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Preface
The B2B Data Exchange Installation and Configuration Guide provides the steps required to install and 
configure B2B Data Exchange. This guide assumes that you have a working knowledge of the operating 
system you are installing on and the software required to run B2B Data Exchange.

Informatica Resources

Informatica Network
Informatica Network hosts Informatica Global Customer Support, the Informatica Knowledge Base, and other 
product resources. To access Informatica Network, visit https://network.informatica.com.

As a member, you can:

• Access all of your Informatica resources in one place.

• Search the Knowledge Base for product resources, including documentation, FAQs, and best practices.

• View product availability information.

• Review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to search Informatica Network for product resources such as 
documentation, how-to articles, best practices, and PAMs.

To access the Knowledge Base, visit https://kb.informatica.com. If you have questions, comments, or ideas 
about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
To get the latest documentation for your product, browse the Informatica Knowledge Base at 
https://kb.informatica.com/_layouts/ProductDocumentation/Page/ProductDocumentSearch.aspx.

If you have questions, comments, or ideas about this documentation, contact the Informatica Documentation 
team through email at infa_documentation@informatica.com.
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Informatica Product Availability Matrixes
Product Availability Matrixes (PAMs) indicate the versions of operating systems, databases, and other types 
of data sources and targets that a product release supports. If you are an Informatica Network member, you 
can access PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional 
Services. Developed from the real-world experience of hundreds of data management projects, Informatica 
Velocity represents the collective knowledge of our consultants who have worked with organizations from 
around the world to plan, develop, deploy, and maintain successful data management solutions.

If you are an Informatica Network member, you can access Informatica Velocity resources at 
http://velocity.informatica.com.

If you have questions, comments, or ideas about Informatica Velocity, contact Informatica Professional 
Services at ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that augment, extend, or enhance your 
Informatica implementations. By leveraging any of the hundreds of solutions from Informatica developers 
and partners, you can improve your productivity and speed up time to implementation on your projects. You 
can access Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through Online Support on Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
http://www.informatica.com/us/services-and-training/support-services/global-support-centers.

If you are an Informatica Network member, you can use Online Support at http://network.informatica.com.
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C h a p t e r  1

Installation Overview
This chapter includes the following topics:

• B2B Data Exchange Installation, 10

• Additional Installation Components, 11

B2B Data Exchange Installation
B2B Data Exchange consists of the core application component and additional required and optional 
components. If you install B2B Data Exchange, PowerCenter services, and the PowerCenter Client on the 
same machine, you can select all of the components in the installer. Otherwise, install each component on 
the required machine.

The B2B Data Exchange installation includes the following components:

B2B Data Exchange

Core application component. Includes the Operation Console, B2B Data Exchange server, and the B2B 
Data Exchange repository, and the publication repository. The PowerCenter services must be running 
when you install B2B Data Exchange. You must set up the database user accounts before you install this 
component.

If you install B2B Data Exchange on an existing database, all data in the repository is preserved. All 
previous user accounts are still valid in the new installation, including the Operation Console 
administrator account. If the repository is from a previous version, the installer upgrades the repository.

B2B Data Exchange Partners Portal

On-premises Partners Portal component. The portal displays visual reports about data that B2B Data 
Exchange processes for partners. You can brand the portal with your organization logo.

You can install the Partners Portal either on the B2B Data Exchange node or on a different node in your 
organization.

B2B Data Exchange Dashboard and Reports

Business activity monitoring component. Includes the dashboard application and the operational data 
store repository. You must set up a different user account from the user account that you use for the 
B2B Data Exchange repository.

You must install the B2B Data Exchange component to install this component.

B2B Data Exchange PowerCenter server plug-in

PowerCenter repository plug-in that B2B Data Exchange uses to run B2B Data Exchange transformations 
in PowerCenter. The installation includes files to add to the classpath of the PowerCenter Integration 
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Service, and sample workflows. You must install this plug-in on the same machine as the PowerCenter 
services.

After you install this component, you must register the plug-in to the PowerCenter repository before you 
create and run B2B Data Exchange workflows.

Note: B2B Data Exchange does not support versioned PowerCenter repositories.

B2B Data Exchange PowerCenter Client plug-in

PowerCenter Client plug-in that displays B2B Data Exchange transformation properties in PowerCenter 
mappings. You install this plug-in on all PowerCenter Client machines that you plan to use to build 
mappings and workflows for B2B Data Exchange transformations.

B2B Managed File Transfer

Managed File Transfer tool to use when you process files to and from partners with specific transfer 
protocols, such as FTP or AS2.

You must install the B2B Data Exchange component to install this component.

B2B Data Exchange Hadoop Service

Available when you install B2B Data Exchange on a UNIX operating system.

Connecting module between B2B Data Exchange and the Hadoop cluster. Enables B2B Data Exchange to 
perform operations on the Hadoop publication repository.

Select this component if you want to define a Hadoop-based publication repository and manage some of 
your topics on Hadoop.

Note: The B2B Data Exchange Hadoop Service must be installed on an edge node in the Hadoop cluster. 
Unless you are installing B2B Data Exchange on a Hadoop edge node, do not select this component 
during B2B Data Exchange installation. In this case, after you complete the B2B Data Exchange 
installation, run the installation again on the edge node and select to install only the B2B Data Exchange 
Hadoop Service component on the node.

B2B Data Exchange Big Data Management

Enables B2B Data Exchange to use Big Data Management mappings for custom publications and 
subscriptions that publish and subscribe to a Hadoop-based publication repository.

Available when you install B2B Data Exchange on a UNIX operating system.

B2B Data Exchange Informatica Data Quality

Enables B2B Data Exchange to use Data Quality mappings for custom publications and subscriptions 
from and to on-premises applications.

Additional Installation Components
B2B Data Exchange requires additional components to run. The components are installed as part of the B2B 
Data Exchange installation process.

The B2B Data Exchange includes the following additional applications and components:

B2B Data Exchange Server

Server environment that manages event processingpublication and subscription processing in B2B Data 
Exchange.
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JMS Broker Service

Manages JMS messages routing between B2B Data Exchange and PowerCenter.

Note: If you upgrade from earlier versions, backwards compatibility is not guaranteed.

Operation Console

Web interface to customize and monitor processing, manage users, and set preferences.

Apache Tomcat

Web server environment that runs the Operation Console client.

Java JDK

Java run-time environment in which the B2B Data Exchange server, B2B Data Exchange Operation 
Console, and B2B Data Exchange command line client tools run.

Samples

Sample workflows and readme files. The installer copies the samples to the following directory: 
<DXInstallationDir>/samples
For more information about the sample workflows, read the readmefirst.txt file in the folder of each 
sample.
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C h a p t e r  2

Before You Begin
This chapter includes the following topics:

• User Accounts, 13

• Port Numbers, 15

User Accounts
Before you install, verify that you have the user names and passwords for the required database and domain 
accounts.

The following table describes the required user accounts:

User Account Description

Database Database user account that you use to log in to the database server and create tables 
and views for the B2B Data Exchange repository and the publication repository. If you 
install the Dashboard and Reports component, you also use a user account for the 
operational data store.
You must install all the repositories on the same type of database server. You must 
create a separate user account for each repository.
The user accounts must have privileges to perform the following actions:
- Select data from tables and views.
- Insert data into tables, delete data from tables, and update data in tables.
- Create, change, and delete the following elements:

- Tables
- Views
- Synonyms
- Indexes
- Custom data types
- Triggers

- Create, change, delete, and run stored procedures and functions.
If you use a Microsoft SQL Server database, you must set up separate databases for 
each repository. It is recommended that you grant database owner privileges to the user 
accounts.

If you use B2B Data 
Exchange with 
Informatica domain 
authentication:
Informatica domain 
administrator

Administrator account for the Informatica domain.
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User Account Description

If you use B2B Data 
Exchange with 
Informatica domain 
authentication:
Informatica security 
domain

User account for Informatica domain authentication. The user account must be created 
in the Informatica Administrator tool with the manage roles/groups/users privileges. The 
B2B Data Exchange administrator synchronizes the user account after the installation.

PowerCenter Repository 
Service

User account that B2B Data Exchange uses to perform operations in the PowerCenter 
Repository Service. The user accounts must have privileges and permissions to perform 
the following actions:
General

- Access Repository Manager privilege

Folders

- Read on folder permission
- Create privilege
- Copy privilege

Design Objects

- Read on folder permission
- Read on shared folder permission
- Read and Write on destination folder permission
- Create, Edit, and Delete privilege with the Read on original folder, Read and Write on 

destination folder, and Read and Write on folder permissions

Sources and Targets

- Read on folder permission
- Read on shared folder permission
- Read and Write on destination folder permission
- Create, Edit, and Delete privilege with the Read on original folder, Read and Write on 

destination folder, and Read and Write on folder permissions

Run-time Objects

- Read on folder permission
- Create, Edit, and Delete privilege with the Read on original folder, Read and Write on 

destination folder, Read on connection object, and Read and Write on folder 
permissions

- Monitor privilege with the Read on folder permission
- Execute privilege with the Read and Execute on folder permission

Global Objects

- Read on connection object permission
- Read and Write on connection object
- Create Connections privilege
- Execute privilege with the Read and Execute on folder permission
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Port Numbers
The installer sets the default port numbers for the installation components. If another application uses the 
same port number as one of the installation components, a port conflict might prevent the component from 
running correctly or cause errors.

You can change the port numbers after installation. Before you start B2B Data Exchange, verify that the port 
numbers do not conflict with other applications and change the port numbers in B2B Data Exchange to 
prevent port conflicts.

The following table describes the default port numbers:

Port Number Description

18000 UDP multicast port that B2B Data Exchange uses for internal communications.

18005 Operation Console shutdown port. Only required to be available on the machine where B2B Data 
Exchange is installed.

18050 Port that the Operation Console uses for internal communications.

18080 Operation Console HTTP port. Required only if you use an HTTP port for the Operation Console.

18095 RMI port for B2B Data Exchange server startup and shutdown.

18095 and 
10896

RMI ports that the Operation Console and PowerCenter workflows use to communicate with the B2B 
Data Exchange server.

18100 Port that the B2B Data Exchange server uses for internal communications.

18443 Operation Console HTTPS port. Required only if you use an HTTPS port for the Operation Console.

18616 Port for the B2B Data Exchange JNDI provider. This port is also the JMS listener port for the B2B 
Data Exchange JMS Broker. 
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C h a p t e r  3

Pre-Installation Tasks
This chapter includes the following topics:

• Pre-Installation Tasks Overview, 16

• Verify the Minimum System Requirements, 17

• Verify the Database Requirements, 18

• Install the Prerequisite Software, 19

• Install and Configure the PowerCenter pmrep Command Line Utility, 20

• Configure Environment Variables, 20

• Set Up a Directory for the Document Store, 20

• Configure Access to the Data Transformation Service, 21

• Configure Microsoft SQL Server Database, 21

• Opening Ports to the Partners Portal, 21

Pre-Installation Tasks Overview
Before you install B2B Data Exchange, set up the machines to meet the installation requirements, verify that 
you have all the user account credentials, and prepare your environment for installing and running B2B Data 
Exchange.

Note: B2B Data Exchange and the PowerCenter Integration Service that B2B Data Exchange uses must be 
installed on the same type of operating system. Both must be installed either on a machine or machines that 
are running Windows operating systems, or on a machine or machines that are running non-Windows 
operating systems.

The following components must reside on machines with the same locale and the same time zone:

• B2B Data Exchange server

• B2B Data Exchange repositories

• B2B Data Exchange Operation Console clients

• PowerCenter Repository Service that B2B Data Exchange uses

• PowerCenter Integration Service that B2B Data Exchange uses

16



Verify the Minimum System Requirements
Verify that your system meets the minimum requirements.

The following table describes the minimum system requirements:

System Requirement

Operating system - Microsoft Windows
- IBM AIX
- Sun Solaris
- Red Hat Linux
- SUSE Linux

Processor - Minimum: 2 CPU cores
- Recommended: 4 CPU cores
- Recommended: 8 CPU cores

RAM 8 GB

Disk space - Minimum: 3 GB
- Recommended: 8 GB

Browser - Microsoft Internet Explorer
- Google Chrome

The following table describes the minimum system requirements to run the installer:

System Requirement

RAM 512 MB

Disk space 1 GB

For more information about product requirements and supported platforms, see the Product Availability 
Matrix on Informatica Network: 
https://network.informatica.com/community/informatica-network/product-availability-matrices/overview 
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Verify the Database Requirements
Verify that your database meets the requirements for running B2B Data Exchange.

The following table describes the database requirements for B2B Data Exchange:

Database 
Component

Description

Database 
System

Type of database on which to install the repositories. You can use one of the following database 
systems:
- Oracle
- Microsoft SQL Server
If you install the Dashboard and Reports component, you do not need to install the operational data 
store on the same machine on which you install B2B Data Exchange.
Note: If you install the Dashboard and Reports component, your B2B Data Exchange and operational 
data store repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 10, 
you must configure the repository connections in PowerCenter Workflow Manager. For details, see 
“Configuring Repository Connections on PowerCenter Version 10” on page 151.

Database 
Instances

Two database instances. B2B Data Exchange uses one database for the B2B Data Exchange 
repository and one database for the publication repository. Both database instances must be on the 
same type of database system. That is, both must be either Oracle databases or Microsoft SQL 
Server databases.
If you use Oracle databases, it is recommended that each database has a unique user account and a 
unique schema.
If you install the Dashboard and Reports component, an additional database instance is required for 
the operational data store. The operational data store must be on the same type of database system 
as the B2B Data Exchange repositories.
Note: If you install the Dashboard and Reports component, your B2B Data Exchange and operational 
data store repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 10, 
you must configure the repository connections in PowerCenter Workflow Manager. For details, see 
“Configuring Repository Connections on PowerCenter Version 10” on page 151.

Disk space The B2B Data Exchange repository database requires at least 512 MB of disk space for the core 
application.
You also need additional space on the publication repository database based on the number of 
messages that you need to process and the type of processing requiredpublications and publication 
instances that you need to retain.
Note: Unicode data requires twice as much storage than single-byte character sets.
The frequency of message archiving also affects the disk space requirement.

Database 
connections

One or moreMultiple database connections for each repository must always be available.
The number of required connections for each repository depends on the number of endpoints and the 
number of documents processedpublications and subscriptions that run concurrently. Use the 
following formula to calculate the number of required database connections for each repository:
(NumberOfEndpoints + Maximum number of concurrent processes 
+ 3)ConcurrentPublicationsOrSubscriptions X 3 + 2
If you do not have enough database connections available, B2B Data Exchange might fail or 
encounter database deadlocks.

Database Unicode Support

If you require Unicode support, create the B2B Data Exchange repository database and the B2B Data 
Exchange publication database with the following settings:

• Oracle databases: use the AL32UTF8 Unicode character set.
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• Microsoft SQL Server: it is recommended that you use data types that support Unicode data: nchar, 
nvarachar, and ntext.

Microsoft SQL Server Collation

If you use Microsoft SQL Server, the collation for the B2B Data Exchange repository and for the B2B Data 
Exchange publication repository must not be case sensitive.

Install the Prerequisite Software
Install the prerequisite software on your machine.

• PowerCenter. Install PowerCenter before you install B2B Data Exchange. Make sure to install PowerCenter 
services on a machine that is accessible to B2B Data Exchange. After you install PowerCenter, verify that 
the PowerCenter Web Services Hub is running.
If you do not install the PowerCenter services on the same machine that you install B2B Data Exchange, 
install the PowerCenter pmrep command line utility on the machine where you install B2B Data Exchange. 
Verify that B2B Data Exchange and PowerCenter can be accessed with the same drive and file path..

If you do not install the PowerCenter services on the same machine that you install B2B Data Exchange, 
install the PowerCenter pmrep command line utility on the machine where you install B2B Data Exchange. 
Verify that B2B Data Exchange and PowerCenter can be accessed with the same drive and file path..

Note: Verify that repository agent caching on the PowerCenter Repository Service is disabled. In 
Informatica Administrator, access the advanced properties of the Repository Service and verify that the 
option Enable Rapagent caching is cleared.

• Data Transformation. Install Data Transformation on the machine where you install B2B Data Exchange 
before you install the B2B Data Exchange server plug-in for PowerCenter.

• Java Development Kit (JDK). On IBM AIX operating systems, install IBM JDK and configure the 
INFA_JDK_HOME environment variable before you install B2B Data Exchange. Verify that the login shell 
can access the INFA_JDK_HOME environment variable. For more information about Java installation, see 
the Java website at the following address: 
http://www.ibm.com/developerworks/java/jdk/aix/service.html#java7
The software available for download at the referenced links belongs to a third party or third parties, not 
Informatica LLC. The download links are subject to the possibility of errors, omissions or change. 
Informatica assumes no responsibility for such links and/or such software, disclaims all warranties, either 
express or implied, including but not limited to, implied warranties of merchantability, fitness for a 
particular purpose, title and non-infringement, and disclaims all liability relating thereto.

For more information about product requirements and supported platforms, see the Product Availability 
Matrix on Informatica Network: 
https://network.informatica.com/community/informatica-network/product-availability-matrices/overview 

• Microsoft Visual C++ 2008 Redistributable Package (x86). Install this package if you use the B2B Data 
Exchange PowerCenter Client plug-in on a Windows Server 2008 64-bit operating system.
The software available for download at the referenced links belongs to a third party or third parties, not 
Informatica LLC. The download links are subject to the possibility of errors, omissions or change. 
Informatica assumes no responsibility for such links and/or such software, disclaims all warranties, either 
express or implied, including but not limited to, implied warranties of merchantability, fitness for a 
particular purpose, title and non-infringement, and disclaims all liability relating thereto.

• Java Cryptography Extension (JCE). Install this package if you are installing B2B Data Exchange with 
Managed File Transfer on an IBM AIX operating system.
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Install and Configure the PowerCenter pmrep 
Command Line Utility

If you do not install the PowerCenter services on the same machine that you install B2B Data Exchange, you 
install and configure the PowerCenter pmrep command line utility on the machine where you install B2B Data 
Exchange.

To download the utility, contact Informatica Shipping. The utility version must match the PowerCenter 
version.

1. Extract the ZIP file on your local machine to a directory that is accessible by the B2B Data Exchange 
installer. 

By default, the installer searches for the utility in the following directory: <LocalDrive>\Informatica
\version

2. Configure the utility settings based on your operating system. 

For information about the utility settings, see the Informatica Repository Guide.

To test the utility settings, run the utility from the command line and verify that no errors appear in the run 
results.

Note: If you upgrade the pmrep command line utility at a later time, clean up all CNX files from the Tmp folder 
on your home directory.

Configure Environment Variables
After you install PowerCenter or the PowerCenter pmrep command line utility on the machine where you 
install B2B Data Exchange, configure environment variables.

1. Set the INFA_HOME environment variable to point to the Informatica installation directory. 

2. Set the INFA_DOMAINS_FILE environment variable to the path and the file name of the domains.infa 
file. 

3. On Solaris and Linux, add <INFA_HOME>/server/bin to the LD_LIBRARY_PATH environment variable. 

4. On AIX, add <INFA_HOME>/server/bin to the LIBPATH environment variable. 

5. Verify that the pmrep utility code page matches the PowerCenter Repository Service code page. You 
specify the code page in the INFA_CODEPAGENAME environment variable of the utility. 

6. To reduce the length of time to wait before the pmrep utility reports an error when connecting to 
PowerCenter, change the value of the INFA_CLIENT_RESILIENCE_TIMEOUT environment variable in the 
utility. 

The default timeout waiting time is 180 seconds.

Set Up a Directory for the Document Store
Set up a directory for the B2B Data Exchange document store.

The document store directory must be accessible to B2B Data Exchange, Apache Tomcat, Data 
Transformation, and PowerCenter with the same drive and file path.
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Configure Access to the Data Transformation Service
Configure the PowerCenter Integration Service to access the Data Transformation service.

When you run workflows for B2B Data Exchange that include an Unstructured Data transformation, the 
PowerCenter Integration Service must be able to access a Data Transformation service.

Configure Microsoft SQL Server Database
If you use a Microsoft SQL Server database for the B2B Data Exchange repository, enable the 
READ_COMMITTED_SNAPSHOT database option. If you install the Dashboard and Reports component, enable this 
option on the operational data store as well.

Note: If you use Microsoft SQL Server 2012, you can set the option Is read committed snapshot on in 
Microsoft SQL Server Management Studio to true instead.

1. Open an SQL query for the database server with rights to set database options. 

2. Run the following SQL statements: 

ALTER DATABASE [<database_name>] SET SINGLE_USER WITH ROLLBACK IMMEDIATE
3. Run the following SQL query: 

ALTER DATABASE <database_name> SET READ_COMMITTED_SNAPSHOT ON
4. To verify that this option is set, run the following SQL query: 

SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name = 
'<database_name>'

If the option is set, the query returns the value 1. If the option is not set, the query returns the value 0.

5. Run the following SQL statement to forcefully disconnect all users from the system: 

ALTER DATABASE [<database_name>] SET MULTI_USER

Opening Ports to the Partners Portal
If you want to install the Partners Portal, enable access to the portal in the firewall by opening the HTTP or 
HTTPS ports from the external network to the Portal server.

Configure the firewall to allow URLs that start with the suffix /dx-portal and /dx-portal-help only.

To ensure that outside access to the Partners Portal is securely performed, assign the external hostname 
URL for the portal to the dx.portal.url system property. For more information about configuring system 
properties in the B2B Data Exchange Operation Console, see the B2B Data Exchange Administror Guide.
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C h a p t e r  4

B2B Data Exchange Installation
This chapter includes the following topics:

• Installing B2B Data Exchange on a Windows Operating System, 22

• Installing B2B Data Exchange on a UNIX Operating System, 57

Installing B2B Data Exchange on a Windows 
Operating System

Install B2B Data Exchange on Windows operating systems in graphical mode. On UNIX operating systems, 
install B2B Data Exchange in console mode.

Before you install, verify that your environment meets the minimum system requirements, perform the pre-
installation tasks, and verify that the PowerCenter services are running.

Note: During the installation, B2B Data Exchange saves log files in the home directory of the user in the 
subdirectory named DXLogs. If the installation does not complete successfully, you can view the log files in 
this location.

Step 1. Run the Installer
1. Log in to the machine with the user account that you want to use to install B2B Data Exchange. 

To prevent permission errors, use the same account to install B2B Data Exchange and PowerCenter.

2. Close all other applications. 

3. Run Install.exe from the root directory of the DVD or from the directory where you downloaded the 
installer. 

The Introduction page appears.

4. Read the instructions, and then click Next. 

22



The Install or Upgrade page appears.

5. Select the option to install B2B Data Exchange, and then click Next. 

The Installation Directory page appears.
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Step 2. Define Installation Settings
1. On the Installation Directory page, enter the absolute path to the installation directory or accept the 

default directory, and then click Next. 

The Installation Components page appears:
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2. Select the components to install: 

B2B Data Exchange

Installs the core B2B Data Exchange application.
Selected by default.
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B2B Data Exchange Partners Portal

Installs the B2B Data Exchange Partners Portal component. You must install B2B Data Exchange to 
install the Partners Portal component.
Selected by default.

B2B Data Exchange Dashboard and Reports

Installs the B2B Data Exchange Dashboard and Reports component. You must install B2B Data 
Exchange to install the Dashboard and Reports component.
Cleared by default.

Note: 

• If you install the Dashboard and Reports component, you must import the operational data store 
event loader after you install B2B Data Exchange.

• If you install the Dashboard and Reports component, your B2B Data Exchange and operational 
data store repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 
10, you must configure the repository connections in PowerCenter Workflow Manager. For 
details, see “Configuring Repository Connections on PowerCenter Version 10” on page 151.

• If you do not install the Dashboard and Reports component, the Dashboard will not be available 
in the Partners Portal.

B2B Data Exchange PowerCenter server plug-in

Installs the B2B Data Exchange plug-in for the PowerCenter services. After the installation, you 
register the plug-in to the PowerCenter repository.
Selected by default.

B2B Data Exchange PowerCenter client plug-in

Installs the B2B Data Exchange plug-in for the PowerCenter Client. Install this component on every 
machine that runs the PowerCenter Client.
Selected by default.

B2B Data Exchange Informatica Data Quality

Enables B2B Data Exchange to use Data Quality mappings for custom publications and 
subscriptions.
Select this component if you want to create custom publications and subscriptions that use Data 
Quality mappings in B2B Data Exchange.

Cleared by default.

3. Click Next. 

The Metadata Repository page appears.

Step 3. Configure the B2B Data Exchange Repository Repositories
1. On the Metadata Repository page, select one of the following options: 

• Create a B2B Data Exchange repository. Creates a repository in the database.

• Create a Data Integration Hub repository. Creates a repository in the database.

• Use an existing B2B Data Exchange repository. Uses the tables and data in an existing B2B Data 
Exchange repository and upgrades the repository.
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• Use an existing Data Integration Hub repository. Uses the tables and data in an existing B2B Data 
Exchange repository and upgrades the repository.

2. Click Next. 
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The Metadata Repository Connection page appears.

3. Enter values in the following fields: 
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Database type

Type of database to use for the B2B Data Exchange metadata repository. You can choose one of the 
following options:

• Oracle

• Microsoft SQL Server

Database URL

Location of the database.
If you select this option, enter the values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for Oracle is 1521. The 
default port number for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if the database is Oracle. Enter either a fully 
qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database. Database name.

Custom Connection String

Connection string to the database.
If you select this option, enter values in one of the following fields:

• JDBC string. JDBC connection string to the metadata repository.

• ODBC string. ODBC connection string to the metadata repository. Available if you install the 
PowerCenter Client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.

Database username

Name of the database user account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication.

Database user password

Password for the database account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication. B2B Data Exchange stores the password as an 
encrypted string.

4. Click Next. 
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The Publication Repository Connection page appears.

5. Enter values in the following fields: 

Database type

Type of database to use for the publication repository. The database type must match the B2B Data 
Exchange metadata repository database type and appears in read-only mode.

Database URL

Location of the database.
If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for Oracle is 1521. The 
default port for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if the database is Oracle. Enter either a fully 
qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database: Database name. Name of the database instance.

Custom Connection String

JDBC connection string to the database.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.
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Database username

Name of the database user account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication.

Database user password

Password of the database account for the Oracle database or Microsoft SQL Server database where 
you do not use Windows authentication. B2B Data Exchange stores the password as an encrypted 
string.

6. Click Next. 

If you selected the B2B Data Exchange Dashboard and ReportsData Integration Hub Dashboard and 
Reports component, the Operational Data Store page appears. If you did not select the Dashboard and 
Reports component, go to “Step 5. Configure User Authentication” on page 34.

Step 4. Set Up the Operational Data Store
1. On the Operational Data Store page, select one of the following options: 

• Create an operational data store repository. Creates an operational data store repository in the 
database.
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• Use an existing operational data store repository. Uses the tables and data in an existing operational 
data store repository.

2. Click Next. 
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The Operational Data Store Database Connection page appears.

3. Enter values in the following fields: 
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Database URL

Location of the database. If you select this option, enter the values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for the Oracle is 1521. 
The default port number for the Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if you select Oracle as the database. Enter 
either a fully qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database. Database name.

Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the Operational Data Store.

• ODBC string. ODBC connection string to the Operational Data Store. Available if you install the 
PowerCenter Client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.

Database username

Name of the operational data store user account for the Oracle database or the Microsoft SQL 
Server database where you do not use Windows authentication.

Database user password

Password for the operational data store account for the Oracle database or the Microsoft SQL 
Server database where you do not use Windows authentication. B2B Data Exchange stores the 
password as an encrypted string.

4. Click Next. 

If you create a repository in the database, the User AuthenticationThe User Authentication page 
appears. If you select an existing repository, the installer selects the existing authentication method. Go 
to “Step 6. Configure Document Store and Web Server Configure Document Store, Web Server, and Port 
Numbers” on page 42.

Step 5. Configure User Authentication
1. On the User Authentication page, choose the type of user authentication that you want to use. 

• Choose Informatica domain authentication to manage user credentials in the Informatica domain 
and synchronize user information with B2B Data Exchange. Use Informatica domain authentication 
for production environments. For more information, see “Configure Settings for Informatica Domain 
Authentication ” on page 37.
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Note: If your Informatica domain uses Kerberos authentication, choose the option Informatica 
domain with Kerberos authentication.

• Choose Informatica domain with Kerberos authentication if the Informatica domain uses Kerberos 
authentication. Use Informatica domain with Kerberos authentication for production environments. 
For more information, see “Configure Settings for Informatica Domain with Kerberos 
Authentication” on page 38.

• Choose B2B Data Exchange native authenticationData Integration Hub native authentication to 
manage user credentials locally in B2B Data Exchange. Use native authentication in development and 
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staging environments. For more information, see “Configure Settings for B2B Data Exchange Native 
Authentication” on page 40.

2. Enter the authentication information, and then click Next. 

The Data Integration Hub Document StoreData Exchange Document Store page appears.
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Configure Settings for Informatica Domain Authentication
If you select the Informatica Domain Authentication option on the User Authentication page, you can 
configure the Informatica domain authentication settings on the Informatica Platform Authentication page.

The following image shows the Informatica Platform Authentication page.
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The following table describes the settings that you need to configure for the Informatica Platform 
Authentication page:
Gateway host

Host name of the Informatica security domain server. B2B Data Exchange stores the host name in the 
pwc.domain.gateway system property.

Gateway port number

Port number for the Informatica security domain gateway. B2B Data Exchange stores the port number in 
the pwc.domain.gateway system property. Use the gateway HTTP port number to connect to the domain 
from the PowerCenter Client. You cannot use the HTTPS port number to connect to the domain.

Username

User name to access the Administrator tool. You must create the user in the Administrator tool and 
assign the manage roles/groups/user privilege to the user.

Password

Password of the Informatica security domain user.

Security domain

Name of the Informatica security domain where the user is defined.

Security group

Optional. Security group within the Informatica security domain where B2B Data Exchange users are 
defined in the following format:

<security group>@<domain>
If you leave the field empty, the Informatica security domain synchronizes only the B2B Data Exchange 
administrator user account.

B2B Data Exchange stores the security group in the dx.authentication.groups system property in the 
following format:

<group name>@<security group>[;<groupname>@<security group>]

Configure Settings for Informatica Domain with Kerberos Authentication
If you select the Informatica domain with Kerberos authentication option on the User Authentication page, 
you can configure the authentication settings on the Informatica Domain with Kerberos Authentication page.
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The following image shows the Informatica Domain with Kerberos Authentication page.

Enter the configuration information.

Kerberos configuration file

File that stores Keberos configuration information, usually named krb5.conf
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The installation copies the file to the following location:

<DXInstallationDir>/shared/conf/security/krb5.conf
Operation Console SPN name

Service Principal Name (SPN) for the B2B Data Exchange Operation Console.

B2B Data Exchange stores the SPN in the dx-security-config.properties property file, in the 
dx.kerberos.console.service.principal.name property.

Operation Console keytab file

Location of the keytab file for the B2B Data Exchange Operation Console SPN.

The installer copies the file to the following location:

<DXInstallationDir>/shared/conf/security/HTTP_console.keytab
B2B Data Exchange stores the location of the keytab file in the dx-security-config.properties 
property file, in the dx.kerberos.console.keytab.file property.

If you change the property to point to a different file, you must enter the absolute path to the file using 
the following format:

 file://<full_path>
System Administrator

B2B Data Exchange system administrator credentials.

Enter the credentials in the following format:

<username>@<SECURITY_DOMAIN>

Note: You must enter <SECURITY_DOMAIN> in uppercase letters.

Gateway host

PowerCenter domain gateway host.

Gateway port number

PowerCenter domain gateway port number.

Security group

Optional. Security group within the Informatica security domain where B2B Data Exchange users are 
defined in the following format:

<security group>@<domain>
If you leave the field empty, the Informatica security domain synchronizes only the B2B Data Exchange 
administrator user account.

B2B Data Exchange stores the security group in the dx.authentication.groups system property in the 
following format:

<group name>@<security group>[;<groupname>@<security group>]

Configure Settings for B2B Data Exchange Native Authentication
If you select the B2B Data Exchange native authenticationData Integration Hub native authentication option 
on the User Authentication page, you need to enter the B2B Data Exchange administrator user name on the 
Operation Console Administrator page. B2B Data Exchange uses this value for the user name and password 
when you log in to the Operation Console.
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The following image shows the Operation Console Administrator page.
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Step 6. Configure Document Store and Web Server Configure 
Document Store, Web Server, and Port Numbers

1. On the Data Integration Hub Document Store Data Exchange Document Store page, accept the default 
directory or enter the directory where you want to create the document store directory. 

B2B Data Exchange stores documents and files in the document store during processing. The document 
store directory must be accessible to B2B Data Exchange, PowerCenter services, and Data 
Transformation.
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2. Click Next. 
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The Web Server page appears.

3. Enter values in the following fields: 
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Enable HTTPS

Instructs B2B Data Exchange to use secure network communication when you open the Operation 
Console in the browser. If you select HTTPS and HTTP, the Operation Console switches existing 
HTTP connections with HTTPS connections.

Connector port number

Port number for the Tomcat connector to use when you open the Operation Console with HTTPS.
The default value is 18443.

Use a keystore file generated by the installer

Instructs the installer to generate a keystore file with an unregistered certificate. If you select this 
option, ignore the security warning that you receive from the browser the first time you open the 
Operation Console.

Use an existing keystore file

Instructs the installer to load an existing keystore file. Enter values in the following fields:

• Keystore password. Password for the keystore file.

• Keystore file. Path to the keystore file.

The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 format.

HTTP connector port number

Port number for the HTTP connector. If you clear this field, your browser must connect to the B2B 
Data Exchange server with HTTPS when you log in to the Operation Console.
The default value is 18080.

Server shutdown listener port number

Port number for the listener that controls the Tomcat server shutdown.
The default value is 18005.

4. Click Next. 
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The Port Numbers page appears.

If you selected to install the B2B Data Exchange server plug-in for PowerCenter or the B2B Data 
Exchange client plug-in for PowerCenter components, the PowerCenter Location page appears. If you 
did not select the PowerCenter server or client components, the PowerCenter Web Services Hub page 
appears.

5. Enter the port number for the B2B Data Exchange JMS Broker JMX listener port or accept the default 
port, and then click Next. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter or the B2B Data 
Exchange client plug-in for PowerCenter components, the PowerCenter Location page appears. If you 
did not select the PowerCenter server or client components, the PowerCenter Web Services Hub page 
appears.
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Step 7. Configure PowerCenter Settings
1. If you selected to install the B2B Data Exchange server plug-in for PowerCenter or the B2B Data 

Exchange client plug-in for PowerCenter components, on the PowerCenter Location page, enter the 
directory where you installed PowerCenter or accept the default directory, and then click Next. 

The PowerCenter Web Services Hub page appears.
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2. On the PowerCenter Web Services Hub page, enter the PowerCenter web services details. 
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Web Services Hub URL

URL that the PowerCenter Web Services Hub uses when B2B Data Exchange transfers documents to 
PowerCenter for processing with batch workflowsto process publication and subscription 
workflows.

Service name

Name of the PowerCenter Repository Service.

Node host name

Host name of the node that runs the PowerCenter Repository Service.

Node port number

Port number of the node that runs the PowerCenter Repository Service.

Username

Name of the PowerCenter Repository Service user.

Password

Password for the PowerCenter Repository Service user. B2B Data Exchange stores the password as 
an encrypted string.

Security domain

Optional. Name of the Informatica security domain in which the PowerCenter Repository Service 
user is stored.
Default is Native.

3. Click Next. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter component, the 
PowerCenter Domain Settings page appears.

Installing B2B Data Exchange on a Windows Operating System       49



If you did not select the PowerCenter server component, the PowerCenter pmrep Command Line Utility 
Location page appears. Go to step 6.

4. Enter values in the following fields: 
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Domain name

Name of the Informatica domain that contains the PowerCenter Integration Service that runs B2B 
Data Exchange workflows.

Node name

Node in the Informatica domain on which the PowerCenter Integration Service runs.

Domain administrator username

Name of the Informatica domain administrator.

Domain administrator password

Password for the Informatica domain administrator. B2B Data Exchange stores the password as an 
encrypted string.

Integration Service name

The name of the PowerCenter Integration Service that B2B Data Exchange uses to run workflows.

5. Click Next. 
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The PowerCenter pmrep Command Line Utility Location page appears.

6. Specify the location of the pmrep command line utility. 
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The location of the utility depends on whether or not you install B2B Data Exchange on the machine 
where the PowerCenter services are installed.

Environment Location of the pmrep command line utility

B2B Data Exchange installed on the 
machine where the PowerCenter 
services are installed

<PowerCenter_services_installation_folder>
\<PowerCenter_version>\tools\pcutils
\<PowerCenter_version>

B2B Data Exchange and PowerCenter 
services installed on different 
machines

<PowerCenter_client_installation_folder>
\<PowerCenter_version>\clients\PowerCenterClient
\client\bin

7. Click Next. 

If you selected to install the B2B Data Exchange Informatica Data Quality component, the Informatica 
Data Quality Domain Settings page appears. If you did not select to install the B2B Data Exchange 
Informatica Data Quality component, theThe Pre-Installation Summary page appears.
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Step 8. Configure Informatica Data Quality Settings
1. If you selected to install the B2B Data Exchange Informatica Data Quality component, the Informatica 

Data Quality Domain Settings page appears. 

Enter values in the following fields:
Domain name

Domain name of the node on which the Data Integration Service runs.

Host name

Host name of the node on which the Data Integration Service runs.

Port number

Port number of the node on which the Data Integration Service runs.

Domain administrator username

User name for the node on which the Data Integration Service runs.

Domain administrator password

Password for the node on which the Data Integration Service runs.

Security Domain

Optional. Name of the Informatica security domain in which the Model Repository Service user is 
stored.

Data Integration Service name

Name of the Data Integration Service.

Model Repository Service name

Name of the Model Repository Service.

2. Click Next. 
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The Informatica Data Quality infacmd Command Line Utility page appears.

3. Enter the location of the infacmd command line utility or accept the default directory, and then click 
Next. 

The Pre-Installation Summary page appears.
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Step 89. Complete the Installation
1. On the Pre-Installation Summary page, verify that the installation information is correct, and then click 

Install. 

During the installation process, the installer displays progress information. When the installation process 
ends, the Post-Installation Actions page appears.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the wizard instructions to 
register the plug-in to the PowerCenter repository, and then click Next. 

The Installation Complete page appears.

3. Click Done to close the installer. 

4. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs. 

5. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

6. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 
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Installing B2B Data Exchange on a UNIX Operating 
System

Install B2B Data Exchange on UNIX operating systems in console mode. On Windows operating systems, 
install B2B Data Exchange in graphical mode.

Before you install, verify that your environment meets the minimum system requirements, perform the pre-
installation tasks, and verify that the PowerCenter services are running.

During the installation, B2B Data Exchange saves log files in the home directory of the user, in the 
subdirectory named DXLogs. If the installation does not complete successfully, you can view the log files in 
this location.

Step 1. Run the Installer
1. Log in to the machine with the user account that you want to use to install B2B Data Exchange. 

To prevent permission errors, use the same account to install B2B Data Exchange and PowerCenter.

2. Close all other applications. 

3. Run Install.bin -i console from the root directory of the DVD or from the directory where you 
downloaded the installer. 

The Introduction section appears.

4. Read the instructions, and then press Enter. 

The Install or Upgrade section appears.

5. Enter 1 to install B2B Data Exchange, and then press Enter. 

The Installation Directory section appears.

Step 2. Define Installation Settings
1. In the Installation Directory section, enter the absolute path to the installation directory or accept the 

default directory, and then press Enter. 

The Installation Components section appears and displays a numbered list of the components to install.

2. Enter a comma-separated list of numbers for the components to install or accept the default 
components: 

1- B2B Data Exchange

Installs the core B2B Data Exchange application.
Selected by default.

2- B2B Data Exchange Partners Portal

Installs the B2B Data Exchange Partners Portal component. You must install B2B Data Exchange to 
install the Partners Portal component.
Selected by default.

3-2- B2B Data Exchange Dashboard and Reports

Installs the B2B Data Exchange Dashboard and Reports component. You must install B2B Data 
Exchange to install the Dashboard and Reports component.
Cleared by default.
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Note: 

• If you install the Dashboard and Reports component, you must import the operational data store 
event loader after you install B2B Data Exchange.

• If you install the Dashboard and Reports component, your B2B Data Exchange and operational 
data store repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 
10, you must configure the repository connections in PowerCenter Workflow Manager. For 
details, see “Configuring Repository Connections on PowerCenter Version 10” on page 151.

• If you do not install the Dashboard and Reports component, the Dashboard will not be available 
in the Partners Portal.

4-3- B2B Data Exchange Server Plug-in for PowerCenter

Installs the B2B Data Exchange PowerCenter server plug-in component. After the installation, 
register the plug-in to the PowerCenter repository.
Selected by default.

4- B2B Data Exchange Hadoop Service

Connecting module between B2B Data Exchange and the Hadoop cluster. Enables B2B Data 
Exchange to perform operations on the Hadoop publication repository.
Select this component if you want to define a Hadoop-based publication repository and manage 
some of your topics on Hadoop.

Note: The B2B Data Exchange Hadoop Service must be installed on an edge node in the Hadoop 
cluster. Unless you are installing B2B Data Exchange on a Hadoop edge node, do not select this 
component during B2B Data Exchange installation. In this case, after you complete the B2B Data 
Exchange installation, run the installation again on the edge node and select to install only the B2B 
Data Exchange Hadoop Service component on the node.

5- B2B Data Exchange Big Data Management/Informatica Data Quality

Enables B2B Data Exchange to use Big Data Management and Data Quality mappings for custom 
publications and subscriptions.
Select this component if you want to create custom publications and subscriptions that use Big 
Data Management or Data Quality mappings in B2B Data Exchange.

3. Press Enter. 

The Metadata Repository section appears.

Step 3. Configure B2B Data Exchange Repository Repositories
1. In the Metadata Repository section, enter the number for the metadata repository database 

configuration option or accept the default option: 

1- Create a B2B Data Exchange repository

Creates a repository in the database.

1- Create a Data Integration Hub repository

Creates a repository in the database.

2- Use an existing B2B Data Exchange repository

Uses the tables and data in an existing repository.

2- Use an existing Data Integration Hub repository

Uses the tables and data in an existing repository.

2. Press Enter. 
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The Metadata Repository Connection section appears.

3. Enter 1 to use an Oracle database as the B2B Data Exchange metadata repository database. 

4. Enter the number for the metadata repository database connection type or accept the default connection 
type: 

1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database.

2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the metadata repository.

• ODBC string. ODBC connection string to the metadata repository. Applicable if you install the 
PowerCenter client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

5. Enter values in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

6. Press Enter. 

If you selected to install the B2B Data Exchange Dashboard and Reports component, the Operational 
Data Store section appears. If you did not select to install the Dashboard and Reports component, go to 
“Step 5. Configure the Web Server Configure the Web Server and Port Numbers” on page 122.

7. Enter the number for the publication repository connection type or accept the default connection type. 

Note: When using Microsoft SQL Server named instances, you must define a custom connection string.

1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Oracle database: Database SID. System identifier for the database.

• Microsoft SQL Server database: Database name. Name of the database instance.
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2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the publication repository.

• ODBC string. Applicable if you install the PowerCenter client plug-in. ODBC connection string to 
the publication repository. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

8. Press Enter. 

9. Enter values in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

10. Press Enter. 

If you selected to install the B2B Data Exchange Dashboard and Reports component, the Operational 
Data Store section appears. If you did not select to install the Dashboard and Reports component, go to 
“Step 5. Configure the Web Server Configure the Web Server and Port Numbers” on page 122.

Step 4. Set Up the Operational Data Store
1. In the Operational Data Store section, enter the number for the database configuration option for the 

operational data store or accept the default option: 

1- Create an operational data store repository

Creates an operational data store repository in the database.

2- Use an existing operational data store repository

Uses the tables and data in an existing operational data store repository.

2. Enter the number for the database connection type for the operational data store or accept the default 
connection type: 

1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Oracle database: Database SID. System identifier for the database.

• Microsoft SQL Server database: Database name. Name of the database instance.
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2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the Operational Data Store.

• If you install the PowerCenter client plug-in: ODBC string. ODBC connection string to the 
Operational Data Store. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

3. Enter values for the operational data store in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

4. Press Enter. 

The User Authentication section appears.

Step 5. Configure User Authentication
1. In the User Authentication section, choose the type of user authentication that you want to use. 

Note: If you select an existing repository, the installer selects the existing authentication method.

• Choose Informatica domain authentication to manage user credentials in the Informatica domain and 
synchronize user information with B2B Data Exchange. Use Informatica domain authentication for 
production environments. For more information, see “Configure Settings for Informatica Domain 
Authentication” on page 62.

Note: If your Informatica domain uses Kerberos authentication, choose the option Informatica 
domain with Kerberos authentication.

• Choose Informatica domain with Kerberos authentication if your Informatica domain uses Kerberos 
authentication. Use Informatica domain with Kerberos authentication for production environments. 
For more information, see “Configure Settings for Informatica Domain with Kerberos 
Authentication” on page 62.

• Choose B2B Data Exchange native authenticationData Integration Hub native authentication to 
manage user credentials locally in B2B Data Exchange. Use native authentication in development and 
staging environments. For more information, see “Configure Settings for Data Integration Hub Native 
Authentication Configure Settings for B2B Data Exchange Native Authentication ” on page 63.

2. Press Enter. 

The Document Store section appears.
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Configure Settings for Informatica Domain Authentication
If you choose Informatica domain authentication, enter values in the following fields:

Gateway host

Host name of the Informatica security domain server. B2B Data Exchange stores the host name in the 
pwc.domain.gateway system property.

Gateway port

Port number for the Informatica security domain gateway. B2B Data Exchange stores the port number in 
the pwc.domain.gateway system property. Use the gateway HTTP port number to connect to the domain 
from the PowerCenter Client. You cannot use the HTTPS port number to connect to the domain.

Username

User name to access the Administrator tool. You must create the user in the Administrator tool and 
assign the manage roles/groups/user privilege to the user.

Password

Password of the Informatica security domain user.

Security domain

Name of the Informatica security domain where the user is defined.

Security group

Optional. Security group within the Informatica security domain where B2B Data Exchange users are 
defined in the following format:

<security group>@<domain>
If you leave the field empty, the Informatica security domain synchronizes only the B2B Data Exchange 
administrator user account.

B2B Data Exchange stores the security group in the dx.authentication.groups system property in the 
following format:

<group name>@<security group>[;<groupname>@<security group>]

Configure Settings for Informatica Domain with Kerberos Authentication
If you choose Informatica domain with Kerberos authentication, enter values in the following fields:

Kerberos configuration file

File that stores Keberos configuration information, usually named krb5.conf

The installation copies the file to the following location:

<DXInstallationDir>/shared/conf/security/krb5.conf
Operation Console SPN name

Service Principal Name (SPN) for the B2B Data Exchange Operation Console.

B2B Data Exchange stores the SPN in the dx-security-config.properties property file, in the 
dx.kerberos.console.service.principal.name property.

Operation Console keytab file

Location of the keytab file for the B2B Data Exchange Operation Console SPN.

The installation copies the file to the following location:

<DXInstallationDir>/shared/conf/security/HTTP_console.keytab
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B2B Data Exchange stores the location of the keytab file in the dx-security-config.properties 
property file, in the dx.kerberos.console.keytab.file property.

If you change the property to point to a different file, you must enter the absolute path to the file using 
the following format:

 file://<full_path>
System Administrator

B2B Data Exchange system administrator credentials.

Enter the credentials in the following format:

<username>@<SECURITY_DOMAIN>

Note: You must enter <SECURITY_DOMAIN> in uppercase letters.

Gateway host

PowerCenter domain gateway host.

Gateway port number

PowerCenter domain gateway port number.

Security group

Optional. Security group within the Informatica security domain where B2B Data Exchange users are 
defined in the following format:

<security group>@<domain>
If you leave the field empty, the Informatica security domain synchronizes only the B2B Data Exchange 
administrator user account.

B2B Data Exchange stores the security group in the dx.authentication.groups system property in the 
following format:

<group name>@<security group>[;<groupname>@<security group>]

Configure Settings for Data Integration Hub Native Authentication Configure 
Settings for B2B Data Exchange Native Authentication 
If you choose B2B Data Exchange native authenticationData Integration Hub native authentication, enter the 
B2B Data Exchange administrator user name. B2B Data Exchange uses this value for the user name and 
password when you log in to the Operation Console.

Step 6. Configure Document Store and Web Server Configure 
Document Store, Web Server, and Port Numbers

1. In the Document Store section, enter the directory where B2B Data Exchange stores documents and files 
during processing or accept the default directory, and then press Enter. 

The document store directory must be accessible to B2B Data Exchange, PowerCenter services, and 
Data Transformation.

2. Press Enter. 

The Web Server section appears.
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3. Configure the Web Server connection. 

a. Enter the number for the network communication protocol or accept the default protocol: 

1- Enable HTTPS

Instructs B2B Data Exchange to use secure network communication when you open the 
Operation Console in the browser.
If you select HTTPS and HTTP, the Operation Console switches existing HTTP connections with 
HTTPS connections.

2- Enable HTTP

Instructs B2B Data Exchange to use regular HTTP network communication when you open the 
Operation Console in the browser.

b. If you selected Enable HTTPS, enter values in the following fields: 

Connector port number

Port number for the Tomcat connector to use when you open the Operation Console with 
HTTPS.
The default value is 18443.

Use a keystore file generated by the installer

Instructs the installer to generate a keystore file with an unregistered certificate. If you select 
this option, ignore the security warning that you receive from the browser the first time you 
open the Operation Console.

Use an existing keystore file

Instructs the installer to load an existing keystore file. Enter values in the following fields:

• Keystore password. Password for the keystore file.

• Keystore file. Path to the keystore file.

The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 format.

c. If you selected Enable HTTP, enter values in the following fields: 

HTTP connector port number

Port number for the HTTP connector. If you clear this field, your browser must connect to the 
B2B Data Exchange server with HTTPS when you log in to the Operation Console.
The default value is 18080.

Server shutdown listener port number

Port number for the listener that controls the Tomcat server shutdown.
The default value is 18005.

4. Press Enter. 

The Port Numbers section appears.

5. Press Enter. 

If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 
PowerCenter Client plug-in components, the PowerCenter Location section appears. If you did not select 
the PowerCenter server or client components, the PowerCenter Web Services Hub section appears.

6. Enter the port number for the B2B Data Exchange JMS Broker JMX listener port or accept the default 
port and then press Enter. 

If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 
PowerCenter Client plug-in components, the PowerCenter Location section appears. If you did not select 
the PowerCenter server or client components, the PowerCenter Web Services Hub section appears.
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Step 7. Configure PowerCenter Settings
1. If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 

PowerCenter Client plug-in components, in the PowerCenter Location section, enter the directory where 
you installed PowerCenter or accept the default directory, and then press Enter. 

The PowerCenter Web Services section appears.

2. In the PowerCenter Web Services section, press Enter to accept the default URL or enter the URL that 
the PowerCenter Web Services Hub uses when B2B Data Exchange transfers documents to PowerCenter 
for processing with batch workflowsto process publication and subscription workflows and then press 
Enter. 

3. Enter the name of the PowerCenter Repository Service, and then press Enter. 

4. Enter values in the following fields: 

Node host name

Host name of the node that runs the PowerCenter Repository Service.

Node port number

Port number of the node that runs the PowerCenter Repository Service.

Username

Name of the PowerCenter Repository Service user.

Password

Password for the PowerCenter Repository Service user. B2B Data Exchange stores the password as 
an encrypted string.

Security domain

Optional. Name of the Informatica security domain in which the PowerCenter Repository Service 
user is stored.
Default is Native.

5. Press Enter. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter component, the 
Informatica DomainPowerCenter Domain Settings section appears. If you did not select the 
PowerCenter server component, the PowerCenter pmrep Command Line Utility Location section 
appears. Go to step 9.

6. Enter values in the following fields: 

Domain name

Name of the Informatica domain that contains the PowerCenter Integration Service that runs B2B 
Data Exchange workflows.

Node name

Node in the Informatica domain on which the PowerCenter Integration Service runs.

Domain administrator user name

Name of the Informatica domain administrator.

Domain administrator password

Password for the Informatica domain administrator. B2B Data Exchange stores the password as an 
encrypted string.

7. Press Enter. 
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8. Enter the name of the PowerCenter Integration Service that B2B Data Exchange uses to run workflows, 
and then press Enter. 

9. Enter the location of the pmrep command line utility and then press Enter. The location of the utility 
depends on whether or not you install B2B Data Exchange on the machine where the PowerCenter 
services are installed. 

Note: On Linux operating systems, pmrep must be executable.

Environment Location of the pmrep command line utility

B2B Data Exchange installed on the 
machine where the PowerCenter 
services are installed

<PowerCenter_services_installation_folder>/
<PowerCenter_version>/tools/pcutils/
<PowerCenter_version>

B2B Data Exchange and PowerCenter 
services installed on different 
machines

<PowerCenter_client_utility_directory>/PowerCenter/
server/bin

10. Press Enter. 

The Pre-Installation Summary section appears. If you selected to install the B2B Data Exchange Big 
Data Management/Informatica Data Quality component, the Big Data Management/Informatica Data 
Quality Domain name section appears. If you did not select to install the B2B Data Exchange Big Data 
Management/Informatica Data Quality component, the Pre-Installation Summary section appears. 

Step 8. Complete the Installation
1. In the Pre-Installation Summary section, verify that the installation information is correct, and then press 

Enter. 

During the installation process, the installer displays progress information.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the on-screen instructions to 
register the plug-in to the PowerCenter repository, and then press Enter. 

3. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs 

4. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

5. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 

Step 8. Configure Processing Engine Settings

1. In the Big Data Management/Informatica Data Quality Domain name section, press Enter to accept the 
default domain name or enter the name of the Informatica domain, and then press Enter. 

The Big Data Management/Informatica Data Quality Host name section appears.

2. Press Enter to accept the default host name or enter the host name of the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality Port number section appears.
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3. Press Enter to accept the default port number or enter the port number of the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality administrator user name section appears.

4. Press Enter to accept the default user name or enter the user name for the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality administrator password section appears.

5. Press Enter to accept the default password or enter the password for the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality Security Domain section appears.

6. Optionally, enter the name of the Informatica security domain in which the Model Repository Service user 
is stored. Press Enter. 

The Big Data Management/Informatica Data Quality Data Integration Service name section appears.

7. Press Enter to accept the default name or enter the name of the Data Integration Service and then press 
Enter. 

The Big Data Management/Informatica Data Quality Model Repository Service name section appears.

8. Press Enter to accept the default name or enter the name of the Model Repository Service and then 
press Enter. 

The Big Data Management/Informatica Data Quality infacmd Command Line Utility Location section 
appears.

9. Press Enter to accept the default location or enter the location of the infacmd command line utility then 
press Enter. 

The Pre-Installation Summary section appears.

Step 9. Complete the Installation
1. In the Pre-Installation Summary section, verify that the installation information is correct, and then press 

Enter. 

During the installation process, the installer displays progress information.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the on-screen instructions to 
register the plug-in to the PowerCenter repository, and then press Enter. 

3. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs 

4. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

5. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 
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C h a p t e r  5

Post-Installation Tasks
This chapter includes the following topics:

• Post-Installation Tasks Overview, 68

• Configure Authentication for the Operation Console, 69

• Register the B2B Data Exchange Server Plug-in for PowerCenter, 70

• Connect to a Remote Informatica Domain, 71

• Set Up the Run Publication SubscriptionB2B Data Exchange Web Services , 73

• Configure Credentials for Windows Authentication, 74

• Set Up Database Partitions on the Publication Repository, 75

• Configuring the Environment for a Hadoop Publication Repository, 75

• Log in to the Operation Console, 77

• Configure Connections to the B2B Data Exchange Repositories, 78

• Configure the Mail Server, 79

• Synchronize B2B Data Exchange Users, 80

• Activate the Dashboard and Reports Component, 80

• Synchronize B2B Data Exchange Users, 82

• Customize the Partners Portal Logo, 82

Post-Installation Tasks Overview
After you install B2B Data Exchange, perform the steps that are relevant for your environment.

1. Configure authentication for the B2B Data Exchange Operation Console.

2. If you installed the B2B Data Exchange server plug-in for PowerCenter, register the plug-in to the 
PowerCenter repository.

3. Configure PowerCenter to access B2B Data Exchange.

4. If you do not have the Informatica services installed on the same machine as B2B Data Exchange, 
configure B2B Data Exchange to connect to a remote Informatica domain.

5. If you want to use the Run Publication Subscription web services API, set up the web services.

6. If you installed the B2B Data Exchange repositories on a Microsoft SQL Server and you selected to use 
Windows authentication, configure credentials for Windows authentication.
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7. Set up partitions on the B2B Data Exchange publication repository database that stores published data 
sets. Setting up partitions is highly recommended.

8. Configure the mail server for B2B Data Exchange monitoring notifications.

9. If you installed the B2B Data Exchange Hadoop Service component, configure your environment for a 
Hadoop-based publication repository.

10. Start the B2B Data Exchange services. For more information, see Chapter 8, “Starting and Stopping B2B 
Data Exchange” on page 136.

Note: If you installed the B2B Data Exchange Hadoop Service component on a different machine than the 
machine where you installed B2B Data Exchange, start the services on both machines. For more 
information, see “Starting and Stopping B2B Data Exchange on UNIX” on page 137.

11. Log in to the B2B Data Exchange Operation Console.

12. Configure connections to the B2B Data Exchange repositories in the B2B Data Exchange Operation 
Console.

13. If you installed B2B Data Exchange with Informatica domain authentication or with Informatica domain 
with Kerberos authentication, synchronize B2B Data Exchange users in the B2B Data Exchange Operation 
Console.

14. If you installed the Dashboard and Reports component, activate the component.

15. If you installed the Partners Portal component, you can brand the portal with your organization logo.

16. If you want to configure subscriptions with the delivery option Insert new rows and update changed 
rows, and if the column values are expected to contain NULLs, you must configure the PowerCenter 
Integration Service property Treat Null In Comparison Operators As to Low.

Related Topics:
• “Overview of Starting and Stopping B2B Data Exchange” on page 136

Configure Authentication for the Operation Console
When you install B2B Data Exchange, you choose native authentication or Informatica domain authentication. 
one of the following authentication options:

• Informatica domain authentication. You use the user name and password you entered in the Informatica 
Platform Authentication screen to log in to the Operation Console.

• Informatica domain with Kerberos authentication. You are automatically logged in to the Operation 
Console with your operating system credentials.

• B2B Data Exchange native authentication. You use the administrator user name you entered in the 
Operation Console Administrator screen to log in to the Operation Console.

If you choose native authentication, use the administrator user name you entered in the Operation Console 
Administrator screen to log in to the Operation Console. If you choose Informatica domain authentication, 
use the user name and password you entered in the Informatica Platform Authentication screen to log in to 
the Operation Console.

If you use B2B Data Exchange native authentication with an authentication protocol that the Informatica 
domain authentication does not support, you can create a JAAS login module to enable authentication for 
users that log in to the Operation Console. You configure the connection between the Operation Console and 
the JAAS login module. The login module must support storing the user principal in the JAAS shared state.
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Configure a JAAS Module for the Operation Console
If you use B2B Data Exchange native authentication, you can create a JAAS login module to connect to the 
authentication server before you configure authentication to the Operation Console.

For more information about the JAAS login module, browse to the following websites:

http://download.oracle.com/javase/6/docs/technotes/guides/security/jaas
/JAASRefGuide.html 
http://download.oracle.com/javase/6/docs/technotes/guides/security/jaas
/JAASLMDevGuide.html 

1. After you create the JAAS login module, copy the JAR file to the following directory: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/lib
2. Go to the home directory of the user account that runs the instance of Apache Tomcat in B2B Data 

Exchange and locate the file named dx-console.login.config. 

On Windows 7, the default user home directory is C:\Username. On Windows XP the default user home 
directory is C:\Documents and Settings\UserName. On UNIX systems, the default user home directory 
is /home/UserName. If the file does not exist, create a text file with the name dx-security.login.config 
in the following directory: <DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/
classesshared/conf/security

3. Add the following lines of code to the file and specify the class name of the JAAS module and any 
options required: 

DX-SECURITY {
<Class_Name_of_Login_Module> REQUISITE;
};

4. Save the file. 

Register the B2B Data Exchange Server Plug-in for 
PowerCenter

If you installed the B2B Data Exchange server plug-in for PowerCenter, register the plug-in to the PowerCenter 
repository where you create B2B Data Exchange workflows. If you do not register the plug-in, you cannot 
create B2B Data Exchange transformations in the PowerCenter Designer, and B2B Data Exchange cannot run 
PowerCenter workflows. Under these conditions, when B2B Data Exchange attempts to run a PowerCenter 
workflow and fails, B2B Data Exchange logs the following error in the PowerCenter workflow session log: 
[REP_12400 Repository Error ([REP_57140] Object does not exist).

The PowerCenter Repository Service must be running in exclusive mode when you register the plug-in. After 
the registration, restart the PowerCenter Repository Service in normal mode.

1. Log in to the Administration tool. 

2. In the Navigator, select the Repository Service for which you want to register the plug-in. 

3. On the Properties tab, edit the General Properties section and set the operating mode to Exclusive. 

4. Restart the Repository Service. 

5. After the Repository Service restarts, click the Plug-ins tab. 

6. Click the link to register a Repository Service plug-in. 

7. On the Register Plug-in for <Repository Service> page, click the Browse button to find the plug-in file. 
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Select the following file in the directory where you installed the B2B Data Exchange server plug-in for 
PowerCenter:

<DXInstallationDir>/powercenter/pluginVERSION/dxplugin.xml
Note: The B2B Data Exchange installer creates separate plug-in folders for each PowerCenter version. 
Make sure to select the plug-in folder for the PowerCenter version that you are using.

8. Enter the Repository Service administrator user name and password to log in to the repository. 

If the security group field appears, select the security group for the Repository Service administrator.

9. Click OK. 

The Repository Service registers the plug-in. Verify that the list of registered plug-ins for the Repository 
Service includes the B2B Data Exchange transformations.

10. On the Properties tab, edit the General Properties section and set the operating mode to Normal. 

11. Restart the PowerCenter Integration Service. 

Connect to a Remote Informatica Domain
If you do not have the Informatica services installed on the same machine as B2B Data Exchange, you can 
configure B2B Data Exchange to connect to a remote Informatica domain.

Verify that you can access the machine that hosts B2B Data Exchange from the machine hosting the 
Informatica services.

Perform the following tasks to connect to a remote Informatica domain:

• Modify the B2B Data Exchange configuration files to explicitly use the host name of the machine where 
B2B Data Exchange is installed.

• Configure the remote domain to access B2B Data Exchange.

• Update the Java security file to allow remote access to B2B Data Exchange.

Modify the B2B Data Exchange Host Name
Replace the default host name for the Operation Console with the actual name of the machine that hosts B2B 
Data Exchange.

Modify the host name information in the following files:

<DXInstallationDir>/conf/dx-configuration.properties
<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/dx-
configuration.properties

Back up the files before you update them.

1. Go to the following directory and locate the file named dx-configuration.properties: 

<DXInstallationDir>/conf/
2. Use a text editor to open the file. 

3. Search for the following text: 

dx.rmi.host=localhost
4. Replace localhost with the host name of the machine that hosts B2B Data Exchange. 

dx.rmi.host=DXHostName
5. Save the dx-configuration.properties file. 
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B2B Data Exchange maintains two copies of the dx-configuration.properties. The contents of the files 
must be identical.

6. Copy the updated dx-configuration.properties file to the following directory: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/

Configuring a PowerCenter Integration Service to Access B2B Data 
Exchange

During the B2B Data Exchange installation or upgrade, you define a PowerCenter Integration Service that B2B 
Data Exchange uses to run workflows. If required, you can configure a different PowerCenter Integration 
Service to access B2B Data Exchange.

In the Java classpath for the PowerCenter Integration Service, add the path to the B2B Data Exchange class 
files.

1. Log in to the Administrator tool and select the PowerCenter Integration Service that runs the workflows 
for B2B Data Exchange. 

2. On the Processes tab, edit the Java SDK ClassPath property and add the location of the B2B Data 
Exchange Java classes at the beginning of the ClassPath property: 

<DXInstallationDir>/powercenter/lib/dx-client-powercenter-10.2.0.jar;
<DXInstallationDir>/powercenter/lib/commons-logging-1.1.3.jar;
<DXInstallationDir>/powercenter/lib/log4j-1.2.17.jar;
<DXInstallationDir>/powercenter/lib/activemq-all-5.12.1.1.jar

Note: You can reference the libraries if the you can access the <DXInstallationDir> from PowerCenter, 
or you can copy the library files locally.

3. Add environment variables to the B2B Data Exchange console and server integration services. 

Integration Service Environment Variable

DX_CONSOLE_URL rmi://<HostName>:<dx.tpm.rmi.port>

DX_SERVER_URL rmi://<HostName>:<dx.rmi.port>

You can find the RMI port numbers for the console and server in the following location:

<DXInstallationDir>\conf\dx-configuration.properties
By default:

• dx.tpm.rmi.port: 18096

• dx.rmi.port: 18095

4. Save the changes. 

Configure Remote Access to B2B Data Exchange
Update the Java security file in PowerCenter to enable remote access to B2B Data Exchange.

1. Go to the PowerCenter installation directory on the remote machine and locate the files named 
java.policy and javaws.policy in the following directory: 

<PowerCenterInstallationDirectory>\java\jre\lib\security
2. Back up the files before you modify them. 

3. Use a text editor to open the java.policy and the javaws.policy files. 
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4. Search for the following text: 

permission java.security.AllPermission;
If you do not find the text, add it to the list of permissions. To add to the list of permissions, add the 
permission to the end of the grant command before the closing bracket:

permission java.security.AllPermission;
5. If you modify the java.policy or the javaws.policy files, save the files. 

Set Up the Run Publication SubscriptionB2B Data 
Exchange Web Services

If you want to use the Run Publication Subscription web services API, import the web service workflows into 
PowerCenter.

If the PowerCenter services and the B2B Data Exchange server run on separate machines, verify that the 
settings for the B2B Data Exchange server are set correctly.

Importing the Web Services to PowerCenter
When you install B2B Data Exchange, the B2B Data Exchange web services workflows are is installed in the 
<DX_INSTALLATION_DIR>/powercenter/webservices<DIH_InstallationDir>\powercenter\webservices 
folder. You must import the B2B Data Exchange web service workflows into PowerCenter before you can 
access the web services.

To use the web services, the Informatica domain must contain the following services:

• PowerCenter Repository Service

• Web Services Hub

• PowerCenter Integration Service

1. Use the PowerCenter Repository Manager to import the following workflow files into the PowerCenter 
repository: wf_m_DIH_WS_StartPublicationSubscription.xml. 

• wf_m_DX_WS_TPM.XML. Contains the workflows for the DX_TPM_Partner, DX_TPM_Account, and 
DX_TPM_Profile web services.

• wf_m_DX_WS_Endpoint.XML. Contains the workflow for the DX_Endpoint web service.

2. In the Web Services Hub console, verify that the B2B Data Exchange web services are is correctly 
imported into PowerCenter. If the import process is successful, the list of valid services includes the B2B 
Data Exchange web services. 

3. You can use the Try-It application in the Web Services Hub console to test the B2B Data Exchange web 
services. On the XML Input tab, enter the data into the SOAP message and click Send. To avoid 
authentication errors, do not use the Form Input page to test athe B2B Data Exchange web service. 

After you verify that the web services are is working, you can create a client application to send requests 
to the web services.
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Verifying the Server Settings
If the PowerCenter services and the B2B Data Exchange server run on separate machines, verify that the 
settings for the B2B Data Exchange server and Operation Console are set correctly.

In the Informatica Administrator, select the PowerCenter Integration Service that runs B2B Data Exchange 
workflows. Verify the following environment variable settings:

Environment 
Variable

Value

DX_SERVER_URL The RMI URL for B2B Data Exchange server.
For example:
rmi://<DXServerHostname>:<RMIPort>/TSSARuntime rmi://
<DIHServerHostname>:<RMIPort>/TSSARuntime
Note: <RMIPort> must match the dx.rmi.port parameter in the dx-
configuration.properties file. The default port number is 18095.

DX_CONSOLE_URL The RMI URL for the B2B Data Exchange Operation Console.
For example:
rmi://<DXServerHostname>:<RMIPort>/PartnerManagementService
Note: <RMIPort> must match the dx.tpm.rmi.port parameter in the dx-
configuration.properties file. The default port number is 18096.

Configure Credentials for Windows Authentication
If you installed any of the B2B Data Exchange repositories on a Microsoft SQL Server and you selected to use 
Windows authentication, configure the credentials that B2B Data Exchange uses to access the Microsoft SQL 
Server instance.

Before you start the configuration process, verify that all B2B Data Exchange Windows services are stopped 
and that the B2B Data Exchange Operation Console and the B2B Data Exchange server are not running.

1. Access the Windows Services window. 

2. Double-click the service Informatica B2B Data Exchange Server version. 

The B2B Data Exchange Server Properties window appears.

3. Select the Log On tab. 

4. Select This account, click Browse, and then specify a user account in the Select User dialog box. When 
you are finished, click OK. 

5. Type the password for the user account in Password and in Confirm password, and then click OK. 

6. Repeat steps 2 through 5 for the service Informatica B2B Data Exchange Console version. 

74       Chapter 5: Post-Installation Tasks



Set Up Database Partitions on the Publication 
Repository

It is highly recommended that you set up partitions on the publication repository database that stores 
published data sets. Partitions divide the stored published data set according to creation date, where each 
partition stores data sets that all applications publish on a specific date. By default, the publication 
repository does not use partitions.

When you set up partitioning, B2B Data Exchange reduces fragmentation by deleting expired data sets and 
reducing the time of data set creation and data consumption. You can set up partitions on Oracle and 
Microsoft SQL Server databases.

Use the B2B Data Exchange repository utility command enablePartitioning to create and manage the 
partitions in the publication repository database. The partitions state appears in the 
dih.staging.use.partitions.default system property. For more information about the B2B Data Exchange 
repository utility see the B2B Data Exchange Administrator Guide.

If you switch between a partitioned database and a non-partitioned database, the change affects topics, 
publications, and subscriptions that you create after the switch. Therefore, it is recommended that you 
choose a partition state before you start to use B2B Data Exchange. To switch the partition state for existing 
topics, publications, or subscriptions, contact Informatica Global Customer Service.

Configuring the Environment for a Hadoop 
Publication Repository

If you installed the B2B Data Exchange Hadoop Service component, configure the environment for a Hadoop 
publication repository.

To complete the task you perform the following actions:

1. Configure settings in the dx-configuration.properties file.

2. Verify references in the dih-hadoop-service.xml file.

3. Enable an option in Cloudera Manager.

1. On the machine where the B2B Data Exchange Hadoop Service is installed, use a text editor to open the 
dx-configuration.properties file from the following location: 

<DXInstallationDir>/DataIntegrationHub/tomcat/shared/classes/
2. Set the properties in the following sections of the file and then save the file: 

HIVE settings

Property Description

dih.hadoop.hive.username User name for connecting to the Apache Hive server.

dih.hadoop.hive.password Password of the user that connects to the Apache Hive server.
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Property Description

dih.hadoop.hive.url URL to the Apache Hive server in the following format:

jdbc:hive2://<hostname>:<port>/<schema>
Where:
- hostname is the host name or IP number of the server.
- port is the port number of the server. Default is 10000.
- schema is the schema used with the Hive warehouse. Default is 

default. If the Hive warehouse uses a non default schema, set the 
property dih.hadoop.service.warehouse.dir.

dih.hadoop.service.warehouse.dir Path to the Hive warehouse directory. Required if the Apache Hive 
server uses a non default schema. If the Apache Hive server uses a 
default schema, do not enter a value for this property.
For example:

dih.hadoop.hive.username=hive
dih.hadoop.hive.password=password
dih.hadoop.hive.url=jdbc:hive2://hive_host:10000/
myschema
dih.hadoop.service.warehouse.dir=/user/hive/
mydatawarehousedir

SPARK settings

Property Description

dih.hadoop.service.spark.version Apache Spark version. You can configure the version to be 1.3 
or 1.2. Default is 1.3.

dih.hadoop.service.spark.url Apache Spark URL.
- If Apache Spark is running in YARN mode, use the default 

value:
dih.hadoop.service.spark.url=yarn

- If Apache Spark is running in standalone mode, enter the URL 
in the following format:
spark://master_host:<port_number>
Where:
- master_host is the Master daemon which coordinates the 

operations of the Workers, which run the executors.
- <port_number> is the port number of the Master daemon. 

Default is 7077.
For example:
spark://Mymasterhost:7077
Note: The value you enter here must be identical to the value 
that is shown in the Spark console. By default, the Spark 
console is located at http://<host_name>:18080.

dih.hadoop.service.spark.additional.args Additional arguments for running jobs.
For example:

--executor-memory 20G --total-executor-cores 100
For a complete list of arguments see the Spark documentation.
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KERBEROS settings

If the Hadoop cluster uses Kerberos authentication, configure the following settings:

Property Description

dih.hadoop.principal Kerberos principal name in the following format:

<principal>/<domain>@<realm>

dih.hadoop.keytab.path Location and name of the keytab file.
For example:

dih.hadoop.principal=infa/admin@informatica.com
dih.hadoop.keytab.path=/etc/security/keytabs/infa.keytab
Note: The file name does not have to be infa.keytab.

3. On the machine where the B2B Data Exchange Hadoop Service is installed, use a text editor to open the 
dih-hadoop-service.xml file from the following location: 

<DXInstallationDir>/DataIntegrationHub/tomcat/conf/Catalina/localhost
4. Verify that the file contains the correct references to your Hadoop classpath configuration. By default, 

the file references a Cloudera VM configuration in the section Cloudera VM - sample default 
configurations. 

The file also contains references to Cloudera Manager and to Hortonworks VM, in the following 
commented out sections: Cloudera CDH - sample cloudera manager configurations and 
Hortonworks VM - sample default configurations. If required, comment out the Cloudera VM - 
sample default configurations section and uncomment the section that is appropriate to your 
configuration.

5. In Cloudera Manager, enable the option Bind NameNode to Wildcard Address and then restart the HDFS 
service. 

Log in to the Operation Console
You log in to the Operation Console with the administrator user account that you defined during installation.

If you use Informatica platform authentication, verify that all user accounts and user passwords exist on the 
authentication server.

1. Make sure that the Operation Console service is running. 

2. Access the Operation Console login page. 

• On Microsoft Windows or UNIX operating systems, open a browser window and enter the URL for the 
Operation Console in one of the following formats:

HTTP: http://<HostName>:<HTTPPortNumber>/
HTTPS: https://<HostName>:<HTTPSPortNumber>/

• On Microsoft Windows operating systems, click the Desktop shortcut to open a new browser window 
to the Operation Console URL.

3. Enter your user name and password and click Log In. 
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Configure Connections to the B2B Data Exchange 
Repositories

Configure connections to the B2B Data Exchange repositories. After you configure the connections, B2B Data 
Exchange creates the connections in the PowerCenter repository. B2B Data Exchange uses the connections 
details to create workflows for publications and for subscriptions, and to create data sources and data 
targets in PowerCenter .

To configure the connections, you must be logged in to the B2B Data Exchange Operation Console with the 
administrator user account.

1. In the Navigator, click Hub Management > Connections. 

The Connections page appears, showing the DIH__REPO and DIH__STAGING connections.

2. Click the Edit icon next to the DIH__REPO connection. 

The Edit Connection page appears, showing the DIH__REPO connection details. DIH__REPO is the 
connection to the B2B Data Exchange metadata repository that you defined during installation.

3. Configure the Database Name if applicable and the Data Access properties of the connection. For more 
information, see the B2B Data Exchange Administrator Guide. 

4. In the Edit Connection page, click Save. 

The Edit Connection page closes.

5. Click the Test Connection icon next to the DIH__REPO connection. 

B2B Data Exchange tests the connection. The process might take a few moments.

6. When the message "Connection successful" shows, click OK in the Test Connection dialog box. 

Note: The first time that you test connections in B2B Data Exchange, the test might fail with an error. 
Wait one minute and then test the connection.

If the test fails after you wait a few seconds, delete the folder DIH__SYSTEM_WORKFLOWS in PowerCenter, 
and then test the connection.

7. In the Navigator, click Connections. 

The Connections page appears.

8. Click the Edit icon next to the DIH__STAGING connection. 

The Edit Connection page appears, showing the DIH__STAGING connection details. DIH__STAGING is the 
connection to the B2B Data Exchange publication repository that you defined during installation.

9. Repeat steps 3 through 6 to configure and test the DIH__STAGING connection. 

10. If you installed the B2B Data Exchange Hadoop Service component, click the Edit icon next to the 
DIH__STAGING__HADOOP connection. 

The Edit Connection page appears, showing the DIH__STAGING__HADOOP connection details. 
DIH__STAGING__HADOOP is the connection to the B2B Data Exchange Hadoop-based publication 
repository.

11. Configure the following Hadoop Settings properties of the connection: 

Hadoop Cluster User

Name of the Hadoop cluster user account.
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NameNode URI

Use the following connection URI:

hdfs://<namenode>:<port>/<path>
Where

• <namenode> is the host name or IP address of the NameNode.

• <port> is the port on which NameNode listens for remote procedure calls (RPC).

• <path> is a working directory in HDFS. The Hadoop cluster user account must have full 
permissions to the working directory.

For example:

hdfs://mycluster:8020/user/claudera
Note: hdfs://<namenode>:<port> must be identical to property fs.defaultFS as it appears in the 
file core-site.xml.

Hadoop Distribution

Type of Hadoop distribution that the Hadoop cluster uses.

12. In the Edit Connection page, click Save. 

The Edit Connection page closes.

13. Click the Test Connection icon next to the DIH__STAGING__HADOOP connection. 

B2B Data Exchange tests the connection. The process might take a few moments.

14. When the message "Connection successful" shows, click OK in the Test Connection dialog box. 

Configure the Mail Server
When you set up an event monitor in the Operation Console, you can specify that the B2B Data Exchange 
server sends email notifications to users in the organization when the conditions of the monitor are met, 
such as when an error occurs. You must configure a mail server to send email notifications.

Note: To invite partners to use the Partners Portal, you must set up the mail server.

To configure a mail server, edit the following B2B Data Exchange system properties:

System Property Edit

dx.smtp.server Replace localhost with the host name of the mail server.

dx_email_from_field Replace the sample email address noreply@example.com with the 
return address for the email notification.

dx.smtp.port Replace the default port 25 with the port of the mail server.

dx.smtp.login Enter the user name for the mail server.

dx.smtp.password Enter the password for the mail server. B2B Data Exchange stores the 
password as an encrypted string.

dx.smtp.ssl If you use ssl (SMTPS) replace the default value false with true.
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Synchronize B2B Data Exchange Users
If you installed B2B Data Exchange with Informatica domain authentication or with Informatica domain with 
Kerberos authentication, synchronize B2B Data Exchange users in the B2B Data Exchange Operation Console.

To synchronize users in the Informatica security domain with B2B Data Exchange, the following conditions 
must be true:

• The Informatica security domain is configured on the Security page of Informatica Administrator.

• At least one security group in the Informatica security domain contains the B2B Data Exchange users to 
synchronize.

• The B2B Data Exchange system property dx.authentication.groups contains the list of groups from the 
Informatica security domain to synchronize, in the following format:

<group name>@<security domain> [;<groupname>@<security domain>]
• One of the groups that are defined in dx.authentication.groups contains the user that performs the 

synchronization.

• The user that is defined in the B2B Data Exchange system property pwc.repository.user.name has 
privileges to manage users, groups, and roles.

• The B2B Data Exchange user has privileges to synchronize users.

1. In the Navigator, click Administration > Users. 

The Users page appears.

2. Click Synchronize users and follow the instructions on the screen. 

3. For each user that is added to the Users page, assign the required privileges. For more information see 
the B2B Data Exchange Administrator Guide. 

Activate the Dashboard and Reports Component
If you installed the Dashboard and Reports component, perform the following tasks to activate the 
component:

• Register the license of the Dashboard and Reports component.

• Import the operational data store event loader to PowerCenter.

Register the Dashboard and Reports License
Register the license of the B2B Data Exchange Dashboard and Reports component.

1. Contact Informatica Global Customer Support to receive the Logi Info Dashboard license files. 

2. Start the B2B Data Exchange services. 

3. Move the file _Settings.lgx from the following location: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\webapps\dx-dashboard
\_Definitions

To the following location:

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\shared\classes
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Rename the file to the following name:

dx_dashboard_configuration.xml
4. Copy the Logi Info Dashboard license file _Settings_encrypted.lgx to the following location: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\webapps\dx-dashboard
\_Definitions

5. Rename the file _Settings_encrypted.lgx to _Settings.lgx. 

6. Restart the B2B Data Exchange services. 

To customize and enhance the Dashboard, the B2B Data Exchange developer installs and registers Logi Info 
Studio. For more information and installation instructions, see the B2B Data Exchange Developer Guide.

If the IP addresses of the machine that hosts B2B Data Exchange change any time after the installation, you 
must update the IP addresses in the Logi Info Dashboard license file. For more information, see “Updating 
the Dashboard Configuration File” on page 150.

Import the Operational Data Store Event Loader Workflow to 
PowerCenter

Import the operational data store (ODS) event loader workflow to load event information from the B2B Data 
Exchange repository to the B2B Data Exchange ODS.

If you use an existing workflow with the name DX_ETL, rename the existing workflow in PowerCenter 
Repository Manager before you import the ODS event loader workflow, or import the workflow to a different 
folder.
Note: After you import the ODS event loader workflow, do not run the workflow manually. The workflow must 
start at the scheduled time. If you start the workflow manually it might fail to store aggregated events in the 
B2B Data Exchange ODS.

1. In the PowerCenter Workflow Manager, select Connections > Relational. 

2. Add the DX_REPO connection for the B2B Data Exchange repository. 

3. Add the DX_ODS connection for the B2B Data Exchange ODS. 

4. In the PowerCenter Repository Manager, import the B2B Data Exchange ODS workflow file. The name of 
the workflow file depends on type of database on which the ODS is installed. 

Database Type Workflow Location and Name

Oracle <DXInstallationDir>\powercenter\ETL\DX_ETL.xml

Microsoft SQL Server <DXInstallationDir>\powercenter\ETL\DX_ETL_SQLSERVER.xml

5. In the PowerCenter Workflow Manager, connect to the PowerCenter repository. 

6. If B2B Data Exchange was previously installed at your site, and you want to exclude old events from the 
dashboard reports, instruct the workflow to load only events that finished processing after a specific 
date and time. Click Workflow > Edit > Variables and change the value of the $
$WF_Last_Load_End_Time variable. 

Note: Do not change the variable after the first time the workflow runs.

7. By default, the workflow runs every 15 minutes. You can schedule the workflow start time. 

8. Right-click the PowerCenter Integration Service that you want to assign to the ODS event loader 
workflow and select Assign to Workflows. 

The Assign Integration Service dialog box appears.
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9. Select the DX_ETL check box and then click Assign. 

PowerCenter assigns the Data Integration Service to the ODS event loader workflow.

Synchronize B2B Data Exchange Users
If you installed B2B Data Exchange with Informatica domain authentication or with Informatica domain with 
Kerberos authentication, synchronize B2B Data Exchange users in the B2B Data Exchange Operation Console.

1. In the Navigator, click Administration > Users. 

The Users page appears.

2. Click Synchronize users and follow the instructions on the screen. 

3. For each user that is added to the Users page, assign the required privileges. For more information see 
the B2B Data Exchange Administrator Guide. 

Customize the Partners Portal Logo
If you installed the Partners Portal component, you can brand the Partners Portal with the organization logo.

The Partners Portal requires two logo graphic files in .png format, a small logo and a large logo. The file for 
the small logo must be named Organization_logo.png and must be 144 pixels by 50 pixels. The file for the 
large logo must be named Login_Organization_logo.png and must be 170 pixels by 100 pixels. The logo 
graphics must be transparent.

1. Copy the Login_Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal
\img\Login_Organization_logo.png. 

This logo appears in the upper right corner of the Partners Portal login page.

2. Copy the Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal\img
\Organization_logo.png. 

This logo appears in the upper right corner of the Partners Portal tabs.
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C h a p t e r  6

Installing the Partners Portal on 
Non-B2B Data Exchange Nodes

This chapter includes the following topics:

• Installing the Partners Portal on Non-B2B Data Exchange Nodes Overview, 83

• Installing the Partners Portal on Non-B2B Data Exchange Nodes Requirements, 84

• Step 1. Install the Partners Portal , 85

• Step 2. Configure the Partners Portal Logo, 92

• Step 3. Set the Dashboard Properties, 93

Installing the Partners Portal on Non-B2B Data 
Exchange Nodes Overview

You can install the Partners Portal in your organization on a different node than the B2B Data Exchange node.

You can install the Partners Portal on Windows and UNIX operating systems. On Windows, run the B2B Data 
Exchange installer in graphical mode. On UNIX, run the B2B Data Exchange installer in console mode. When 
you run the installer, you must select only the B2B Data Exchange Partners Portal component.

Before you install, verify that your environment meets the installation requirements.

Verify the Minimum System Requirements
Verify that your system meets the minimum requirements.

The following table describes the minimum system requirements:

System Requirement

Operating system - Microsoft Windows
- IBM AIX
- Sun Solaris
- Red Hat Linux
- SUSE Linux

Processor 2 CPU cores
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System Requirement

RAM 2 GB for the B2B Data Exchange Partners Portal

Disk space 3 GB

Browser - Microsoft Internet Explorer
- Google Chrome

The following table describes the minimum system requirements to run the installer:

System Requirement

Operating system X Window server if you run the installer on a UNIX operating system in graphical mode.

RAM 512 MB

Disk space 1 GB

For more information about product requirements and supported platforms, see the Product Availability 
Matrix on the Informatica My Support Portal: https://mysupport.informatica.com/community/my-support/
product-availability-matrices

Installation Process
The Partners Portal installation process consists of the following tasks:

1. Install the Partners Portal.
Run the installer in graphical mode or in console mode to install the Partners Portal.

2. Optionally, configure the Partners Portal logo.

Installing the Partners Portal on Non-B2B Data 
Exchange Nodes Requirements

Before you install the Partners Portal, set up the node to run the installer. If you plan to brand the portal with 
your organization logo, follow the logo branding guidelines.

Partners Portal node

Follow these guidelines to set up the node where you plan to install the Partners Portal:

• B2B Data Exchange must be installed in the network.

• B2B Data Exchange and the Partners Portal must be deployed on the same operating system type.

• The Partners Portal requires file system level access to the B2B Data Exchange Document Store.

• Open HTTP or HTTPS ports from the external network to the node where you plan to install the 
Partners Portal. Configure the firewall to allow URLs that start with the suffix /dx-portal or /dx-
portal-help.
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Logo branding

Follow these guidelines if you plan to brand the Partners Portal with the organization logo:

• The Partners Portal requires two graphic files for a small logo and a large logo in .png format.

• The file for the small logo must be named Organization_logo.png and must be 144 pixels by 50 
pixels.

• The file for the large logo must be named Login_Organization_logo.png and must be 170 pixels by 
100 pixels.

• The logo graphics must be transparent.

Step 1. Install the Partners Portal
Based your operating system, install the Partners Portal in graphical mode or in console mode.

Installing the Partners Portal on Windows in Graphical Mode

1. Log in to the machine with the user account that you want to use to install the Partners Portal. 

2. Close all other applications. 

3. Run the Install.exe installer file from the root directory of the DVD or from the directory where you 
downloaded the installer. 

The Introduction page appears.

4. Read the instructions, and then click Next. 

The Install or Upgrade page appears.
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5. Select the option to install B2B Data Exchange, and then click Next. 

The Installation Directory page appears.

6. Enter the absolute path to the installation directory or accept the default directory. 

7. Click Next. 

The Installation Components page appears.

86       Chapter 6: Installing the Partners Portal on Non-B2B Data Exchange Nodes



8. Select B2B Data Exchange Partners Portal, and then click Next. 

The Metadata Repository Connection page appears.

Select to use an existing repository.

9. Enter values in the following fields: 

Field Description

Database type Type of database to use for the B2B Data Exchange metadata repository. You can 
choose one of the following options:
- Oracle
- Microsoft SQL Server

Database URL Location of the database. If you select this option, enter the values in the 
following fields:
- Database host name. Host name of the machine where the database server is 

installed.
- Database port. Port number for the database. The default port number for 

Oracle is 1521. The default port number for Microsoft SQL Server is 1433.
- Oracle database. Database SID. System identifier for the database. Enter either 

a fully qualified ServiceName or a fully qualified SID.
Note: It is recommended that you enter a ServiceName in this field.

- Microsoft SQL Server database. Database name.
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Field Description

Custom Connection String Connection string to the database. If you select this option, enter values in one of 
the following fields:
- JDBC string. JDBC connection string to the metadata repository.
- ODBC string. ODBC connection string to the metadata repository. Available if 

you install the PowerCenter Client plug-in. The installer cannot verify the 
validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you must 
specify a custom connection string. You cannot connect to the database 
instance with a database URL. For example, 
jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

Microsoft SQL Server 
database: Use Windows 
Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft 
Windows authentication mechanism. Available when you select a Microsoft SQL 
Server database.

Oracle database or 
Microsoft SQL Server 
database where you do not 
use Windows authentication: 
Database username

Name of the database user account.

Oracle database or 
Microsoft SQL Server 
database where you do not 
use Windows authentication: 
Database user password

Password for the database account. B2B Data Exchange stores the password as 
an encrypted string.

Note: The values that you enter here must be identical to the values that you entered in this page during 
B2B Data Exchange installation.

10. Click Next. 
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The Web Server page appears.

11. Enter values in the following fields: 

Field Description

Enable HTTPS Instructs B2B Data Exchange to use secure network communication when you open the 
Operation Console in the browser. If you select HTTPS and HTTP, the Operation Console 
switches existing HTTP connections with HTTPS connections.

Connector port 
number

Port number for the Tomcat connector to use when you open the Partners Portal or 
Operation Console with HTTPS.
The default value is 18443.

Use a keystore file 
generated by the 
installer

Instructs the installer to generate a keystore file with an unregistered certificate. If you 
select this option, ignore the security warning that you receive from the browser the first 
time you open the Operation Console.

Use an existing 
keystore file

Instructs the installer to load an existing keystore file. Enter values in the following 
fields:
- Keystore password. Password for the keystore file.
- Keystore file. Path to the keystore file.
The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 format.

HTTP connector port 
number

Port number for the HTTP connector. If you clear this field, your browser must connect to 
the B2B Data Exchange server with HTTPS when you log in to the Operation Console.
The default value is 18080.

Server shutdown 
listener port number

Port number for the listener that controls the Tomcat server shutdown.
The default value is 18005.

12. Click Next. 
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The Pre-Installation Summary page appears.

13. Verify that the installation information is correct, and then click Install. 

During the installation process, the installer displays progress information. When the installation process 
ends, the Installation Complete page appears.

14. Click Done to close the installer. 

15. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs. 

Installing the Partners Portal on UNIX in Console Mode

1. Log in to the machine with the user account that you want to use to install the Partners Portal. 

2. Close all other applications. 

3. Run the Install.bin -i console command. 

The Introduction section appears.

4. Read the installation instructions, and then press Enter. 

The Install or Upgrade section appears.

5. Select 1- Install B2B Data Exchange or any of its components, and then press Enter. 

The PowerCenter Version section appears.

6. Select the PowerCenter version for which you want to install B2B Data Exchange, and then press Enter. 

The Installation Directory section appears.

7. Enter the absolute path to the installation directory or accept the default directory, and then press Enter. 

The Installation Components section appears and displays a numbered list of the components to install.

8. Select 2- B2B Data Exchange Partners Portal, and then press Enter. 

The Metadata Repository Connection section appears.
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9. Enter the number for the B2B Data Exchange metadata repository database type or accept the default 
database type: 

Option Description

1- Oracle Oracle database.

2- Microsoft SQL Server Microsoft SQL Server database.

10. Enter the number for the metadata repository database connection type or accept the default connection 
type. 

Option Description

1- Database 
URL

Location of the database. If you select this option, enter values in the following fields:
- Database host name. Host name of the machine where the database server is installed.
- Database port number. Port number for the database. The default port number for Oracle is 

1521. The default port for Microsoft SQL Server is 1433.
- Oracle database. Database SID. System identifier for the database.
- Microsoft SQL Server database. Database name. Name of the database instance.

2- Custom 
Connection 
String

Connection string to the database. If you select this option, enter values in one of the following 
fields:
- JDBC string. JDBC connection string to the metadata repository.
- If you install the PowerCenter client plug-in: ODBC string. ODBC connection string to the 

metadata repository. The installer cannot verify the validity of the ODBC string.
Note: If you use a named Microsoft SQL Server database instance, you must specify a custom 
connection string. You cannot connect to the database instance with a database URL. For 
example, jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME; 

Note: The values that you enter here must be identical to the values that you entered in this section 
during B2B Data Exchange installation.

11. Press Enter. 

The Web Server section appears.

12. Configure the Web Server connection. 

a. Enter the number for the network communication protocol or accept the default protocol: 

Option Description

1- Enable 
HTTPS

Instructs B2B Data Exchange to use secure network communication when you open the 
Operation Console in the browser.
If you select HTTPS and HTTP, the Operation Console switches existing HTTP 
connections with HTTPS connections.

2- Enable HTTP Instructs B2B Data Exchange to use regular HTTP network communication when you 
open the Operation Console in the browser.
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b. If you selected Enable HTTPS, enter values in the following fields: 

Field Description

Connector port 
number

Port number for the Tomcat connector to use when you open the Operation 
Console with HTTPS.
The default value is 18443.

Use a keystore file 
generated by the 
installer

Instructs the installer to generate a keystore file with an unregistered certificate. If 
you select this option, ignore the security warning that you receive from the 
browser the first time you open the Operation Console.

Use an existing 
keystore file

Instructs the installer to load an existing keystore file. Enter values in the following 
fields:
- Keystore password. Password for the keystore file.
- Keystore file. Path to the keystore file.
The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 
format.

c. If you selected Enable HTTP, enter values in the following fields: 

Field Description

HTTP connector port 
number

Port number for the HTTP connector. If you clear this field, your browser must 
connect to the B2B Data Exchange server with HTTPS when you log in to the 
Operation Console.
The default value is 18080.

Server shutdown 
listener port number

Port number for the listener that controls the Tomcat server shutdown.
The default value is 18005.

13. Click Next. 

The Pre-Installation Summary section appears.

14. Verify that the installation information is correct, and then press Enter. 

During the installation process, the installer displays progress information.

15. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs 

Step 2. Configure the Partners Portal Logo
1. Copy the Login_Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal

\img\. 

This logo appears in the upper right corner of the Partners Portal login page.

2. Copy the Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal\img\. 

This logo appears in the upper right corner of the Partners Portal tabs.
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Step 3. Set the Dashboard Properties
When you install the Partners Portal with a stand-alone installation, set the Dashboard properties to ensure 
that you can view all the Dashboard charts in the Partners Portal.

1. Log in to the machine where you installed the Partners Portal. 

2. Edit the following properties in the dx-configuration.properties file in the directory \DX 
Installation directory\DataExchange\conf\: 

System Property Description

dx.dashboard.jdbc.username User name for the operational data store database.

dx.dashboard.jdbc.password Password for the operational data store in an encrypted string database. If you 
change the password you must encrypt the string with the password encryption 
utility and use the encrypted string.

dx.dashboard.jdbc.url Location of operational data store. The location must be different from the B2B 
Data Exchange repository.

3. Edit the same properties in the dx-configuration.properties file in the directory \DX Installation 
directory\DataExchange\tomcat\shared\classes\. 
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C h a p t e r  7

Upgrading B2B Data Exchange
This chapter includes the following topics:

• Upgrading B2B Data Exchange Overview, 94

• Before You Upgrade, 95

• Upgrading B2B Data Exchange on a Windows Operating System, 96

• Upgrading B2B Data Exchange on a UNIX Operating System, 118

• After You Upgrade, 126

Upgrading B2B Data Exchange Overview
You can upgrade the following versions of B2B Data Exchange directly to the latest version:

• B2B Data Exchange 10.0

• B2B Data Exchange 10.1

• B2B Data Exchange 10.1

• B2B Data Exchange 10.1.1

When you upgrade B2B Data Exchange, the installer backs up the files of the previous version of B2B Data 
Exchange and installs the new version. If the document store is found under the B2B Data Exchange 
Installation folder, you must move the document store to its original location after the upgrade process 
completes and before you start the DX service. You can create a new repository for the new version or you 
can use the existing repository. If you use the repository from the previous version, the installer upgrades the 
repository to the latest version. When you upgrade the B2B Data Exchange repository, you cannot change the 
database server type and server location.

Before you start the upgrade process, perform the procedures that are described in “Before You Upgrade” on 
page 95. Then run the B2B Data Exchange installer. After the upgrade, perform the procedures that are 
described in “After You Upgrade” on page 126.

For more information about the B2B Data Exchange configuration that you can perform after you upgrade, 
see Chapter 4, “B2B Data Exchange Installation” on page 22.

Note: During the upgrade you cannot change the user authentication method that B2B Data Exchange uses. 
To change the user authentication method you must first upgrade the system and then switch to the required 
authentication method. For information about switching between authentication methods see the B2B Data 
Exchange Administrator Guide.
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Before You Upgrade
To prepare for the upgrade, perform the following tasks:

1. Verify that you have the user names and passwords for the required database accounts.

2. Verify that no publications or subscriptions are running and that all events are in a Final state.

Tip: You can view the state of all events in the B2B Data Exchange Operation Console, on the Event List 
page.

3. Ensure that the all topics are in a Valid status.

Tip: You can view the status of all topics in the B2B Data Exchange Operation Console, on the Topics 
page.

4. Ensure that the retention management job is not running. If the retention management job is running, you 
will see an incomplete System Event for the retention management job.

Note: If the publication repository is used by applications other than B2B Data Exchange, you might lose 
data in the tables that are not managed by B2B Data Exchange when the upgrade is complete.

5. Ensure that the dx.endpoint.file.prefix property is empty.

Note: This property is the landing zone path. Earlier releases of Data Integration Hub do not support this 
property. If this property value is not empty, then set it to an empty value.

6. Stop all B2B Data Exchange services. The B2B Data Exchange upgrade modifies the B2B Data Exchange 
files. The installer cannot proceed if the files are in use.

Note: If the B2B Data Exchange Hadoop Service component is installed on a different machine than the 
machine where you installed B2B Data Exchange, stop the services on both machines. For more 
information, see “Starting and Stopping B2B Data Exchange on UNIX” on page 137.

7. Stop all PowerCenter workflows that process B2B Data Exchange documents. In PowerCenter, stop all 
workflows that process B2B Data Exchange documents. Do not start the workflows again until the 
upgrade is complete.

8. Unschedule all custom workflows in PowerCenter. In PowerCenter, unschedule all custom workflows 
and verify that they do not run until the upgrade is complete.

9. Back up the B2B Data Exchange repository to be upgraded. Use the database server backup utility to 
back up the repository. This ensures that you can recover from any errors that you encounter during the 
upgrade.

10. Back up the B2B Data Exchange publication repository to be upgraded. Use the database server backup 
utility to back up the repository. This ensures that you can recover from any errors that you encounter 
during the upgrade.

11. Back up the existing B2B Data Exchange installation folder. Perform this action to help ensure that you 
can recover from any errors encountered during the upgrade, and that, after the upgrade, you can reapply 
modifications that were made to the configuration in previous versions.

12. If the PowerCenter services are not installed on the same machine where B2B Data Exchange is installed 
and you have upgraded the pmrep command line utility after you installed the previous version of B2B 
Data Exchange, clean up all CNX files from the Tmp folder on your root directory.

13. If the Partners Portal was not installed on your system in previous versions and you want to install the 
portal when you upgrade to the new version, open ports to the portal in your firewall.
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Opening Ports to the Partners Portal
If you want to install the Partners Portal, enable access to the portal in the firewall by opening the HTTP or 
HTTPS ports from the external network to the Portal server.

Configure the firewall to allow URLs that start with the suffix /dx-portal and /dx-portal-help only.

To ensure that outside access to the Partners Portal is securely performed, assign the external hostname 
URL for the portal to the dx.portal.url system property. For more information about configuring system 
properties in the B2B Data Exchange Operation Console, see the B2B Data Exchange Administror Guide.

Upgrading B2B Data Exchange on a Windows 
Operating System

Upgrade B2B Data Exchange on Windows operating systems in graphical mode. On UNIX operating systems, 
upgrade B2B Data Exchange in console mode.

Before you install, verify that your environment meets the minimum system requirements, perform the pre-
installation tasks, and verify that the PowerCenter services are running.

Note: During the upgrade, B2B Data Exchange saves log files in the home directory of the user in the 
subdirectory named DXLogs. If the upgrade does not complete successfully, you can view the log files in this 
location.

Step 1. Run the Installer
1. Log in to the machine with the user account that you want to use to install B2B Data Exchange. 

To prevent permission errors, use the same account to install B2B Data Exchange and PowerCenter.

2. Close all other applications. 

3. Run Install.exe from the root directory of the DVD or from the directory where you downloaded the 
installer. 

The Introduction page appears.

4. Read the instructions, and then click Next. 

96       Chapter 7: Upgrading B2B Data Exchange 



The Install or Upgrade page appears.

5. Select the option to upgrade B2B Data Exchange, and then click Next. 

The Installation Directory page appears.
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Step 2. Define Installation Settings
1. On the Installation Directory page, enter the absolute path to the installation directory or accept the 

default directory. 

Note: You must select the same installation directory where you installed the previous B2B Data 
Exchange version.
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2. Click Next. 

The Installation Components page appears.

3. Select the components to install: 
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B2B Data Exchange

Installs the core B2B Data Exchange application.
Selected by default.

B2B Data Exchange Partners Portal

Installs the B2B Data Exchange Partners Portal component. You must install B2B Data Exchange to 
install the Partners Portal component.
Selected by default.

B2B Data Exchange Dashboard and Reports

Installs the B2B Data Exchange Dashboard and Reports component. You must install B2B Data 
Exchange to install the Dashboard and Reports component.
Cleared by default.

Note: 

• If you install the Dashboard and Reports component, you must import the operational data store 
event loader after you install B2B Data Exchange.

• If you install the Dashboard and Reports component, your B2B Data Exchange and operational 
data store repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 
10, you must configure the repository connections in PowerCenter Workflow Manager. For 
details, see “Configuring Repository Connections on PowerCenter Version 10” on page 151.

• If you do not install the Dashboard and Reports component, the Dashboard will not be available 
in the Partners Portal.

B2B Data Exchange PowerCenter server plug-in

Installs the B2B Data Exchange plug-in for the PowerCenter services. After the installation, you 
register the plug-in to the PowerCenter repository.
Selected by default.

B2B Data Exchange PowerCenter client plug-in

Installs the B2B Data Exchange plug-in for the PowerCenter Client. Install this component on every 
machine that runs the PowerCenter Client.
Selected by default.

B2B Data Exchange Informatica Data Quality

Enables B2B Data Exchange to use Data Quality mappings for custom publications and 
subscriptions.
Select this component if you want to create custom publications and subscriptions that use Data 
Quality mappings in B2B Data Exchange.

Cleared by default.

B2B Data Exchange OEM Managed File Transfer

Adds the OEM Managed File Transfer component to B2B Data Exchange. You must install B2B Data 
Exchange to install the OEM Managed File Transfer component.
Selected by default.

4. Click Next. 

The Metadata RepositoryMetadata Repository page appears.

Step 3. Configure B2B Data Exchange Repositories Repository
1. On the Metadata Repository page, select one of the following options: 
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• Create a B2B Data Exchange repository. Creates a repository in the database.

• Create a Data Integration Hub repository. Creates a repository in the database.

• Use an existing B2B Data Exchange repository. Uses the tables and data in an existing B2B Data 
Exchange repository and upgrades the repository.
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• Use an existing Data Integration Hub repository. Uses the tables and data in an existing B2B Data 
Exchange repository and upgrades the repository.

2. Click Next. 
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The Metadata Repository Connection page appears.

3. Enter values in the following fields: 
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Database type

Type of database to use for the B2B Data Exchange metadata repository. You can choose one of the 
following options:

• Oracle

• Microsoft SQL Server

Database URL

Location of the database.
If you select this option, enter the values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for Oracle is 1521. The 
default port number for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if the database is Oracle. Enter either a fully 
qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database. Database name.

Custom Connection String

Connection string to the database.
If you select this option, enter values in one of the following fields:

• JDBC string. JDBC connection string to the metadata repository.

• ODBC string. ODBC connection string to the metadata repository. Available if you install the 
PowerCenter Client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.

Database username

Name of the database user account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication.

Database user password

Password for the database account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication. B2B Data Exchange stores the password as an 
encrypted string.

4. Click Next. 
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The Publication Repository Connection page appears.

5. Enter values in the following fields: 

Database type

Type of database to use for the publication repository. The database type must match the B2B Data 
Exchange metadata repository database type and appears in read-only mode.

Database URL

Location of the database.
If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for Oracle is 1521. The 
default port for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if the database is Oracle. Enter either a fully 
qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database: Database name. Name of the database instance.

Custom Connection String

JDBC connection string to the database.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.
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Database username

Name of the database user account for the Oracle database or Microsoft SQL Server database 
where you do not use Windows authentication.

Database user password

Password of the database account for the Oracle database or Microsoft SQL Server database where 
you do not use Windows authentication. B2B Data Exchange stores the password as an encrypted 
string.

6. Click Next. 

If you selected the B2B Data Exchange Dashboard and ReportsData Integration Hub Dashboard and 
Reports component, the Operational Data Store page appears. If you did not select the Dashboard and 
Reports component, go to “Step 5. Configure the Web Server Configure Web Server and Port 
Numbers” on page 109.

Step 4. Set Up the Operational Data Store
1. On the Operational Data Store page, select one of the following options: 

• Create an operational data store repository. Creates an operational data store repository in the 
database.
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• Use an existing operational data store repository. Uses the tables and data in an existing operational 
data store repository.

2. Click Next. 
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The Operational Data Store Database Connection page appears.

3. Enter values in the following fields: 
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Database URL

Location of the database. If you select this option, enter the values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port. Port number for the database. The default port number for the Oracle is 1521. 
The default port number for the Microsoft SQL Server is 1433.

• Database SID. System identifier for the database if you select Oracle as the database. Enter 
either a fully qualified ServiceName or a fully qualified SID.

Note: It is recommended that you enter a ServiceName in this field.

• Microsoft SQL Server database. Database name.

Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the Operational Data Store.

• ODBC string. ODBC connection string to the Operational Data Store. Available if you install the 
PowerCenter Client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

Use Windows Authentication

Instructs B2B Data Exchange to authenticate user names against the Microsoft Windows 
authentication mechanism. Available when you select a Microsoft SQL Server database.

Database username

Name of the operational data store user account for the Oracle database or the Microsoft SQL 
Server database where you do not use Windows authentication.

Database user password

Password for the operational data store account for the Oracle database or the Microsoft SQL 
Server database where you do not use Windows authentication. B2B Data Exchange stores the 
password as an encrypted string.

4. Click Next. 

The Web Server page appears.

Step 5. Configure the Web Server Configure Web Server and Port 
Numbers

1. On the Web Server page enter values in the following fields: 

Enable HTTPS

Instructs B2B Data Exchange to use secure network communication when you open the Operation 
Console in the browser. If you select HTTPS and HTTP, the Operation Console switches existing 
HTTP connections with HTTPS connections.
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Connector port number

Port number for the Tomcat connector to use when you open the Operation Console with HTTPS.
The default value is 18443.

Use a keystore file generated by the installer

Instructs the installer to generate a keystore file with an unregistered certificate. If you select this 
option, ignore the security warning that you receive from the browser the first time you open the 
Operation Console.

Use an existing keystore file

Instructs the installer to load an existing keystore file. Enter values in the following fields:

• Keystore password. Password for the keystore file.

• Keystore file. Path to the keystore file.

The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 format.

2. Click Next. 

The Port Numbers page appears.

If you selected to install the B2B Data Exchange server plug-in for PowerCenter or the B2B Data 
Exchange client plug-in for PowerCenter components, the PowerCenter Location page appears. If you 
did not select the PowerCenter server or client components, the PowerCenter Web Services Hub page 
appears.

3. Enter the port number for the B2B Data Exchange JMS Broker JMX listener port or accept the default 
port, and then click Next. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter or the B2B Data 
Exchange client plug-in for PowerCenter components, the PowerCenter Location page appears. If you 
did not select the PowerCenter server or client components, the PowerCenter Web Services Hub page 
appears.
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Step 6. Configure PowerCenter Settings
1. On the PowerCenter Web Services Hub page, enter the PowerCenter web services details. 

Web Services Hub URL

URL that the PowerCenter Web Services Hub uses when B2B Data Exchange transfers documents to 
PowerCenter for processing with batch workflowsto process publication and subscription 
workflows.

Service name

Name of the PowerCenter Repository Service.

Node host name

Host name of the node that runs the PowerCenter Repository Service.

Node port number

Port number of the node that runs the PowerCenter Repository Service.

Username

Name of the PowerCenter Repository Service user.

Password

Password for the PowerCenter Repository Service user. B2B Data Exchange stores the password as 
an encrypted string.

Security domain

Optional. Name of the Informatica security domain in which the PowerCenter Repository Service 
user is stored.
Default is Native.

2. Click Next. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter component, the 
Informatica DomainPowerCenter Domain Settings page appears.
If you did not select the PowerCenter server component, the PowerCenter pmrep Command Line Utility 
Location page appears. Go to step 5.
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If you did not select the PowerCenter server component, the Pre-Installation Summary page appears. Go 
to “Step 78. Complete the Installation” on page 117.

3. Enter values in the following fields: 
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Domain name

Name of the Informatica domain that contains the PowerCenter Integration Service that runs B2B 
Data Exchange workflows.

Node name

Node in the Informatica domain on which the PowerCenter Integration Service runs.

Domain administrator username

Name of the Informatica domain administrator.

Domain administrator password

Password for the Informatica domain administrator. B2B Data Exchange stores the password as an 
encrypted string.

Integration Service name

The name of the PowerCenter Integration Service that B2B Data Exchange uses to run workflows.

4. Click Next. 

The PowerCenter pmrep Command Line Utility Location page appears.

5. Specify the location of the pmrep command line utility. 

Upgrading B2B Data Exchange on a Windows Operating System       113



The location of the utility depends on whether or not you install B2B Data Exchange on the machine 
where the PowerCenter services are installed.

Environment Location of the pmrep command line utility

B2B Data Exchange installed on the 
machine where the PowerCenter 
services are installed

<PowerCenter_services_installation_folder>
\<PowerCenter_version>\tools\pcutils
\<PowerCenter_version>

B2B Data Exchange and PowerCenter 
services installed on different 
machines

<PowerCenter_client_installation_folder>
\<PowerCenter_version>\clients\PowerCenterClient
\client\bin

6. Click Next. 

If you selected to install the B2B Data Exchange Informatica Data Quality component, the Informatica 
Data Quality Domain Settings page appears. If you did not select to install the B2B Data Exchange 
Informatica Data Quality component, theThe Pre-Installation Summary page appears.
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Step 7. Configure Data Quality Settings
1. If you selected to install the B2B Data Exchange Informatica Data Quality component, the Informatica 

Data Quality Domain Settings page appears. 

Enter values in the following fields:
Domain name

Domain name of the node on which the Data Integration Service runs.

Host name

Host name of the node on which the Data Integration Service runs.

Port number

Port number of the node on which the Data Integration Service runs.

Domain administrator username

User name for the node on which the Data Integration Service runs.

Domain administrator password

Password for the node on which the Data Integration Service runs.

Security Domain

Optional. Name of the Informatica security domain in which the Model Repository Service user is 
stored.

Data Integration Service name

Name of the Data Integration Service.

Model Repository Service name

Name of the Model Repository Service.

2. Click Next. 
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The Informatica Data Quality infacmd Command Line Utility page appears.

3. Enter the location of the infacmd command line utility or accept the default directory, and then click 
Next. 

The Pre-Installation Summary page appears.
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Step 78. Complete the Installation
1. On the Pre-Installation Summary page, verify that the installation information is correct, and then click 

Install. 

During the installation process, the installer displays progress information. When the installation process 
ends, the Post-Installation Actions page appears.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the wizard instructions to 
register the plug-in to the PowerCenter repository, and then click Next. 

The Installation Complete page appears.

3. Click Done to close the installer. 

4. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs. 

5. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

6. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 
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Upgrading B2B Data Exchange on a UNIX Operating 
System

Upgrade B2B Data Exchange on UNIX operating systems in console mode. On Windows operating systems, 
upgrade B2B Data Exchange in graphical mode.

Before you install, verify that your environment meets the minimum system requirements, perform the pre-
installation tasks, and verify that the PowerCenter services are running.

Note: During the upgrade, B2B Data Exchange saves log files in the home directory of the user, in the 
subdirectory named DXLogs. If the upgrade does not complete successfully, you can view the log files in this 
location.

Step 1. Run the Installer
1. Log in to the machine with the user account that you want to use to install B2B Data Exchange. 

To prevent permission errors, use the same account to install B2B Data Exchange and PowerCenter.

2. Close all other applications. 

3. Run Install.bin -i console from the root directory of the DVD or from the directory where you 
downloaded the installer. 

The Introduction section appears.

4. Read the instructions, and then press Enter. 

The Install or Upgrade section appears.

5. Enter 2 to upgrade B2B Data Exchange, and then press Enter. 

The Installation Directory section appears.

Step 2. Define Installation Settings
1. In the Installation Directory section, enter the absolute path to the installation directory or accept the 

default directory, and then press Enter. 

The Installation Components section appears and displays a numbered list of the components to install.

2. Enter a comma-separated list of numbers for the components to install or accept the default 
components: 

1- B2B Data Exchange

Installs the core B2B Data Exchange application.
Selected by default.

2- B2B Data Exchange Partners Portal

Installs the B2B Data Exchange Partners Portal component. You must install B2B Data Exchange to 
install the Partners Portal component.
Selected by default.

3-2- B2B Data Exchange Dashboard and Reports

Installs the B2B Data Exchange Dashboard and Reports component. You must install B2B Data 
Exchange to install the Dashboard and Reports component.
Cleared by default.
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4-3- B2B Data Exchange Server Plug-in for PowerCenter

Installs the B2B Data Exchange PowerCenter server plug-in component. After the installation, 
register the plug-in to the PowerCenter repository.
Selected by default.

4- B2B Data Exchange Hadoop Service

Connecting module between B2B Data Exchange and the Hadoop cluster. Enables B2B Data 
Exchange to perform operations on the Hadoop publication repository.
Select this component if you want to define a Hadoop-based publication repository and manage 
some of your topics on Hadoop.

Note: The B2B Data Exchange Hadoop Service must be installed on an edge node in the Hadoop 
cluster. Unless you are installing B2B Data Exchange on a Hadoop edge node, do not select this 
component during B2B Data Exchange installation. In this case, after you complete the B2B Data 
Exchange installation, run the installation again on the edge node and select to install only the B2B 
Data Exchange Hadoop Service component on the node.

5- B2B Data Exchange Big Data Management/Informatica Data Quality

Enables B2B Data Exchange to use Big Data Management and Data Quality mappings for custom 
publications and subscriptions.
Select this component if you want to create custom publications and subscriptions that use Big 
Data Management or Data Quality mappings in B2B Data Exchange.

5- B2B Data Exchange OEM Managed File Transfer

Adds the OEM Managed File Transfer component to B2B Data Exchange. You must install B2B Data 
Exchange to install the OEM Managed File Transfer component.
Selected by default.

3. Press Enter. 

The Metadata Repository section appears.

Step 3. Configure B2B Data Exchange Repository Repositories
1. In the Metadata Repository section, enter the number for the metadata repository database 

configuration option or accept the default option: 

1- Create a B2B Data Exchange repository

Creates a repository in the database.

1- Create a Data Integration Hub repository

Creates a repository in the database.

2- Use an existing B2B Data Exchange repository

Uses the tables and data in an existing repository.

2- Use an existing Data Integration Hub repository

Uses the tables and data in an existing repository.

2. Press Enter. 

The Metadata Repository Connection section appears.

3. Enter 1 to use an Oracle database as the B2B Data Exchange metadata repository database. 

4. Enter the number for the metadata repository database connection type or accept the default connection 
type: 
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1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Database SID. System identifier for the database.

2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the metadata repository.

• ODBC string. ODBC connection string to the metadata repository. Applicable if you install the 
PowerCenter client plug-in. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

5. Enter values in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

6. Press Enter. 

If you selected to install the B2B Data Exchange Dashboard and Reports component, the Operational 
Data Store section appears. If you did not select to install the Dashboard and Reports component, go to 
“Step 5. Configure the Web Server Configure the Web Server and Port Numbers” on page 122.

7. Enter the number for the publication repository connection type or accept the default connection type. 

Note: When using Microsoft SQL Server named instances, you must define a custom connection string.

1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Oracle database: Database SID. System identifier for the database.

• Microsoft SQL Server database: Database name. Name of the database instance.

2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the publication repository.
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• ODBC string. Applicable if you install the PowerCenter client plug-in. ODBC connection string to 
the publication repository. The installer cannot verify the validity of the ODBC string.

Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

8. Press Enter. 

9. Enter values in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

10. Press Enter. 

If you selected to install the B2B Data Exchange Dashboard and Reports component, the Operational 
Data Store section appears. If you did not select to install the Dashboard and Reports component, go to 
“Step 5. Configure the Web Server Configure the Web Server and Port Numbers” on page 122.

Step 4. Set Up the Operational Data Store
1. In the Operational Data Store section, enter the number for the database configuration option for the 

operational data store or accept the default option: 

1- Create an operational data store repository

Creates an operational data store repository in the database.

2- Use an existing operational data store repository

Uses the tables and data in an existing operational data store repository.

2. Enter the number for the database connection type for the operational data store or accept the default 
connection type: 

1- Database URL

Location of the database. If you select this option, enter values in the following fields:

• Database host name. Host name of the machine where the database server is installed.

• Database port number. Port number for the database. The default port number for Oracle is 
1521. The default port for Microsoft SQL Server is 1433.

• Oracle database: Database SID. System identifier for the database.

• Microsoft SQL Server database: Database name. Name of the database instance.

2- Custom Connection String

Connection string to the database. If you select this option, enter values in one of the following 
fields:

• JDBC string. JDBC connection string to the Operational Data Store.

• If you install the PowerCenter client plug-in: ODBC string. ODBC connection string to the 
Operational Data Store. The installer cannot verify the validity of the ODBC string.
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Note: If you use a named Microsoft SQL Server database instance, you cannot connect to the 
database instance using the Database URL option. Use the Custom Connection String option.

For example:

jdbc:informatica:sqlserver://MYSQLSERVERCOMPUTERHOSTNAME
\MYDBINSTANCENAME;DatabaseName=MYDATABASENAME;

3. Enter values for the operational data store in the following fields: 

Database username

Name of the database user account for the Oracle database or the Microsoft SQL Server database.

Database user password

The password for the database account for the Oracle database or the Microsoft SQL Server 
database. B2B Data Exchange stores the password as an encrypted string.

4. Press Enter. 

The Web Server section appears.

Step 5. Configure the Web Server Configure the Web Server and 
Port Numbers

1. Configure the Web Server connection. 

a. Enter the number for the network communication protocol or accept the default protocol: 

1- Enable HTTPS

Instructs B2B Data Exchange to use secure network communication when you open the 
Operation Console in the browser.
If you select HTTPS and HTTP, the Operation Console switches existing HTTP connections with 
HTTPS connections.

2- Enable HTTP

Instructs B2B Data Exchange to use regular HTTP network communication when you open the 
Operation Console in the browser.

b. If you selected Enable HTTPS, enter values in the following fields: 

Connector port number

Port number for the Tomcat connector to use when you open the Operation Console with 
HTTPS.
The default value is 18443.

Use a keystore file generated by the installer

Instructs the installer to generate a keystore file with an unregistered certificate. If you select 
this option, ignore the security warning that you receive from the browser the first time you 
open the Operation Console.

Use an existing keystore file

Instructs the installer to load an existing keystore file. Enter values in the following fields:

• Keystore password. Password for the keystore file.

• Keystore file. Path to the keystore file.

The keystore file must be in the Public Key Cryptography Standard (PKCS) #12 format.
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c. If you selected Enable HTTP, enter values in the following fields: 

HTTP connector port number

Port number for the HTTP connector. If you clear this field, your browser must connect to the 
B2B Data Exchange server with HTTPS when you log in to the Operation Console.
The default value is 18080.

Server shutdown listener port number

Port number for the listener that controls the Tomcat server shutdown.
The default value is 18005.

2. Press Enter. 

The Port Numbers section appears.

3. Press Enter. 

If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 
PowerCenter Client plug-in components, the PowerCenter Location section appears. If you did not select 
the PowerCenter server or client components, the PowerCenter Web Services Hub section appears.

4. Enter the port number for the B2B Data Exchange JMS Broker JMX listener port or accept the default 
port and then press Enter. 

If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 
PowerCenter Client plug-in components, the PowerCenter Location section appears. If you did not select 
the PowerCenter server or client components, the PowerCenter Web Services Hub section appears.

Step 6. Configure PowerCenter Settings
1. If you selected to install the B2B Data Exchange PowerCenter server plug-in or the B2B Data Exchange 

PowerCenter Client plug-in components, in the PowerCenter Location section, enter the directory where 
you installed PowerCenter or accept the default directory, and then press Enter. 

The PowerCenter Web Services section appears.

2. In the PowerCenter Web Services section, press Enter to accept the default URL or enter the URL that 
the PowerCenter Web Services Hub uses when B2B Data Exchange transfers documents to PowerCenter 
for processing with batch workflowsto process publication and subscription workflows and then press 
Enter. 

3. Enter the name of the PowerCenter Repository Service, and then press Enter. 

4. Enter values in the following fields: 

Node host name

Host name of the node that runs the PowerCenter Repository Service.

Node port number

Port number of the node that runs the PowerCenter Repository Service.

Username

Name of the PowerCenter Repository Service user.

Password

Password for the PowerCenter Repository Service user. B2B Data Exchange stores the password as 
an encrypted string.
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Security domain

Optional. Name of the Informatica security domain in which the PowerCenter Repository Service 
user is stored.
Default is Native.

5. Press Enter. 

If you selected to install the B2B Data Exchange server plug-in for PowerCenter component, the 
Informatica DomainPowerCenter Domain Settings section appears. If you did not select the 
PowerCenter server component, the PowerCenter pmrep Command Line Utility Location section 
appears. Go to step 9.If you did not select the PowerCenter server component, the Pre-Installation 
Summary section appears. Go to “Step 8. Complete the Installation” on page 126.

6. Enter values in the following fields: 

Domain name

Name of the Informatica domain that contains the PowerCenter Integration Service that runs B2B 
Data Exchange workflows.

Node name

Node in the Informatica domain on which the PowerCenter Integration Service runs.

Domain administrator user name

Name of the Informatica domain administrator.

Domain administrator password

Password for the Informatica domain administrator. B2B Data Exchange stores the password as an 
encrypted string.

7. Press Enter. 

8. Enter the name of the PowerCenter Integration Service that B2B Data Exchange uses to run workflows, 
and then press Enter. 

9. Enter the location of the pmrep command line utility and then press Enter. The location of the utility 
depends on whether or not you install B2B Data Exchange on the machine where the PowerCenter 
services are installed. 

Note: On Linux operating systems, pmrep must be executable.

Environment Location of the pmrep command line utility

B2B Data Exchange installed on the 
machine where the PowerCenter 
services are installed

<PowerCenter_services_installation_folder>/
<PowerCenter_version>/tools/pcutils/
<PowerCenter_version>

B2B Data Exchange and PowerCenter 
services installed on different 
machines

<PowerCenter_client_utility_directory>/PowerCenter/
server/bin

10. Press Enter. 

The Pre-Installation Summary section appears. If you selected to install the B2B Data Exchange Big 
Data Management/Informatica Data Quality component, the Big Data Management/Informatica Data 
Quality Domain name section appears. If you did not select to install the B2B Data Exchange Big Data 
Management/Informatica Data Quality component, the Pre-Installation Summary section appears. 
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Step 7. Complete the Installation
1. In the Pre-Installation Summary section, verify that the installation information is correct, and then press 

Enter. 

During the installation process, the installer displays progress information.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the on-screen instructions to 
register the plug-in to the PowerCenter repository, and then press Enter. 

3. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs 

4. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

5. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 

Step 7. Configure Processing Engine Settings
1. In the Big Data Management/Informatica Data Quality Domain name section, press Enter to accept the 

default domain name or enter the name of the Informatica domain, and then press Enter. 

The Big Data Management/Informatica Data Quality Host name section appears.

2. Press Enter to accept the default host name or enter the host name of the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality Port number section appears.

3. Press Enter to accept the default port number or enter the port number of the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality administrator user name section appears.

4. Press Enter to accept the default user name or enter the user name for the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality administrator password section appears.

5. Press Enter to accept the default password or enter the password for the node on which the Data 
Integration Service runs and then press Enter. 

The Big Data Management/Informatica Data Quality Security Domain section appears.

6. Optionally, enter the name of the Informatica security domain in which the Model Repository Service user 
is stored. Press Enter. 

The Big Data Management/Informatica Data Quality Data Integration Service name section appears.

7. Press Enter to accept the default name or enter the name of the Data Integration Service and then press 
Enter. 

The Big Data Management/Informatica Data Quality Model Repository Service name section appears.

8. Press Enter to accept the default name or enter the name of the Model Repository Service and then 
press Enter. 

The Big Data Management/Informatica Data Quality infacmd Command Line Utility Location section 
appears.

9. Press Enter to accept the default location or enter the location of the infacmd command line utility then 
press Enter. 

The Pre-Installation Summary section appears.

Upgrading B2B Data Exchange on a UNIX Operating System       125



Step 8. Complete the Installation
1. In the Pre-Installation Summary section, verify that the installation information is correct, and then press 

Enter. 

During the installation process, the installer displays progress information.

2. If you installed the B2B Data Exchange PowerCenter server plug-in, follow the on-screen instructions to 
register the plug-in to the PowerCenter repository, and then press Enter. 

3. To view the log files that the installer generates, navigate to the following directory: 
<DXInstallationDir>\logs 

4. Perform the required post-installation tasks. 

For more information, see Chapter 5, “Post-Installation Tasks” on page 68.

Note: Perform only the tasks that are relevant for your environment.

5. Optionally, perform additional configuration tasks. For more information, see Chapter 9, “Optional B2B 
Data Exchange Configuration” on page 138. 

After You Upgrade
After you upgrade, update the B2B Data Exchange configuration files to work with the upgraded instance of 
B2B Data Exchange.

To update the configuration files and complete the upgrade process, perform the following steps:

1. Reapply modifications that were made to B2B Data Exchange configuration files in previous versions.

2. If you installed the Dashboard and Reports component, register the license of the Dashboard and 
Reports component.

3. If you installed the Dashboard and Reports component, import the operational data store (ODS) loader 
workflow.

4. To unregister the existing PowerCenter server plug-in, click the Plug-ins tab after the Repository Service 
restarts. Click the unregister icon (next to the existing plug-in) to unregister the plug-in.

5. Use the PowerCenter Administration Console to register the plug-in in the PowerCenter repository.

6. Restart PowerCenter workflows.

7. Start the B2B Data Exchange Server.

8. If any of the B2B Data Exchange repositories are installed on a Microsoft SQL Server and use Windows 
authentication, configure credentials for Windows authentication.

9. Update the security configuration files.

10. If any of the B2B Data Exchange repositories are installed on a Microsoft SQL Server and do not have 
partitions, delete all B2B Data Exchange partition functions. For example: 
DIH__DATE_PARTITION_FUNCTION.

11. If you are using the B2B Data Exchange Run Publication Subscription Web Service API, update the API.

12. Update the B2B Data Exchange custom workflows in PowerCenter.

13. If you installed the B2B Data Exchange Hadoop Service component for the first time, configure your 
environment for a Hadoop-based publication repository. For more information, see “Configuring the 
Environment for a Hadoop Publication Repository” on page 75.
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14. Start the B2B Data Exchange services. For more information, see Chapter 8, “Starting and Stopping B2B 
Data Exchange” on page 136.

Note: If you installed the B2B Data Exchange Hadoop Service component on a different machine than the 
machine where you installed B2B Data Exchange, start the services on both machines. For more 
information, see “Starting and Stopping B2B Data Exchange on UNIX” on page 137.

15. If you installed the B2B Data Exchange Hadoop Service component for the first time, log in to the 
Operation Console and configure the DIH__STAGING__HADOOP connection. For more information, see 
“Configure Connections to the B2B Data Exchange Repositories” on page 78.

16. Run the importexport script to update the entities managed by B2B Data Exchange in PowerCenter.

17. Clear the browser cache on each of the client machines.

18. If you upgrade the Partners Portal component, to provide existing portal users with Partners Portal 
privileges, create portal user groups and then assign each portal user to a portal user group.

Note: If you do not assign a portal user to a portal user group, the portal user can only view the 
Dashboard in the Partners Portal.

19. If you installed the Partners Portal component, you can brand the Partners Portal with the organization 
logo.

Note: If you used your logo in the previous version, you must perform this task after the upgrade in order 
to re-brand the portal.

20. If you use real-time publication workflows, enable the property Enable high precision in the session that 
writes data to the B2B Data Exchange publication repository in all the real-time publication workflows.

21. Update the B2B Data Exchange custom workflows in PowerCenter.

22. If you use custom workflows, update the B2B Data Exchange publication repository in all the real-time 
publication workflows.

23. Update the entities that are managed by B2B Data Exchange in PowerCenter.

24. Update the custom workflows for events view enhancements.

25. If you installed the OEM Managed File Transfer component, perform the following procedures:

• Register the component license.

• To ensure secure access, change the default username and password and configure the relevant B2B 
Data Exchange settings.

Note: The B2B Data Exchange installer does not delete the previous version of B2B Data Exchange. The 
installer renames the folder with the suffix _Backupn.n.n where n.n.n is the version number that you 
upgraded. To ensure that you update the configuration files correctly, see the configuration files in the 
directory of the previous version of B2B Data Exchange.

If you installed the OEM Managed File Transfer component when you upgraded B2B Data Exchange, refer to 
the documentation suite for B2B Data Exchange version 10.1 for usage information.
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Related Topics:
• “Importing the Web Services to PowerCenter” on page 73

Reapplying Configuration Modifications
Reapply modifications that were made to B2B Data Exchange configuration files in previous versions.

To perform this procedure, you must have backed up the B2B Data Exchange installation folder.

1. Open the following file from the location where you backed up the B2B Data Exchange installation folder: 

<BackupDir>/conf/dx-configuration.properties
2. On the machine where B2B Data Exchange is installed, open the server and console copies of the dx-

configuration.properties files in a text editor from the following locations: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\shared\classes\
<DXInstallationDir>\conf\

3. Copy any relevant configuration changes from the file that you backed up to both the dx-
configuration.properties files. 

4. Save the dx-configuration.properties files. 

Registering the Dashboard and Reports License
Register the license of the B2B Data Exchange Dashboard and Reports component.

1. Start the B2B Data Exchange services. 

2. Move the file _Settings.lgx from the following location: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\webapps\dx-dashboard
\_Definitions

To the following location:

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\shared\classes
Rename the file to the following name:

dx_dashboard_configuration.xml
3. Reapply modifications that were made to the file dx_dashboard_configuration.xml in previous 

versions. 

4. Copy the Logi Info Dashboard license file _Settings_encrypted.lgx to the following location: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\webapps\dx-dashboard
\_Definitions

5. Rename the file _Settings_encrypted.lgx to _Settings.lgx. 

6. Restart the B2B Data Exchange services. 

Replacing the Operational Data Store Loader Workflow
If you installed the Dashboard and Reports component for the first time, import the operational data store 
(ODS) loader workflow. If the Dashboard and Reports component was installed in the previous version of B2B 
Data Exchange and you are upgrading to the current version from a version earlier than 9.6.2, replace the 
existing workflow.

Note: If the Dashboard and Reports component was installed in the previous version of B2B Data Exchange, 
you must have unscheduled the B2B Data Exchange ODS loader workflow before you upgraded B2B Data 
Exchange to the current version. For more information, see GUID-8BD86874-0566-47F6-99C8-16427FA8E887.

1. In PowerCenter Repository Manager, run the Import Wizard. 
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2. Select the B2B Data Exchange ODS loader workflow file. The name of the workflow file depends on the 
type of database on which the ODS is installed: 

Database Type Workflow Location and Name

Oracle <DXInstallationDir>\powercenter\ETL\DX_ETL.xml

Microsoft SQL Server <DXInstallationDir>\powercenter\ETL\DX_ETL_SQLSERVER.xml

3. If the Dashboard and Reports component was installed in the previous version of B2B Data Exchange 
and you are upgrading to the current version from version 9.6.1, select the PowerCenter repository folder 
that contains the B2B Data Exchange ODS loader workflow from the previous version as the import 
folder target. 

4. If the Dashboard and Reports component was installed in the previous version of B2B Data Exchange, in 
the Conflict Resolution Wizard, select Replace. 

In the Apply this resolution to list, select All Conflicts. Click Next.

5. If the Dashboard and Reports component was installed in the previous version of B2B Data Exchange, in 
the Conflict Resolution Wizard, select Replace. In the Apply this resolution to list, select All Conflicts. 
Click Next. 

6. In the Global Copy Options area select the options Retain Sequence Generator, Normalizer, or XML key 
current values and Retain Persistent Mapping Variable Values. 

7. Follow the instructions in the Import Wizard to complete the import of the workflow. 

Configure Credentials for Windows Authentication
If you installed any of the B2B Data Exchange repositories on a Microsoft SQL Server and you selected to use 
Windows authentication, configure the credentials that B2B Data Exchange uses to access the Microsoft SQL 
Server instance.

Before you start the configuration process, verify that all B2B Data Exchange Windows services are stopped 
and that the B2B Data Exchange Operation Console and the B2B Data Exchange server are not running.

1. Access the Windows Services window. 

2. Double-click the service Informatica B2B Data Exchange Server version. 

The B2B Data Exchange Server Properties window appears.

3. Select the Log On tab. 

4. Select This account, click Browse, and then specify a user account in the Select User dialog box. When 
you are finished, click OK. 

5. Type the password for the user account in Password and in Confirm password, and then click OK. 

6. Repeat steps 2 through 5 for the service Informatica B2B Data Exchange Console version. 

Updating the Security Configuration Files
To perform this procedure, you must have backed up the B2B Data Exchange installation folder.

1. Open the following folder from the location where you backed up the B2B Data Exchange installation 
folder: 

<BackupDir>\shared\conf\security\ 
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2. Copy all the files from the backup security folder to the following folder: 

<DXInstallationDir>\shared\conf\security\
Overwrite existing files.

Updating the Run Publication Subscription Web Service API
If you are using the B2B Data Exchange Run Publication Subscription Web Service API, update the API before 
you start the B2B Data Exchange services.

1. Import the runpublicationsubscription B2B Data Exchange web service workflow to PowerCenter. 

2. Update your client application to use the new web service. 

Restart the B2B Data Exchange Services
Restart the B2B Data Exchange Server and other services. For more information, see Chapter 8, “Starting and 
Stopping B2B Data Exchange” on page 136.

Restart the B2B Data Exchange Server and the B2B Data Exchange Console services.

Creating a Portal User Group
When you upgrade the Partners Portal component, create portal user groups in the Operation Console.

Note: If you do not assign a portal user group to a portal user, the portal user can only view the Dashboard in 
the Partners Portal.

1. In the Navigator, click Administration > Portal User Groups. 

The Portal User Groups page appears.

2. To create a portal user group, click New User Group. 

3. To assign privileges to a portal user group, in the Privileges tab select the privileges to assign. 

• To assign the portal user role, select Portal User Role.

• To view the Dashboard in the Partners Portal, click View Dashboard. Alternatively, to assign all 
Dashboard privileges, click Dashboard.

• To view the Event List in the Partners Portal, click View Event List. Alternatively, to assign all Event 
List privileges, click Event List.

• You can set the following message profile privileges in the Partners Portal:

- To view message profiles, click View Message Profiles

- To edit message profiles, click Edit Message Profiles.

- Alternatively, to assign all privileges, click Message Profile.

a. To assign the portal user role, select Portal User Role. 

Note: You cannot save the portal user group without assigning the portal user role.

b. To view the Dashboard in the Partners Portal, click View Dashboard. Alternatively, to assign all 
Dashboard privileges, click Dashboard. 

c. To view the Event List in the Partners Portal, click View Event List. Alternatively, to assign all Event 
List privileges, click Event List. 

d. You can set the following message profile privileges in the Partners Portal: 
- To view message profiles, click View Message Profiles
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- To edit message profiles, click Edit Message Profiles.
- Alternatively, to assign all privileges, click Message Profile.

e. You can set the following endpoint privileges in the Partners Portal: 
- To view endpoints, click View Endpoints.
- To edit the password for organization hosted FTP or FTPs endpoints, click Change Password.
- Alternatively, to assign all privileges, click Endpoint.

f. You can set the following file exchange privileges in the Partners Portal: 
- To view file exchanges, click View File Exchange.
- To download files from the portal, click Download Files.
- To upload files to the portal, click Upload Files.
- To delete files on the portal, click Delete Files.
- Alternatively, to assign all privileges, click File Exchange.

4. Click Save. 

Assigning a Portal User to a Portal User Group
When you upgrade the Partners Portal component, after you create portal user groups, assign portal users to 
portal user groups.

1. In the Navigator, click Partner Management > Portal Users. 

2. To add the portal user to a user group, in the User Groups tab, select a user group from the Available 
User Groups panel and transfer the group to the Selected User Groups panel. 

When you assign the portal user to a user group, the portal user obtains all the privileges associated with 
the user group. You can select more than one user group. If you do not assign a user group, the portal 
user can only view the Dashboard in the Partners Portal.

3. To save the changes, click Save. 

Customize the Partners Portal Logo
If you installed the Partners Portal component, you can brand the Partners Portal with the organization logo.

The Partners Portal requires two logo graphic files in .png format, a small logo and a large logo. The file for 
the small logo must be named Organization_logo.png and must be 144 pixels by 50 pixels. The file for the 
large logo must be named Login_Organization_logo.png and must be 170 pixels by 100 pixels. The logo 
graphics must be transparent.

1. Copy the Login_Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal
\img\Login_Organization_logo.png. 

This logo appears in the upper right corner of the Partners Portal login page.

2. Copy the Organization_logo.png file to the following directory: dx\tomcat\webapps\dx-portal\img
\Organization_logo.png. 

This logo appears in the upper right corner of the Partners Portal tabs.

Configure Data Archive
If you are upgrading to the current version, you must configure Data Archive.

1. Close B2B Data Exchange. Do not run any archive jobs related to B2B Data Exchange. 

2. Update the dx.archive.jdbc.url, dx.archive.jdbc.username, and dx.archive.jdbc.password properties with 
the values for the URL, the user name, and the password that you use to access the history database. 
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Update these properties in the dx-configuration.properties file located in the directory 
<DXInstallationDir>/conf/. Also update these properties in the dx-configuration.properties file 
located in the directory <DXInstallationDir>/tomcat/shared/classes/. 

3. Start B2B Data Exchange. 

Updating the B2B Data Exchange Custom Workflows in 
PowerCenter

Before you start the B2B Data Exchange services, update the B2B Data Exchange custom workflows in 
PowerCenter.

Update the following workflows:

• Flat file publications

• Flat file subscriptions

• Relational database publications

• Relational database subscriptions

1. To update flat file publications, perform the following steps: 

a. In PowerCenter, change the name of the input file so that the file name has the following format: 

$InputFile<someUserSpecificName>
b. Import the workflows to B2B Data Exchange and add the values of the parameters in the file. 

c. If you use a publication repository that is installed on a Microsoft SQL Server, change the 
PowerCenter workflow Target_Load type from bulk to normal. 

d. In the PowerCenter session properties, change the file type to Indirect. 

e. If you use a publication repository that is installed on a Microsoft SQL Server, change the B2B Data 
Exchange publication instance date and all fields in the source that have a datetime data type to 
datetime2. 

2. To update flat file subscriptions, perform the following steps: 

a. If you use a publication repository that is installed on a Microsoft SQL Server, change the B2B Data 
Exchange publication instance date and all fields in the source that have a datetime data type to 
datetime2. 

b. Update the precision of the <tableName>__PublicationInstanceIDs and 
<tableName>___PublicationInstanceDatesSQL mapping parameters to 90000. 

3. To update relational database publications, perform the following steps: 

a. If you use a publication repository that is installed on a Microsoft SQL Server, change the 
PowerCenter workflow Target_Load type from bulk to normal. 

b. In the PowerCenter session properties, change the file type to Indirect. 

c. If you use a publication repository that is installed on a Microsoft SQL Server, change the B2B Data 
Exchange publication instance date and all fields in the source that have a datetime data type to 
datetime2. 

4. To update relational database subscriptions, perform the following steps: 

a. If you use a publication repository that is installed on a Microsoft SQL Server, change the B2B Data 
Exchange publication instance date and all fields in the source that have a datetime data type to 
datetime2. 

b. Update the precision of the <tableName>__PublicationInstanceIDs and 
<tableName>___PublicationInstanceDatesSQL mapping parameters to 90000. 

132       Chapter 7: Upgrading B2B Data Exchange 



Updating Entities Managed by B2B Data Exchange in PowerCenter
After you start the B2B Data Exchange service, update the entities managed by B2B Data Exchange in 
PowerCenter.

1. Navigate to the following directory: 

<DIHInstallationDir>\dx-tools\
2. To update the entities, run the importexport command with the following syntax: 

• On Windows operating systems: importexport.bat -u <dih_username> -p <dih_password> -c 
noimport -v all

• On UNIX operating systems: importexport.sh -u <dih_username> -p <dih_password> -c 
noimport -v all

Updating Custom Workflows for Events View Enhancements
Copy the m__DIH_sub_route_event route event mapping changes from any of the automatic publication or 
subscription workflows in PowerCenter to your custom workflows.

1. Add the following ports to the expression transformation: 

• DXTargetSuccessRows - Expression = TgtSuccessRows
• DXTargetFailedRows = TgtFailedRows
• DXSourceFailedRows = SrcFailedRows
• DXSourceSuccessRows = SrcSuccessRows

2. Connect the ports to the NotifyDX transformation. 

Register the OEM Managed File Transfer License
If you upgraded B2B Data Exchange and installed the OEM Managed File Transfer component, register the 
license before you launch Managed File Transfer.
Before you complete this task, verify that you have the following prerequisites:

• The license details you received from Informatica shipping.

• Internet access to the Cleo Licensing server at https://license.cleo.com:443.

After installing OEM Managed File Transfer, you must register your license for this component.

1. Log in to the B2B Data Exchange Operation Console with an administrator user account. 

2. In the Navigator, click Administration > MFT Console. 

The Informatica B2B Managed File Transfer console opens in another web page. If you are registering 
the license for the first time after you install, the Informatica B2B Managed File Transfer Product 
Registration window appears. If the license is registered, click Tools > Register to access the 
Informatica B2B Managed File Transfer Product Registration window.

3. Enter the license details you received from Informatica shipping in the Serial Number field and click 
Check Registration. 

The Informatica B2B Managed File Transfer window appears.

4. Enter the required information and click Register. 

A message informs you that the registration is successful.

5. Click OK to close the Informatica B2B Managed File Transfer Product Registration window. 
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6. Based on whether the license is registered or not, perform one of the following actions: 

a. If the license is not registered, B2B Data Exchange opens the Managed File Transfer login window. 

Go to step 7.

b. If the license is registered, go to step 9. 

7. Select Edit mode and enter dxadmin in the Password field. 

8. Click OK to close the license registration window. 

9. In the Navigator, click Administration > MFT Console and verify the registration by logging in to the 
Informatica B2B Managed File Transfer window. 

10. Click Tools > License > Request Permanent License to convert the temporary license you installed to a 
permanent license. 

For information about configuring your firewall and testing your setup, see the B2B Data Exchange Managed 
File Transfer User Guide (VersaLex Powered by Cleo).

Configuring User Name and Password for the OEM Managed File 
Transfer

If you upgraded B2B Data Exchange and installed the OEM Managed File Transfer component, to ensure that 
access to the Managed File Transfer component is secure, change the user name and password from the 
default settings.

After you create a user name and password to use Managed File Transfer with B2B Data Exchange, edit the 
following B2B Data Exchange system properties with the Operator Console:

System Property Edit

dx.endpoint.mft.username Enter the user name for Managed File Transfer.

dx.endpoint.mft.password Enter the internal password for Managed File Transfer. Use the password for edit- and 
view-only operations.
You must restart the B2B Data Exchange server to apply the change.
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For information about how to define permissions and add user groups for Managed File Transfer, refer to the 
B2B Data Exchange Managed File Transfer User Guide.

If you install the B2B Data Exchange Partners Portal component, to ensure that access between the Partners 
Portal and Managed File Transfer is secure, edit the following properties in the dx-
configuration.properties file:

System Property Edit

internal.service.username Enter an internal username for access between the B2B Data Exchange Partners Portal 
and Managed File Transfer.

internal.service.password Enter an encrypted password for access between the B2B Data Exchange Partners Portal 
and Managed File Transfer. Use the dxpassword utility to encrypt the password.

The dx-configuration.properties file is located in the following directories:

• DXInstallationDir>\DataExchange\conf\ 
• DXInstallationDir>\DataExchange\tomcat\shared\classes\ 
To encrypt a password with the dxpassword utility, in the directory DXInstallationDir>\dx-tools\, do the 
following:

• In Windows, use the following command:

dxpasswd.bat -p toEncrypt
• In Unix, use the following command:

dxpasswd.sh -p toEncrypt

After You Upgrade       135



C h a p t e r  8

Starting and Stopping B2B Data 
Exchange

This chapter includes the following topics:

• Overview of Starting and Stopping B2B Data Exchange, 136

• Starting and Stopping B2B Data Exchange on Windows, 136

• Starting and Stopping B2B Data Exchange on UNIX, 137

Overview of Starting and Stopping B2B Data 
Exchange

Stop or start the B2B Data Exchange services.

For example, start the services after you install B2B Data Exchange, or stop the services before you upgrade 
B2B Data Exchange.

Starting and Stopping B2B Data Exchange on 
Windows

Start and stop the B2B Data Exchange services from the Start menu or run the startup and shutdown scripts.

The installer creates shortcuts in the Start menu to start and stop all B2B Data Exchange services.

Starting and Stopping B2B Data Exchange from the Start Menu
On Windows operating systems, you can use the Start menu to start and stop all B2B Data Exchange 
services. You cannot start or stop a single service from the Start menu.

1. In the Start menu, click Informatica > B2B Data Exchange. 

2. Choose one of the following options: 

• Start Services. Starts all B2B Data Exchange services.

136



• Stop Services. Stops all B2B Data Exchange services.

• Operation Console. Opens the Operation Console in a Web browser.

Starting and Stopping B2B Data Exchange with Batch Scripts
On Windows operating systems, you can run scripts to start and stop one or more B2B Data Exchange 
services.

1. Navigate to the following directory: 

<DXInstallationDir>\bin
2. Choose the script to run. 

• startup.bat. Starts all B2B Data Exchange services.

• shutdown.bat. Stops all B2B Data Exchange services.

• Start each of these services separately in the listed order:

- activemq.bat. Starts the B2B Data Exchange JMS Broker.

- mft.bat. Starts the B2B Managed File Transfer service.

- dxconsole.bat. Starts the Operation Console.

- dxserver.bat. Starts the B2B Data Exchange server.

Starting and Stopping B2B Data Exchange on UNIX
Run the scripts to start or stop the B2B Data Exchange services. The installer creates shell scripts that you 
can use to start or stop all the B2B Data Exchange services or to start each service separately. You cannot 
stop each service separately.

1. Navigate to the following directory:

<DXInstallationDir>/bin
2. Choose the script to run.

• startup.sh. Starts all B2B Data Exchange services.

• shutdown.sh. Stops all B2B Data Exchange services.

• Start each of these services separately in the listed order:

- activemq.sh. Starts the B2B Data Exchange JMS Broker.

- mft-server.sh. Starts the Informatica Managed File Transfer service.

- mft.sh. If you upgraded B2B Data Exchange and installed the OEM Managed File Transfer, this 
command starts the OEM Managed File Transfer service.

- dxconsole.sh. Starts the Operation Console.

- dxserver.sh. Starts the B2B Data Exchange server.

Note: If you installed the B2B Data Exchange Hadoop Service component on a different machine than the 
machine where you installed B2B Data Exchange, to stop or to start the Hadoop service on the machine 
where the service is installed, run the startup.sh or shutdown.sh script from the following location:

<DXInstallationDir>/DataIntegrationHub/tomcat/bin/
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C h a p t e r  9

Optional B2B Data Exchange 
Configuration

This chapter includes the following topics:

• Optional B2B Data Exchange Configuration Overview, 138

• Modifying Port Numbers, 139

• Modifying the B2B Data Exchange Server RMI Port Number, 142

• Logs, 142

• Changing the Maximum Java Heap Size, 146

• Changing the Credentials for a Database User Account, 147

• Changing the Credentials for the Data Integration Hub Hadoop Service, 149

• Updating the Dashboard Configuration File, 150

• Configuring the pmrep Process Pool, 150

• Configuring a PowerCenter Integration Service to Access B2B Data Exchange, 151

• Configuring Repository Connections on PowerCenter Version 10, 151

• Configuring the B2B Data Exchange JMS Broker, 152

• Activating the ActiveMQ Web Console, 152

• Configure System Properties to Enable Informatica Managed File Transfer Access, 153

• Installing a Single Sign On Key , 153

• Sharing Informatica Managed File Transfer Directories with B2B Data Exchange, 154

• Adding Variables to Custom Informatica Managed File Transfer Projects, 155

Optional B2B Data Exchange Configuration Overview
Optional configuration includes tasks that you might want to perform after you install or upgrade B2B Data 
Exchange, or at a later date.

• The B2B Data Exchange components send information through ports. You can change the default port 
numbers based on the requirements of your network environment.

• When different components process information or encounter errors, log files contain information that 
you can use to analyze and troubleshoot the installed components. You can change the location of the log 
files or define custom logs.
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• To increase performance and reliability, you can change the maximum memory allocation for the B2B 
Data Exchange JMS Broker service, the embedded B2B Data Exchange server broker, or the embedded 
B2B Data Exchange console broker.

• If you change the database user credentials for the B2B Data Exchange repositoryrepositories or for the 
operational data store, you must update the B2B Data Exchange configuration files. If you are running the 
Dashboard and Reports component, you must also update the relevant PowerCenter connections.

• If you use a Hadoop-based publication repository and you change the credentials for the user account of 
the B2B Data Exchange Hadoop Service, you must update the B2B Data Exchange configuration files.

• If you use the Dashboard and Reports component, and the IP addresses of the machine that hosts B2B 
Data Exchange change any time after the installation, you must update the IP addresses in the dashboard 
configuration file.

• To speed up the system response time when you create connections, topics, publications, and 
subscriptions in the B2B Data Exchange Operation Console, configure the pmrep process pool.

Note: This step is relevant to systems running PowerCenter 9.5.1 HotFix 4 and PowerCenter 9.6.1 HotFix 1 
or higher.

• For the B2B Data Exchange Dashboard and Reports component, you can specify a user name, password, 
and location for the operational data store user account.

• During the B2B Data Exchange installation or upgrade, you define a PowerCenter Integration Service that 
B2B Data Exchange uses to run workflows. If required, you can configure a different PowerCenter 
Integration Service to access B2B Data Exchange.

• If you use the Dashboard and Reports component, your B2B Data Exchange and operational data store 
repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 10, configure the 
repository connections in PowerCenter Workflow Manager.

• If you want to change JMS broker communication settings, configure attributes to modify control of the 
JMS broker.

• To use the Active MQ Web Console to troubleshoot JMS broker communications, access the Active MQ 
Web Console, then use the predefined username and password.

• If you installed the Informatica Managed File Transfer component, perform the following procedures:

- Configure the relevant B2B Data Exchange system properties and restart B2B Data Exchange before you 
try to access Informatica Managed File Transfer from the Operations Console.

- You must enable SSO with Informatica Managed File Transfer before you try to access Informatica 
Managed File Transfer from the Operations Console. To enable SSO, copy the keystore from the 
Informatica Managed File Transfer server and the install an SSO key on the B2B Data Exchange server.

- Share the B2B Data Exchange download directory and the Informatica Managed File Transfer Web User 
directories with both B2B Data Exchange and Informatica Managed File Transfer Web.

- If you create a custom project in Informatica Managed File Transfer, ensure that you include specific 
variables to pass information from B2B Data Exchange system properties.

Modifying Port Numbers
You can modify the port numbers that B2B Data Exchange uses to send and receive information.

You can modify the numbers of the following ports:

• B2B Data Exchange server startup and shutdown port
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• B2B Data Exchange server RMI port

• JNDI provider port

Modifying the B2B Data Exchange Server Startup and Shutdown 
Port Number

On Windows operating systems, edit the Java Service Wrapper file to configure the B2B Data Exchange 
server to use a different port. On UNIX and Windows operating systems, run the dxserver command line utility 
with the different port number.

When you start the B2B Data Exchange server with a different port number, you must use the same port 
number when you ping or shut down the B2B Data Exchange server.

1. On Windows operating systems, edit the Java Service Wrapper file. 

a. On the machine where B2B Data Exchange is installed, open the wrapper.conf file in a text editor 
from the following directory: 

<DXInstallationDir>/conf
b. Search for the following text: 

wrapper.app.parameter.2=start
c. Add the following line below the text: 

wrapper.app.parameter.3=<PortNumber>
d. Replace the <PortNumber> value with the port number that you want to use. 

e. Save the wrapper.conf file. 

2. On Windows and UNIX operating systems, run the following command to restart the B2B Data Exchange: 

• Windows: dxserver.bat start <PortNumber>
• UNIX: dxserver.sh start <PortNumber>

Modifying the B2B Data Exchange Server RMI Port Number
Replace the RMI port number in the dx-configuration.properties files and in the PowerCenter Integration 
Service.

1. On the machine where B2B Data Exchange is installed, open the server and console copies of the dx-
configuration.properties files in a text editor from the following locations: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/
<DXInstallationDir>/conf/

2. Enter the port number in the following property: 

dx.rmi.port=
3. Save the dx-configuration.properties files. 

4. In the Administrator tool, select the PowerCenter Integration Service that runs B2B Data Exchange 
transformations. 

5. On the Processes tab of the PowerCenter Integration Service, add or edit the DX_SERVER_URL 
environment variable and set the URL of the B2B Data Exchange server in the following format: 

 rmi://<HostName>:<PortNumber>
6. Save the changes and restart the B2B Data Exchange services. 
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After you change the RMI port number, make sure you use it when you run the command line utilities. For 
example, to use the port number when you import, export, or archive B2B Data Exchange repository objects, 
run the command line utilities with the following options:

• Import: importexport -c import -f <ExportFile> -s <SpecificationFile> -u <UserID> --server 
<"HostName:PortNumber">

• Export: importexport -c export -f <ExportFile> -s <SpecificationFile> -u <UserID> --server 
<"HostName:PortNumber">

• Archive: archive -s <SpecificationFile> -u <UserID> --server <"HostName:PortNumber">

Note: You may encounter B2B Data Exchange performance and stability issues when using the basic archive 
command line utility in B2B Data Exchange. It is recommended to use the Data Archive utility for archiving 
high volumes of event data in production.

Modifying the JNDI Provider Port Number
PowerCenter uses the JNDI provider to find the JMS queues that B2B Data Exchange uses to send and 
receive messages. When you change the JNDI port number, change it in the B2B Data Exchange workflow 
connection objects in PowerCenter and in the dx.endpoint.jms.provider.url B2B Data Exchange system 
property. If you use JMS endpoints, also change the port number in the activemq.xml file and in the JMS 
endpoint properties.

1. In the Workflow Manager, update the port number in the JNDI Provider URL attribute of the JNDI 
connection object for all B2B Data Exchange workflows. 

2. In the Operation Console, click Administration > System Properties. 

The System Properties page appears.

3. In the dx.endpoint.jms.provider.url, change the port number in the property value. 

The following example shows the property value with the default port number:

failover:tcp://localhost:18616
4. In the Operation Console, click Partner Management > Endpoints. 

The Endpoints page appears.

5. In each JMS Send or JMS Receive endpoint, change the port number in the value of the Provider URL 
property. 

6. On the machine where B2B Data Exchange is installed, open the activemq.xml file in a text editor from 
the following directory: 

<DXInstallationDir>\message-broker\conf\
7. In the <transportConnectors> element, change the port number for the URL attribute of the openwire 

connector. 

The following example shows the URL with the default port number:

<transportConnector name="openwire" uri="tcp://localhost:18616" />
8. Save the activemq.xml file. 
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Modifying the B2B Data Exchange Server RMI Port 
Number

Replace the RMI port number in the dx-configuration.properties files and in the PowerCenter Integration 
Service.

1. On the machine where B2B Data Exchange is installed, open the server and console copies of the dx-
configuration.properties files in a text editor from the following locations: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/
<DXInstallationDir>/conf/

2. Enter the port number in the following property: 

dx.rmi.port=
3. Save the dx-configuration.properties files. 

4. In the Administrator tool, select the PowerCenter Integration Service that runs B2B Data Exchange 
transformations. 

5. On the Processes tab of the PowerCenter Integration Service, add or edit the DX_SERVER_URL 
environment variable and set the URL of the B2B Data Exchange server in the following format: 

 rmi://<HostName>:<PortNumber>
6. Save the changes and restart the B2B Data Exchange services. 

After you change the RMI port number, make sure you use it when you run the command line utilities. For 
example, to use the port number when you import, export, or archive B2B Data Exchange repository objects, 
run the command line utilities with the following options:

• Import: importexport -c import -f <ExportFile> -s <SpecificationFile> -u <UserID> --server 
<"HostName:PortNumber">

• Export: importexport -c export -f <ExportFile> -s <SpecificationFile> -u <UserID> --server 
<"HostName:PortNumber">

• Archive: archive -s <SpecificationFile> -u <UserID> --server <"HostName:PortNumber">

Note: You may encounter B2B Data Exchange performance and stability issues when using the basic archive 
command line utility in B2B Data Exchange. It is recommended to use the Data Archive utility for archiving 
high volumes of event data in production.

Logs
The B2B Data Exchange log files include information that you can use to analyze activity and troubleshoot.

You can configure the following logs:

• Debug logs

• RMI server logs

• Database debug logs

• Import logs

To send log messages to a different log file destination, you can create an SNMP appender to redirect the 
logs to a custom destination.
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Default Log Files
B2B Data Exchange creates log files that record diagnostic information regarding system and user 
operations. The installer also creates log files that record installation selections and configuration.

You can configure log settings in the log4j.xml file located in the B2B Data Exchange configuration directory.

The following log files are available:
Server

The dxserver.log file is located in the following directory:

<DXInstallationDir>/logs
You can change the log mode to debug to generate more messages while you troubleshoot server 
issues.

Operation Console

The log files are located in the following directory:

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/logs
Managed File Transfer

The log files are located in the following directory:

<DXInstallationDir>\ManagedFileTransfer\logs
The following logs include Managed File Transfer server error information:

• System XML log file (VLTrader.xml)

• System debug file (VLTrader.dbg)

JMS Broker

The log files are located in the following directory:

<DXInstallationDir>\message-broker\data\
The log4j.properties configuration file are located in the following directory:

<DXInstallationDir>\message-broker\
Installer

The log files are located in the following directory:

<DXInstallationDir>/logs
B2B Data Exchange Hadoop Service

When you use the B2B Data Exchange Hadoop Service, the log files are located in the following directory:

<DXInstallationDir>/DataIntegrationHub/tomcat/logs

Customizing the Destination for Log Messages
By default, the log4j logging utility sends log messages to files. You can configure the log4j utility to send log 
messages to a destination that is different from the default log files with the Simple Network Management 
Protocol (SNMP). The installer installs the file that the log4j utility requires to work with SNMP.

Complete the following tasks to change the destination:

1. Add an SNMP appender to the log4j properties file and set the logging level. Change the sample SNMP 
appender in the log4j.xml file to the appender that you want to use. You can add multiple appenders to 
the log4j.xml file that send different types of log messages to different SNMP outputs.
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2. Configure an SNMP manager to listen for messages. For information about configuring the SNMP 
manager to handle log4j messages, see the documentation for your SNMP network management 
software.

For general information about the log4j utility, see the Apache Web site: 
http://logging.apache.org/log4j/1.2/manual.html

SNMP Appender Parameters
The parameters of the SNMP appender in the log4j.xml file define the output destination and settings for log 
messages.

The following table describes the SNMP parameters that you can define for B2B Data Exchange:

Parameter Description

ManagementHost IP address of the monitoring system host.
Default is 127.0.0.1

ManagementHostTrapListenPort Port number of the monitoring system host.
Default is 162

LocalIPAddress IP address of local SNMP embedded agent. You do not normally need 
to modify this value.
Default is 127.0.0.1

LocalTrapSendPort Port number of the local SNMP embedded agent.
Default is 161

CommunityString Name of the SNMP community.
Default is public

GenericTrapType Type of the trap. Set one of the following values:
- 0=cold start
- 1=warm start
- 2=link down
- 3=link up
- 4=authentication failure
- 5=egp neighbor loss
- 6=enterprise specific
Default is 6=enterprise specific

ApplicationTrapOID Identifier of the application object that sends the trap messages. You 
can set the value of this parameter to the name of the application 
object in B2B Data Exchange.
Default is 1.3.6.1.2.1.2.0.0.0.0

EnterpriseOID Identifier of the organization object sending the trap message. You can 
set this parameter to any value that identifies the message in B2B Data 
Exchange.
Default is 1.3.6.1.2.1.2.0

ForwardStackTraceWithTrap Determines whether to include the stack trace in the log message.
Default is False
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Parameter Description

Threshold Level of details to report. Set one of the following values:
- FATAL
- ERROR
- WARN
- INFO
- DEBUG
Threshold values that are lower than INFO or WARN might cause heavy 
network traffic. For fewer notifications, set the threshold value to 
FATAL. For a larger number of notifications, set the threshold value to 
WARN.

SysUpTime Amount of time that the application is running. Set the value to 0 to 
calculate the system up time when a message is sent.
Default is 0

Adding an SNMP Appender to the log4j.xml File
Add an SNMP appender to the B2B Data Exchange server or Operation Console copies of the log4j.xml file to 
customize the output destination for log messages.

1. Back up the log4j.xml file that you want to edit from one of the following locations: 

• B2B Data Exchange server: <DXInstallationDir>/conf
• Operation Console: <DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/

classes
2. Open the file in a text editor and search for the following text: 

SNMP_TRAP is a sample appender
3. To edit the sample appender with the actual values of your appender, remove the comment indicators 

from the SNMP_TRAP appender and edit the appender parameters and values based on your 
requirements. 

Note: You can also add an appender below the sample appender instead of editing the sample appender.

4. To set the formatting of the log messages, edit the layout element. 

The following example shows the layout element of the sample appender:

<layout class="org.apache.log4j.PatternLayout">
   <param name="ConversionPattern" value="%d{ISO8601} %-5p [%c] {%t} %m%n"/>
</layout>

For information about the layout pattern options, see the description on the Apache Website: 
http://logging.apache.org/log4j/1.2/apidocs/org/apache/log4j/PatternLayout.html

5. To activate the appender, search for the following text: 

<root>
6. Add the appender name to the appender list. 

The following example shows the appender list after you add the appender name:

<root>
   <priority value="INFO"/>
   <appender-ref ref="BROKER-LOG"/>
   <appender-ref ref="CONSOLE"/>
   <appender-ref ref="SNMP_TRAP"/>
</root>

7. Save the log4j.xml file. 

After you add the SNMP appender, configure your SNMP manager to listen for the log messages.
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Changing the Maximum Java Heap Size
You can change the maximum memory allocation for the B2B Data Exchange JMS Broker service, the 
embedded B2B Data Exchange server broker, or the embedded B2B Data Exchange console broker.

B2B Data Exchange JMS Broker

To change the maximum Java heap size of the B2B Data Exchange JMS Broker, open one of the following 
files:

Operating System File Location

Microsoft Windows <DXInstallationDir>\bin\setenv.bat

UNIX <DXInstallationDir>/bin/setenv.sh

Change the maximum heap size in MB in the ACTIVEMQ_OPTS property. The default maximum heap size is 
512 MB.

Embedded B2B Data Exchange server broker

To change the maximum Java heap size of the embedded B2B Data Exchange server broker, open one of the 
following files:

Operating System File Location

Microsoft Windows <DXInstallationDir>\bin\setenv.bat

UNIX <DXInstallationDir>/bin/setenv.sh

Change the maximum heap size in MB in the DX_SERVER_OPTS property. The default maximum heap size is 
1024 MB.

Embedded B2B Data Exchange client broker

To change the maximum Java heap size of the B2B Data Exchange client, open one of the following files:

Operating System File Location

Microsoft Windows <DXInstallationDir>\bin\setenv.bat

UNIX <DXInstallationDir>/bin/setenv.sh

Change the maximum heap size in MB in the CATALINA_OPTS property. The default minimum heap size is 
128 MB and the default maximum heap size is 2048 MB.

B2B Data Exchange JMS Broker service

To change the maximum Java heap size of the B2B Data Exchange JMS Broker service on Microsoft 
Windows operating systems, open the following file:

<DXInstallationDir>\message-broker\bin\win32\wrapper.conf
Change the maximum Java heap size in MB in the wrapper.java.maxmemory property. The default maximum 
heap size is 512 MB.
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B2B Data Exchange server service

To change the maximum Java heap size of the B2B Data Exchange server service on Microsoft Windows 
operating systems, open the following file:

<DXInstallationDir>\conf\wrapper.conf
Change the maximum heap size in MB in the wrapper.java.maxmemory property. The default maximum heap 
size is 1024 MB.

B2B Data Exchange client service

To change the maximum Java heap size of the B2B Data Exchange client service on Microsoft Windows 
operating systems, run the following command:

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\bin\tomcat7.exe //US//
InfaDXOpConsoleversion --JvmMx <max_heap_size> 
                  

Enter the maximum heap size in MB with integers and without letters. The default maximum heap size is 
2048 MB.

Changing the Credentials for a Database User 
Account

When you install B2B Data Exchange, you specify a user name and a user password for the user accounts of 
the B2B Data Exchange repository database and of the publication repository database. If you are running the 
Dashboard and Reports component, you also specify a user name and a user password for the operational 
data store user account.

Perform the following steps if you change the credentials for a database user account after you install B2B 
Data Exchange. Perform only the steps that are relevant to the changes that you are making. If you are not 
running the Dashboard and Reports component, skip the steps that are only relevant to this component.

1. Stop the B2B Data Exchange services and close the Operation Console. 

2. Verify that the PowerCenter Integration Service is not running any B2B Data Exchange workflows. 

3. If you are running the Dashboard and Reports component, and you are changing credentials for the B2B 
Data Exchange repository or for the operational data store user account, use the PowerCenter Workflow 
Manager to update the credentials in the following connections: 

• For the B2B Data Exchange repository, update the DX_REPO connection.

• For the operational data store, update the DX_ODS connection.

4. If you are changing a password, perform the following steps: 

a. Run the password encryption utility and enter the new password in the following syntax: 

• On Windows operating systems: <DXInstallationDir>\dx-tools\dxpasswd.bat -p 
<NewPassword>

• On UNIX operating systems: <DXInstallationDir>/dx-tools/dxpasswd.sh -p <NewPassword>
The password encryption utility encrypts the password and displays an encrypted string. For 
example, -->ywo+o3cw8+O3iLdlhPprW2YA==<--.

b. Copy the encrypted string without the --><-- indicators to the clipboard. 
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5. Open both copies of the dx-configuration.properties file from the following locations in a text editor: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/
<DXInstallationDir>/conf/

6. In both copies of the dx-configuration.properties file, perform the following steps: 

a. Search for the text that is relevant to the changes that you are making: 

• B2B Data Exchange repository:

dx.jdbc.username=<CurrentUsername>
dx.jdbc.password=<CurrentPassword>

• Publication repository:

dih.staging.jdbc.username=<CurrentUsername>
dih.staging.jdbc.password=<CurrentPassword>

• Operational data store:

dx.dashboard.jdbc.username=<CurrentUsername>
dx.dashboard.jdbc.password=<CurrentPassword>

b. Replace the relevant value with the new value. If you are replacing a password, enter the encrypted 
string. 

c. Save and close the files. 

Note: The content in both copies of the dx-configuration.properties file must be identical.

7. Start the B2B Data Exchange Operation Console. 

8. If you are changing the credentials for the operational data store user account, perform the following 
steps: 

a. In the Navigator click Administration > System Properties. 

b. Change the values of the dx.dashboard.jdbc.username and the dx.dashboard.jdbc.password 
properties to the new values. For the password, enter the encrypted string. 

9. Verify that the PowerCenter Integration Service is running. 

10. If you are changing the credentials for the B2B Data Exchange repository or for the publication 
repository, perform the following steps: 

a. In the Navigator, click Hub Management > Connections. 

The Connections page appears.

b. Click the Test Connection icon next to the connection to the repository for which you want to 
change the credentials. 

• DIH__REPO. Connection to the B2B Data Exchange repository.

• DIH__STAGING. Connection to the publication repository.

B2B Data Exchange tests the connection. The process might take a few moments.

c. When the message "Connection successful" shows, click OK in the Test Connection dialog box. 

11. Start the B2B Data Exchange Server service. 

12. If you are running the Dashboard and Reports component, perform the following steps to schedule the 
B2B Data Exchange operational data store loader workflow: 

a. In PowerCenter Workflow Manager, expand the folder where the operational data store loader 
workflow is located and then right-click DX_ETL. 

b. Select Schedule from the menu and wait until PowerCenter Workflow Manager schedules and runs 
the workflow. 
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Changing the Credentials for the Data Integration 
Hub Hadoop Service

When you install B2B Data Exchange, the installation assigns a user name and a user password for the user 
account of the B2B Data Exchange Hadoop Service.

Perform the following steps if you change the credentials of the B2B Data Exchange Hadoop Service at a 
later date.

1. Stop the B2B Data Exchange services and close the Operation Console. For more information, see 
“Starting and Stopping B2B Data Exchange on UNIX” on page 137 

2. Verify that the PowerCenter Integration Service is not running any B2B Data Exchange workflows. 

3. If you are changing a password, perform the following steps: 

a. Run the password encryption utility and enter the new password in the following syntax: 

<DXInstallationDir>/dx-tools/dxpasswd.sh -p <NewPassword> 
                     

The password encryption utility encrypts the password and displays an encrypted string. For 
example, -->ywo+o3cw8+O3iLdlhPprW2YA==<--.

b. Copy the encrypted string without the --><-- indicators to the clipboard. 

4. Open both copies of the dx-configuration.properties file in a text editor from the following locations 
on the machine where B2B Data Exchange is installed: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/
<DXInstallationDir>/conf/

5. If the B2B Data Exchange Hadoop Service component is installed on a different machine than the 
machine where B2B Data Exchange is installed, on the machine where the B2B Data Exchange Hadoop 
Service is installed, open the dx-configuration.properties file in a text editor from the following 
location: 

<DXInstallationDir>/conf/
6. In all the copies of the dx-configuration.properties file, perform the following steps: 

a. Search for the following text : 

internal.service.username=
internal.service.password= 

b. Replace the relevant value with the new value. If you are replacing a password, enter the encrypted 
string. 

c. Save and close the files. 

Note: The content in all copies of the dx-configuration.properties file must be identical.

7. Start the B2B Data Exchange Operation Console. 

8. Verify that the PowerCenter Integration Service is running. 

9. In the Navigator, click Hub Management > Connections. 

The Connections page appears.

10. Click the Test Connection icon next to the DIH__STAGING__HADOOP connection. 

B2B Data Exchange tests the connection. The process might take a few moments.

11. When the message "Connection successful" shows, click OK in the Test Connection dialog box. 

12. Start the B2B Data Exchange Server services. For more information, see “Starting and Stopping B2B Data 
Exchange on UNIX” on page 137 
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Updating the Dashboard Configuration File
If you use the Dashboard and Reports component, and the IP addresses of the machine that hosts B2B Data 
Exchange change any time after the installation, you must update the IP addresses in the dashboard 
configuration file.

1. Open the dashboard configuration file from the following location: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\shared\classes
\dx_dashboard_configuration.xml

2. In the Security section, in the AuthenticationClientAddresses attribute, update the IP addresses of all 
the Network Interface Cards that provide access to the machine that hosts B2B Data Exchange, including 
both IPv4 and IPv6 addresses. For example: 

<Security AuthenticationSource="SecureKey" SecurityEnabled="True" 
AuthenticationClientAddresses="127.0.0.1,0:0:0:0:0:0:0:1,10.36.8.34,fe80:0:0:0:c1f:
167a:bc3c:8307%11,10.36.112.186,fe80:0:0:0:5c9a:af6e:
87b9:3c08%12,fe80:0:0:0:7c26:627:71d2:4784%14,fe80:0:0:0:0:5efe:a24:822%16,fe80:0:0:0
:0:5efe:a24:70ba%16,fe80:0:0:0:0:5efe:c0a8:7701%17,192.168.119.1,fe80:0:0:0:45cf:
7bcf:f673:4392%18,192.168.162.1,fe80:0:0:0:3516:cd0c:
6f8:df39%19,fe80:0:0:0:0:5efe:c0a8:a201%20" RestartSession="False" 
CacheRights="Session" LogonFailPage="https://HBW180084:18443/dx-console/logout.jsp">

3. Restart the B2B Data Exchange services. 

Configuring the pmrep Process Pool
Speed up the system response time when you create connections, topics, publications, and subscriptions in 
the B2B Data Exchange Operation Console.

Note: This procedure is relevant to systems running PowerCenter 9.5.1 HotFix 4 and PowerCenter 9.6.1 
HotFix 1 or higher.

Based on your PowerCenter version, get one of the following Informatica EBFs:

• For PowerCenter 9.6.1 HotFix 1: EBF14598

• For PowerCenter 9.5.1 HotFix 4: EBF14597

1. On the computer where B2B Data Exchange is installed, back up the following folder: <INFA_HOME>
\server\bin. 

2. Copy the EBF to the <INFA_HOME>\server\bin folder. 

3. Open the EBF file and extract the library that corresponds to your operating system to the <INFA_HOME>
\server\bin folder. 

4. On the machine where B2B Data Exchange is installed, open the server and console copies of the dx-
configuration.properties files in a text editor from the following locations: 

<DXInstallationDir>\DataExchangeDataIntegrationHub\tomcat\shared\classes\
<DXInstallationDir>\conf\

5. Enable following properties in both the dx-configuration.properties files: 

#pwc.pmrep.use.process.pool=true
#pwc.pmrep.process.pool.max=5

6. Save the dx-configuration.properties files. 
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Configuring a PowerCenter Integration Service to 
Access B2B Data Exchange

During the B2B Data Exchange installation or upgrade, you define a PowerCenter Integration Service that B2B 
Data Exchange uses to run workflows. If required, you can configure a different PowerCenter Integration 
Service to access B2B Data Exchange.

In the Java classpath for the PowerCenter Integration Service, add the path to the B2B Data Exchange class 
files.

1. Log in to the Administrator tool and select the PowerCenter Integration Service that runs the workflows 
for B2B Data Exchange. 

2. On the Processes tab, edit the Java SDK ClassPath property and add the location of the B2B Data 
Exchange Java classes at the beginning of the ClassPath property: 

<DXInstallationDir>/powercenter/lib/dx-client-powercenter-10.2.0.jar;
<DXInstallationDir>/powercenter/lib/commons-logging-1.1.3.jar;
<DXInstallationDir>/powercenter/lib/log4j-1.2.17.jar;
<DXInstallationDir>/powercenter/lib/activemq-all-5.12.1.1.jar

Note: You can reference the libraries if the you can access the <DXInstallationDir> from PowerCenter, 
or you can copy the library files locally.

3. Add environment variables to the B2B Data Exchange console and server integration services. 

Integration Service Environment Variable

DX_CONSOLE_URL rmi://<HostName>:<dx.tpm.rmi.port>

DX_SERVER_URL rmi://<HostName>:<dx.rmi.port>

You can find the RMI port numbers for the console and server in the following location:

<DXInstallationDir>\conf\dx-configuration.properties
By default:

• dx.tpm.rmi.port: 18096

• dx.rmi.port: 18095

4. Save the changes. 

Configuring Repository Connections on PowerCenter 
Version 10

If you use the Dashboard and Reports component, your B2B Data Exchange and operational data store 
repositories are installed on Microsoft SQL Servers, and you use PowerCenter version 10, configure the 
repository connections in PowerCenter Workflow Manager.

1. In the Workflow Manager, access the DX_REPO database connection and open the Connection Object 
Definition dialog box. 
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2. Perform the following actions and then click OK: 

a. Select Use DNS. 

b. In the Connect String text box enter the connection name. The name is defined in the ODBC Data 
Source Administrator interface, in ODBC SQL Server Wire Protocol Setup, in the Data Source Name 
field. 

3. Repeat steps 1 and 2 for the DX_ODS connection. 

Configuring the B2B Data Exchange JMS Broker
To configure the JMS communications broker, modify attributes and elements in the activemq.xml file. The 
file is located in the following folder: <DXInstallationDir>\message-broker\conf\

Modify the memoryLimit attribute to determine the maximum memory allocation for message transfer. You 
can increase the memory limit if you expect a large number of queues and messages or higher message 
volume. You can modify the memory limit for the following elements:

• policyEntry topic

• policyEntry queue

The default value is 20 MB.

To troubleshoot message communication issues, you can instruct the JMS Broker to open the administrator 
console when you start the B2B Data Exchange services.

The jetty.xml import element appears with the following syntax:

<!--
<import resource="jetty.xml"/>
-->

To access the administrator console, remove the comment indicators around the element and restart the B2B 
Data Exchange services.

If you use a JMS source, ensure that the PowerCenter workflow source property Transacted Mode is set to 
Yes.

1. Select to edit the workflow.

2. In the Mapping tab, select the source. In the Attributes section, change the value of the property 
Transacted Mode to Yes.

Activating the ActiveMQ Web Console
The ActiveMQ Web Console is a troubleshooting tool that can be used to debug JMS broker communication 
issues for B2B Data Exchange.

By default, the ActiveMQ Web Console is disabled. To enable the web console, in the activemq.xml file 
located in the directory <DXInstallationDir>\message-broker\conf\, un-comment the following section:

<import resource="jetty.xml"/>
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After you activate the ActiveMQ Web Console, use the following user name and password to access the 
ActiveMQ Web Console:

Access Setting Value

user name admin

password admin

Configure System Properties to Enable Informatica 
Managed File Transfer Access

If you install the Informatica Managed File Transfer component, to ensure that B2B Data Exchange can 
access Managed File Transfer, define the following system properties with the Operations Console:

System Property Description

infamft.api.username Name of a user from a user account with privileges to run Informatica 
Managed File Transfer projects. The credential is used to execute 
Informatica Managed File Transfer projects.

infamft.api.password Password of the user defined for the infamft.api.username property. The 
credential is used to execute Informatica Managed File Transfer 
projects.

infamft.console.url URL address for Informatica Managed File Transfer.

After you edit the system properties, restart B2B Data Exchange.

Installing a Single Sign On Key
Single Sign On (SSO) uses a symmetric key that applications share. After you install Informatica Managed 
File Transfer, you create a master key with the Informatica Managed File Transfer mft-keytool utility. 
Specify the keygen, keystore, and key passphrases. Next, use the master key to enable SSO with B2B Data 
Exchange. After you enable SSO, you can launch Managed File Transfer from the B2B Data Exchange 
Operation console.

To create an SSO key for Informatica Managed File Transfer, see the Informatica Managed File Transfer 
Installation Guide. After you create the SSO key for Informatica Managed File Transfer, perform the following 
steps:

Note: In order to launch Managed File Transfer from the B2B Data Exchange Operation console you must 
enable Informatica domain authentication for both Managed File Transfer and B2B Data Exchange

1. Copy the generated Informatica Managed File Transfer keystore file keystore.jceks from the directory 
<MFT_INSTALL_DIR>\mft\config\security on the Informatica Managed File Transfer server to the B2B 
Data Exchange server. 
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2. To isntall an SSO key, run the install-ssokey.bat tool in Windows or the install-ssokey.sh tool in 
Linux based systems on the B2B Data Exchange server. Run a command with the following syntax: 

-c installMftSSOKey -f <keyStoreFileName> -kp <keyPassOption> -ksp <keyStorePassOption> 
-c installMftSSOKey

Required. Installs the SSO key.

-kp <Key Passphrase>

Required. Specify a passphrase from 7 to 255 characters that will access the SSO encryption key. 
The passphrase is the same one that you specified when you created the key on the Informatica 
Managed File Transfer server.

-ksp <Keystore Passphrase>

Required. Specify a keystore passphrase from 7 to 255 characters that will access the SSO 
keystore. The passphrase is the same one that you specified when you created the keystore on the 
Informatica Managed File Transfer server.

-f <Keystore File Name>

Required. Specify the path to the keystore file that you copied from the Informatica Managed File 
Transfer server.

3. Stop the B2B Data Exchange services and close the Operation Console, and then restart the services. For 
more information, see “Starting and Stopping B2B Data Exchange on UNIX” on page 137 

4. For multiple B2B Data Exchange servers in high availability mode, follow the same procedure to install 
the key separately on each node. 

Sharing Informatica Managed File Transfer 
Directories with B2B Data Exchange

Use Informatica Managed File Transfer to configure client and server machines that serve as B2B Data 
Exchange endpoints. If you install the Managed File Transfer component, to ensure that endpoints function 
correctly, share the relevant Managed File Transfer directories with B2B Data Exchange.

Before using an MFT Remote Receive or MFT Hosted Receive endpoint that runs a project, you must share 
the Informatica Managed File Transfer download directory. Share the Managed File Transfer directory 
specified in the B2B Data Exchange system property named infamft.download.location with B2B Data 
Exchange.

Before using an MFT Hosted Receive or MFT Hosted Send endpoint, share the Managed File Transfer 
directory <MFT installation>\server\userdata\webdocs with B2B Data Exchange.
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Adding Variables to Custom Informatica Managed 
File Transfer Projects

You can use pre-configured Informatica Managed File Transfer projects to define communication protocols 
and file management processes for B2B Data Exchange MFT endpoints. If you choose to create a custom 
project, ensure that you include the following variables.

For an MFT Hosted Receive endpoint that runs a custom project, the source directory is specified with a 
variable starting with InputFile. For example, you could include the variable ${InputFile_DXData} in the 
custom project to pass the source directory path to B2B Data Exchange.

For an MFT Hosted Send endpoint that runs a custom project, the destination file is specified with the 
variable ${OutputFile_DXData} in the project.
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Installing and Configuring B2B Data Exchange 
Accelerator for Data Archive Overview

The B2B Data Exchange accelerator is a plug-in for Data Archive that enables you to archivepurge events that 
B2B Data Exchange generates with Data Archive. The accelerator utilizes the advanced archiving capabilities 
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of Data Archive, such as detailed archive parameters, recurring archive jobs, and easily accessible archive 
repositories.

After you install B2B Data Exchange Accelerator for Data Archive, configure the archive project based on the 
archiving requirements in your organizationData Archive source connection. Perform the following 
configuration steps:

1. Create the source and target connections.

2. To secure access to the source connections, configure access roles and access users, and then create a 
security group.

3. Create the history database tables and indexes.

4. Create the seamless access layer for the history database.

5. Create the file archive user and the file archive folder.

6. Schedule archive jobs, and then archive the B2B Data Exchange repository.

7. To view archived documents and events in the B2B Data Exchange Operations Console, configure 
system properties and assign user permissions.

8. To view archived documents and events in the Data Discovery portal, configure the relevant Data Archive 
search to browse data, search data, or search by-reference documents.

Note: You may encounter B2B Data Exchange performance and stability issues when using the basic archive 
command line utility in B2B Data Exchange. It is recommended to use the Data Archive utility for 
archivingpurging high volumes of event data in production.

Pre-Installation Steps
Before you install the B2B Data Exchange accelerator in Data Archive, make sure that your system meets the 
minimum requirements and follow the pre-installation steps.

1. Make sure you have an active installation of Data Archive. A limited Data Archive version is provided with 
B2B Data Exchange.

2. Create and assign privileges to the B2B Data Exchange production database and history 
databaserepository users.
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3. For archive projects to or from the history database, configure the history database location and 
credentials in the client and server copies of the dx-configuration.properties file:

Property Description

dx.archive.jdbc.url Location of the history database. You replace the default value with one of the 
following values:
- For Oracle, use the following format: jdbc:informatica:oracle://<oracle 
host>:<oracle port>;SID=<oracle sid>

- For Microsoft SQL Server, use the following format: 
jdbc:informatica:sqlserver://<sqlserver host>:<sql server 
port>;DatabaseName=<database name>

The default value is ${dx.archive.jdbc.url}.

dx.archive.jdbc.username Name of the history database user. You replace the default value with the database 
user name.
The default value is: ${dx.archive.jdbc.username}

dx.archive.jdbc.password Encrypted password for the history database user. You encrypt the password with 
the password encryption utility and replace the default value with the encrypted 
string.
The default value is: ${dx.archive.jdbc.password}

Note: To determine the specific location and credentials for the history database, consult the database 
administrator.

4. To enable archiving document attachments, copy the library file from the folder <DX installation 
directory>/ILM-accelerator/lib to the folder <ILM installation directory>/webapp/WEB-INF/
lib/.

5. In the Data Archive installation directory, open the conf.properties file and set the value of the 
following properties:

• Set the value of the informia.useDbaViewsInSeamlessAccess property to false.

• Set the value of the informia.proceduresToExecute.inArchiveFromHistory property to java://
com.informatica.b2b.dx.ilm.MoveDXDocStoreDatabaseDAOImpl.

Note: Back up the conf.properties file before you modify the property.

6. Restart Data Archive.

Database User Privileges
When you prepare the production database and history database, you assign database privileges to users 
according to the archive scenario requirements. Set up the database users before you install the accelerator 
and create archive projects.

Note: To avoid user conflicts, set up a unique database user for each database.
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The following table describes the production database privileges to assign to the production database user:

Component Privileges

Rows - Select
- Insert
- Update
- Delete

Tables and views - Create
- Alter
- Drop

The following table describes the history database privileges to assign to the history database user:

Component Privileges

Rows - Select
- Insert
- Update
- Delete

Tables and views - Create
- Alter
- Drop

Synonyms and links - Create
- Delete

In addition to the history database privileges, the history database user needs to access and modify rows in 
the production database.

The following table describes the production database privileges to assign to the history database user:

Component Privileges

Rows - Select
- Insert
- Update
- Delete

Installing the B2B Data Exchange Accelerator for 
Data Archive

Install the B2B Data Exchange accelerator for Data Archive after you install B2B Data Exchange and Data 
Archive.

Before you install the accelerator, install Data Archive and follow the pre-installation steps.
The minimum supported version of Data Archive is 6.1. If you have Data Archive version 6.1 installed, also 
install EBF 11801 and EBF 11672.
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If you have Data Archive version 5.3.6 installed, also install EBF 11152.

1. Log in to Data Archive with administrator privileges and click Accelerators > Enterprise Data Manager. 

The Enterprise Data Manager appears.

2. In the Enterprise Data Manager, click File > Import > Accelerator. 

The Import Metadata Options window appears.

3. Select Continue Import through EDM and click OK. 

4. Navigate to the location <DXInstallationDir>/ILM-accelerator and select to import all the XML files in 
the directory. 

Note: Do not import the sub-folders in the directory.

The Enterprise Data Manager displays a progress window during the import process.

5. To verify the import process, restart the Enterprise Data Manager and make sure that the accelerator 
appears in the B2B Data ExchangeData Integration Hub node of the Explorer pane. 

6. To add the accelerator to drop-down lists in Data Archive, log in to the database with the B2B Data 
Exchange history databaserepository credentials and run the SQL script on the Data Archive repository. 
The script is located in one of the following locations: 

Database Path

Oracle <DXInstallationDir>/ILM-accelerator/sql/oracle_ilm_repository_update.sql

Microsoft SQL Server <DXInstallationDir>ILM-accelerator/sql/sqlserver_ilm_repository_update.sql

Configuring athe Data Archive Source Connection 
from Production Database to History Database

Configure the Data Archive source connection before you archivepurge events from the production database 
to the history database.

For information about creating source connections, see the Data Archive Administrator Guide.

Note: The production database and history database must use the same database system, either SQL Server 
or Oracle.

1. Log in to Accelerator. 

2. Click Administration > New Source Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Set the property Source / Staging Attachment Location to the root path for the production document 
store. 

The path is the same as the path defined for the B2B Data Exchange system property 
dx.system.document.store.folder.

6. Set the property Target Attachment Location to the path of a location that can hold the archived 
document store (history database). 

The path is the same as the path defined for the B2B Data Exchange system property 
dx.archive.document.store.folder.
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7. If the connection is to an SQL Server database, select the option Compile ILM Functions. 

Note: The properties Source / Staging Attachment Location and Target Attachment Location cannot have 
the same value. Both locations must be accessible to the Data Archive archive process.

Note: The location specified in the Source / Staging Attachment Location property must be accessible to the 
Data Archive purge process.

Source and Target Connections
You must create a connection for each source database that you want to archive data documents from. One 
source database is the database that stores the documents that you want to archive, the production 
database. For restore jobs, the source database is the history database, where the data was originally 
archived.

Create a connection to the source database from which you want to purge data documents.

There are two types of source connections, one to archive data from the production database to the history 
database, and the other from any database to the file archive.

You must also create a target connection for each database that you want to archive data to. The target 
database is the location where you want to archive data to.

There are two types of target connections, a connection to a target database, or to a file archive. The first one 
is used for mid-term storage, whereas the latter is used for long-term storage.

Configuring athe Data Archive Source Connection from Production 
Database to History Database

Configure the Data Archive source connection before you archivepurge events from the production database 
to the history database.

For information about creating source connections, see the Data Archive Administrator Guide.

Note: The production database and history database must use the same database system, either SQL Server 
or Oracle.

1. Log in to Accelerator. 

2. Click Administration > New Source Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Set the property Source / Staging Attachment Location to the root path for the production document 
store. 

The path is the same as the path defined for the B2B Data Exchange system property 
dx.system.document.store.folder.

6. Set the property Target Attachment Location to the path of a location that can hold the archived 
document store (history database). 

The path is the same as the path defined for the B2B Data Exchange system property 
dx.archive.document.store.folder.

7. If the connection is to an SQL Server database, select the option Compile ILM Functions. 
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Note: The properties Source / Staging Attachment Location and Target Attachment Location cannot have 
the same value. Both locations must be accessible to the Data Archive archive process.

Note: The location specified in the Source / Staging Attachment Location property must be accessible to the 
Data Archive purge process.

Configuring a Source Connection from History Database to Data 
Archive

Configure the Data Archive source connection from the history database to the data archive.

For information about creating source connections, see the Data Archive Administrator Guide.

1. Log in to Accelerator. 

2. Click Administration > New Source Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Set the property Source / Staging Attachment Location to the root path for the history database. This is 
the same path as defined for the B2B Data Exchange system property 
dx.archive.document.store.folder. This value should match the value for the property Target 
Attachment Location for the connection to the production database. 

6. Set the property Target Attachment Location to the path of a location that has sufficient space to 
temporarily store documents for the archived document store. 

7. If the connection is to an SQL Server database, select the option Compile ILM Functions. 

8. Set the property Database Link To Production to the same path as the history database target 
connection. 

Note: The properties Source / Staging Attachment Location andTarget Attachment Location cannot have the 
same value. Both locations must be accessible to the Data Archive archive process.

Configuring a Source Connection from Production Database to File 
Archive

Configure the Data Archive source connection from the production database to the file archive.

For information about creating source connections, see the Data Archive Administrator Guide.

Note: The production database and history database must use the same database system, either SQL Server 
or Oracle.

1. Log in to Accelerator. 

2. Click Administration > New Source Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Set the property Source / Staging Attachment Location to the root path for the document store. 

This is the same path as defined for the B2B Data Exchange system property 
dx.system.document.store.folder.

6. Set the property Target Attachment Location to the path of a location that has sufficient space to 
temporarily store documents for the archived document store. 

7. If the connection is to an SQL Server database, select the option Compile ILM Functions. 
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Note: The properties Source / Staging Attachment Location andTarget Attachment Location cannot have the 
same value. Both locations must be accessible to the Data Archive archive process.

Configuring a Target Connection from Production Database to 
History Database

Configure the Data Archive target connection from the production database to the history database.

For information about creating target connections, see the Data Archive Administrator Guide.

1. Log in to Accelerator. 

2. Click Administration > New Target Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Define the property Database Link To Source. 

The database link is used to access the meta-data tables from the production database. Consult with 
your database administrator regarding how to set up a database link.

Note: If the link server name contains special characters enclose the special character with double quotes.

Configuring a Target Connection from History Database to File 
Archive

Configure the Data Archive target connection from the history database to the file archive.

For information about creating target connections, see the Data Archive Administrator Guide.

1. Log in to Accelerator. 

2. Click Administration > New Target Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Define the connection type as Optimized File. 

6. Disable the option Use Mined Source Schema. 

Configuring a Target Connection from Production Database to File 
Archive

Configure the Data Archive target connection from the production database to the file archive.

For information about creating target connections, see the Data Archive Administrator Guide.

1. Log in to Accelerator. 

2. Click Administration > New Target Connection. 

3. Enter the database-specific connection properties. 

4. Set the application version of the connection to B2B Data Exchange 10.1. 

5. Define the connection type as Optimized File. 

6. Disable the option Use Mined Source Schema. 
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Securing Data Archive Connections
Secure the Data Archive source connections so that only specific users can use and access the connections.

Access roles determine the data that users can access in Data Discovery searches. You use the Data 
Discovery portal to search for documents that are archived to the Data Archive. Access roles also restrict 
which users can view and download files that contain exported search results. Users can only download the 
exported files if the user is assigned to the same access role as the entity.

To secure source connections, first create an access role and associate it with an entity, then assign the 
access role to a user. Next, create a security group and assign the users that are allowed to access the B2B 
Data Exchange repository (production) source connection to the group.

Configuring and Assigning the B2B Data Exchange and FAS 
Access Roles

Access roles determine the data that users can access in Data Discovery searches. Users can only download 
the exported files if the user is assigned to the same access role as the entitypurge. Create an access role 
and associate it with an entity, then assign the access role to a user.

Create an access role associated with the entity production database, and an access role associated with the 
entity FAS production database, and then assign the access roles to users.

1. Log in to Accelerator. 

2. Click Administration > Manage Roles. 

3. Click New Role. 

The role name cannot contain special characters.

4. Click Assign Role to New Entity and provide the name B2B Data Exchange Access Role. 

The name cannot contain special characters.

5. For Application Version select B2B Data Exchange 10.1. 

6. For Application select DX_SCHEMA B2B Data Exchange Database. 

7. For Entity Name type Processing Data. 

8. To create a second entity named FAS Processing Data, click Add Role. 

9. Click Assign Role to New Entity and provide a name, for example FAS Access Role. 

The name cannot contain special characters.

10. For Application Version select B2B Data Exchange 10.1. 

11. For Application select DX_SCHEMA B2B Data Exchange Database. 

12. For Entity Name type FAS Processing Data. 

13. To assign the B2B Data Exchange Access Role entity to a user, click Administration > Manage Roles. 

14. Select a user and click the Edit icon next to the user. 

The Edit User page appears.

15. Click Add Role. 

16. For Product select Data Archive. 

17. For Role select B2B Data Exchange Access Role. 

18. Click Save. 

19. To assign the FAS Access Role entity to a user, click Administration > Manage Roles. 
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20. Select a user and click the Edit icon next to the user. 

The Edit User page appears.

21. Click Add Role. 

22. For Product select Data Archive. 

23. For Role select FAS Access Role. 

24. Click Save. 

Assign a Connection to a Security Group
Assign a connection to a security group.

1. Log in to Accelerator. 

2. Click Administration > Manage Security Groups. 

3. Click New Security Group. 

The Create or Edit a Security Group page appears.

4. Name the security group, for example B2B Data Exchange Security Group. 

5. Select the source connection to the production database. 

6. Click Add Permission. 

A window appears with a list of defined permissions.

7. Select the permission and click Select. 

The permission appears in the list of permissions.

8. Select Application and for the value select DX_SCHEMA B2B Data Exchange Database. 

9. Click Add User. 

A window appears with a list of users.

10. Select the users that are allowed to access the B2B Data Exchange repository source connection and 
click Select. 

The user appears in the list of users.

11. Enter the user properties. 

12. Click Save. 

13. Follow the same steps for the connection to the history database. 

Creating the History Database Tables and Indexes
Create tables and indexes in the history database is required when you create the seamless access layer, and 
to assure optimized performance.

1. Log in to Accelerator. 

2. Select Jobs > Schedule a Job. 

3. In the Projects/Programs to Run area select Standalone Programs, and click Add Item. 

The Program dialog box appears.

4. Select Create Tables, and click Select. 
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5. Select the source repository. 

6. Select the target history database as the destination repository. 

7. In the Schedule area, select the option to run once or start the job immediately. 

8. Click Schedule. 

Note: When the program Create Indexes runs, it prevents the same events from being archived multiple times 
into the same history database. Several constraints are added to the history database to represent primary 
keys.

Create the Seamless Access Layer for the History 
Database

Create the seamless access layer after you run an archive job or pre-create the tables for the history 
database.

The database administrator creates the seamless access layer by executing the relevant script located in <DX 
installation directory>/ILM-accelerator/sql:

1. For Oracle: oracle_seamless_access_script.sql
2. For SQL Server: sqlserver_seamless_access_script.sql

Replace the following system variables in the script:

1. Replace &linkName with the database link.

2. Replace &databaseName with the schema name of the production database.

The program Create Seamless Data Access performs a similar function as the scripts. However, the scripts 
generate a proper view for in-lining certain entity names, such as partner name, with the event table, when 
data is archived to the file archive. This in-lining allows you to find events based on partner or account name.

Creating a File Archive User
You must create a file archive user before you create a file archive folder. The file archive user can access 
the file archive folder.

Data Archive 5.3.6

Create a file archive user with the sa_user role.

To create a user, run the following command with the npa_admin tool:

add_user <username>, <password>
The user must be able to query the NPA system data. To enable this capability, run the following command 
with the npa_admin tool:

add_user_role dxarchive, query, npa_system
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Data Archive 6.1

To create a file archive user, perform the following steps:

1. Login to the FAS service using SSASQL, for example with the following command:

SSASQL meta meta dba/dba
2. To create a user, type the following command:

create authorization dx_fas /dx_fas
3. To assign DBA privileges, type the following command:

cgrant DBA to dx_fas
4. To commit the changes, type the following command:

commit

Creating a File Archive Folder
In Data Archive, select and run the Create Archive Folder program to create the file archive folder and 
initialize the file archive.

When you run the Create Archive Folder program, define the target connection.

Creating an Archive Job
To set up an archive job for a production or history database, perform the following task.

1. Log in to Accelerator. 

2. Click Workbench > Manage Archive Projects. 

3. Click New Archive Project. 

4. Provide a name for the project. 

5. Set the action to Archive and Purge. 

This option removes data from the B2B Data Exchange repository after they are archived and also 
ensures that by-reference documents are archived and then deleted.

6. Select the source and target connections. 

7. If the target is a file archive, then only select the option Include Reference Data. 

This option ensures that important reference data, such as partner names and account numbers, are 
also stored in the file archive for each archived event.

8. Click Next. 

9. Click Add Entity. 

• If the target connection is a database, select the entity Processing Data.

• If the target connection is the File Archive Service, select FAS Processing Data.

10. Set Role to the access role created in “Configuring and Assigning the B2B Data Exchange and FAS 
Access Roles” on page 164. 

11. Set the archive job parameters. 
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For more information, see “Archive Job Parameters” on page 168.

12. Click Next. 

13. To save the project only, click Publish. 

14. To save the project and immediately schedule a run, click Publish and Schedule. 

Archive Job Parameters
The following list contains archive job parameters. The parameters Event Age, Include with reconcile 
status, and Include intermediate documents apply to the whole event hierarchy. Other parameters apply 
to the root event of the hierarchy.

Event Age

Required. Specifies how old an event must be, in days, before it is archived. For example, if the event was 
created on 2011-09-01 and the date on which the archive job runs is 2011-09-06, then the age of the 
event is 5 days. If a value of zero is supplied, then all the events are archived regardless of their age. The 
event age is counted in the number of whole days. An event created at 01:00 hours or at 23:00 hours on 
the same day will have the same age in days.

Partner

Optional. The partner to which the root of the event hierarchy must belong. If the root does not belong to 
the given partner, then that hierarchy is not archived. The partners in the rest of hierarchy (on the child 
events) do not have to be same partner.

Account

Optional. The account with which the root event of the event hierarchy is associated. If the root event is 
not related to the given account, then that hierarchy is not archived. The accounts in the rest of hierarchy 
(on the child events) do not have to be related to the same account.

You can only select an account that is associated with the chosen partner. It is not possible to select an 
account before choosing a partner.

Event Type

Optional. The event type required for the root event of the event hierarchy. If the root event does not 
match the event type, the hierarchy is not archived. Other events in the hierarchy do not have to match 
the event type.

Event Status

Optional. The event status required for the root event of the event hierarchy. If the root event does not 
match the status, the hierarchy is not archived. If this parameter is selected, the status of any event 
except the root event is ignored. If no value is specified, then all the events in the hierarchy must have a 
final status.

Reconciliation Status

Optional. The reconciliation status required for the associated correlation tickets, before the event is 
archived. The reconciliation tickets can have the following possible status groups:
Any

The ticket status is ignored.

Closed

All the tickets completed normally or are closed after time-out.
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Closed and Timed-out

All the tickets completed normally or are closed after time-out. If a ticket timed-out, then this status 
applies.

Root Events Without Partners

Required. In some scenarios, events that are created are not associated with a partner. This option 
allows those events to be archived. Enabling this option means that events with no associated partner 
are archived together for the selected partner or account.

Intermediate Documents

Required. Defines whether the archive job archives intermediate documents or log blobs.

Specifying no would result in data loss, as intermediate documents will not be copied to the archive but 
just deleted.

Scheduling Archive Jobs
Archive job scheduling depends on the type of archive job. Database to database archiving is performed 
when you archive from the production database to the history database. Database to file archiving is 
performed when you archive from the production database to the file archive, or from the history database to 
file archive.

Scheduling Archiving from the Production Database to History 
Database

Perform the following steps to archive files from the production database to the history database.

1. Log in to Accelerator. 

2. Select Jobs > Schedule a Job. 

3. Select Projects and click Add Item. 

4. From the Programs list, select the production to history database program that you want to schedule, 
according to the database type. 

5. Select Standalone Programs and click Add Item. 

6. From the Programs list, select Create Indexes. 

7. Select the source and target connections that are configured for the archive project. 

8. Define relevant schedule parameters. 

9. Click Schedule. 

Archiving from a Database to the File Archive
To archive documents from the history database to the file archive, or from the production database to the 
file archive you schedule the following programs:

1. Archive the B2B Data Exchange repository and move the files from the database document store to the 
staging area.

2. Load the archived data into the file archive.
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3. Load the documents from the staging area into the file archive.

Scheduling Archiving from a Database to the File Archive
Perform the following steps to archive the production or history database to the file archive.

1. Log in to Accelerator. 

2. Select Jobs > Schedule a Job. 

3. Select Projects and click Add Item. 

4. To archive the B2B Data Exchange repository and move the files from the database document store to 
the staging area, from the Programs list, select the DX <Database Type> Archive program, according to 
the database type. 

5. Select Standalone Programs and click Add Item. 

6. To load the archived data into the file archive, from the Programs list, select File Archive Loader. 

7. Ensure that the field Archive Job Id is empty. 

The value is determined when the program runs.

8. Select Standalone Programs and click Add Item. 

9. To load the documents from the staging area into the file archive, from the Programs list, select Load 
External Attachments. 

10. For the property Directory provide the same value as provided for the property Target Attachment 
Location from the source connection. 

11. For the property Target Archive Store provide the same value as provided for the same property Target 
Attachment Location for the archive project. 

12. Set the field Purge after Load to Yes. 

13. Define relevant schedule parameters. 

14. Click Schedule. 

15. If the job is not scheduled to run immediately, you can view the job if you select Jobs > Manage Jobs. 
Schedule. 

Viewing Archived Events
You can view archived events in the B2B Data Exchange Operations Console, or the Data Archive Data 
Discovery portal.

Before you view archived events in the Operations Console, configure the relevant system properties and 
assign user privileges.

Alternatively, you can use the Data Discovery portal to view archived events. Use the Data Discovery portal to 
search for and view events and their details.

Use the Browse Data option to find information directly associated with the event itself, for example the start 
and complete time. This option provides a direct view of all the data that is available in the archived B2B Data 
Exchange repository.

Use the Search File Archive option to search for data based on archived top-level entities. The difference 
between the Search File Archive option and the Browse Data option is that with the first search you can 
easily drill down to the data associated with an event, for example to event blobs.
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You can also use the Data Discovery portal to view archived events for by-reference documents.

Configuring B2B Data Exchange System Properties
Before you can view the archived events from the history database in the B2B Data Exchange Operations 
Console, you must update the relevant system properties.

Modify the following files:

<DXInstallationDir>/conf/dx-configuration.properties
<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/dx-
configuration.properties

Back up the files before you update them.

1. Go to the following directory and locate the file named dx-configuration.properties: 

<DXInstallationDir>/conf/
2. Use a text editor to open the file. 

3. Search for the following text: 

dx.archive.jdbc.url 
Set this value to the location of the history database.

4. Search for the following text: 

dx.archive.jdbc.username 
Set this value to the user name for the user enabled to access the history database.

5. Search for the following text: 

dx.archive.jdbc.password
Set this value to the password for the user enabled to access the history database.

6. Add the following parameter: 

dx.archive.document.store.folder
Set this value to the location where the pass-by-reference documents are archived.

7. Save the dx-configuration.properties file. 

B2B Data Exchange maintains two copies of the dx-configuration.properties. The contents of the files 
must be identical.

8. Copy the updated dx-configuration.properties file to the following directory: 

<DXInstallationDir>/DataExchangeDataIntegrationHub/tomcat/shared/classes/
9. Restart B2B Data Exchange. 

Viewing Archived Events in the B2B Data Exchange Operations 
Console

After you update the relevant system properties, you can view events archived in the history database 
through the B2B Data Exchange Operations Console.

1. In the B2B Data Exchange Operations Console Navigator, click Administration > User Groups. 

The User Groups page appears.

2. Create a user group and enable the Operator privilege View Archived Events. 

3. Assign relevant users to the user group. 

4. When an Operator with the relevant permissions logs into B2B Data Exchange, in the Events section of 
the Operations Console, the option View Archived Events appears. 
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Browsing Data with the Data Discovery Portal
Use the Data Discovery portal to search for and view events and their details. Use the Browse Data option to 
find information directly associated with the event itself, for example the start and complete time. This option 
provides a direct view of all the data that is available in the archived B2B Data Exchange repository.

1. Log in to Accelerator. 

2. Click Data Discovery > Browse Data. 

The Browse Data page appears.

3. For the Archive Folder, select the relevant FAS folder. 

4. For the Entity, select FAS Processing Data. 

5. Select Table to search. 

6. Expand the Data Columns section. 

7. In the Available Columns panel, select the columns to be present in the search results. 

8. In the Where Clause panel, add any SQL conditions that need to be applied to the search. To check the 
SQL query, click Preview SQL. 

9. Click Search. 

The results panel appears with a list of the columns in each table in the entity.

10. To export the data, select CSV or SQL and then click Export. 

Defining Search Options to Search the File Archive with the Data 
Discovery Portal

You can use the Search File Archive option to search for data based on archived top-level entities, which are 
for B2B Data Exchange-only events.

Before you use the Search File Archive option, set up the search options.

1. Log in to Accelerator. 

2. Click Data Discovery > Search Options. 

The View Search Options page appears.

3. For Application Version, select B2B Data Exchange 10.1. 

4. For Application, select DX_SCHEMA B2B Data Exchange Database. 

5. For Entity, select FAS Processing Data. 

6. Click Edit. 

The Edit Search Options page appears with a list of the columns in each table in the entity.

7. Click Add Entity Table and select DX_VIEW_ARCHIVE_EVENT. 

8. In the Event table ensure that you do not select anything in the columns Display, Search, and Sort. 

9. In the DX_VIEW_ARCHIVE_EVENT table, in the columns Display, Search, and Sort, select the columns to 
be displayed, searched and sorted. 

It is recommended to select all the columns, and then deselect H_LEVEL, SAVEPOINT_ID, and 
CORRELATION_STATE.

10. Click Save. 
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Searching the File Archive with the Data Discovery Portal
After you set up search options, you can use the Search File Archive option to search for data based on 
archived top-level entities. The difference between the Search File Archive option and the Browse Data 
option is that with the first search you can easily drill down to the data associated with an event, for example 
to event blobs.

1. Log in to Accelerator. 

2. Click Data Discovery > Search File Archive. 

The Search File Archive page appears.

3. For the Archive Folder, select the FAS archive folder. 

4. For Entity, select DX_VIEW_ARCHIVE_EVENT. 

5. Select the search parameters. 

For more information, see the Data Archive Administrator Guide.

6. Click View. 

The Search Results pane appears with a list of the columns related to the entity.

7. To view additional information about a selected event, click View Archived Data or Technical View. 

In the DX_EVENT_BLOBS table, there are links to the data in the OBJECT column. The data cannot be 
viewed directly as it largely contains binary data.

8. To export selected data, click Export Data. To export all data, click Export All Data. 

Configuring and Assigning the By-Reference Access Role
Before you can view archived by-reference documents, the entity that holds the archived documents must be 
accessible. Create an access role and associate it with an entity, then assign the access role to a user.

The application External Attachments and entity AM_ATTACHMENT_ENTITY are automatically created, when 
the program Load External Attachments is run.

1. Log in to Accelerator. 

2. Click Administration > Manage Roles. 

3. Click New Role. 

The role name cannot contain special characters.

4. Click Assign Role to New Entity and provide the name By Reference Access Role. 

The name cannot contain special characters.

5. For Application Version select B2B Data Exchange 10.1. 

6. For Application select External Attachment. 

7. For Entity Name type AM_ATTACHMENT_ENTITY. 

8. To assign the By Reference Access Role entity to a user, click Administration > Manage Roles. 

9. Select a user and click the Edit icon next to the user. 

The Edit User page appears.

10. Click Add Role. 

11. For Product select Data Archive. 

12. For Role select By Reference Access Role. 

13. Click Save. 
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Viewing Archived By-Reference Documents
Enter a short description of the task here (optional).

1. Log in to Accelerator. 

2. Click Data Discovery > Search File Archive. 

The Search File Archive page appears.

3. For the Archive Folder, select the FAS archive folder. 

4. For Entity, select DX_VIEW_ARCHIVE_EVENT. 

5. Select the search parameters. 

For more information, see the Data Archive Administrator Guide.

6. Click View. 

The Search Results pane appears with a list of the columns related to the entity.

7. To view additional information about a selected event, click View Archived Data or Technical View. 

8. In the DX_EVENT_BLOBS table, find the event blob file name in the FULL_FILE_NAME column. Select the 
last two elements in the file path, that is the file name and directory. 

9. To find the by-reference documents, start another search. Click Data Discovery > Search File Archive. 

The Search File Archive page appears.

10. For the Archive Folder, select the same archive folder. 

11. For Entity, select AM_ATTACHMENT_ENTITY. 

12. For Table, select AM_ATTACHMENT. 

13. Select the search parameters. For the first search row, select Attachment Directory with the operator 
Contains. For the next value, supply the name of the directory in which the event blob file is located. 

14. Add a second search row. Select Attachment Name with the operator Contains. For the next value, 
supply the event blob file name. 

15. Click View. 

The results panel appears with a list of the columns in each table in the entity.

16. To view or download the original event blob file, click Click to view in the Attachment Data column. 

Limitations
The following limitations apply to the Data Archive Accelerator.

• By-reference document are only moved from the document store if the archive job is configured with the 
Archive and Purge option. With the Archive Only option, the documents reamain in the document store, 
and are not copied to the history database or the staging area for inclusion in the File Archive.

• The document store is moved synchronously with the archive task. The property Move Attachments in 
Synchronous Mode has no meaning for B2B Data Exchange repository archive jobs.

• ·If the document store is moved, then the property Source / Staging Attachment Location for the 
source connection must also be updated.
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• Running an archive job with the Archive Only is not supported, as this can lead to duplicate events in the 
history database. It might cause the B2B Data Exchange Operations Console Archived Events view to be 
unable to show the event details.

• If the program Create Indexes is run on the history database, then the archive job might end in an error 
state. The program Create Indexes adds uniqueness constraints to simulate indexed primary keys which 
would causes the error.

• If the drop target indexes property is selected for a target connection, then the program create 
indexes must be run after each archive job.

• If you use Oracle databases, the history database user must be able to create tables, views, and 
synonyms. The user must have the following privileges: CONNECT, RESOURCE, CREATE VIEW, and CREATE 
SYNONYM.
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C h a p t e r  1 1

Uninstallation
This chapter includes the following topics:

• Uninstallation Overview, 176

• Uninstalling B2B Data Exchange from Windows Operating Systems, 176

• Uninstalling B2B Data Exchange from UNIX Operating Systems, 177

Uninstallation Overview
Uninstall B2B Data Exchange to remove the core application and additional components that you installed on 
the machine.

The uninstallation process does not delete the repositories or the B2B Data Exchange document store.

The uninstallation process depends on the operating system on which B2B Data Exchange is installed, 
Windows or UNIX.

Uninstalling B2B Data Exchange from Windows 
Operating Systems

1. Stop all B2B Data Exchange services. 

2. In the Add/Remove Programs control panel, right-click B2B Data Exchange and select Uninstall. 

The Uninstall B2B Data Exchange wizard appears.

3. Click Next. 

The Pre-Uninstall Summary screen appears.

4. Click Uninstall. 

The Uninstall B2B Data Exchange screen displays the progress of the uninstallation process. When the 
uninstallation process ends, the Uninstall Complete screen appears.

5. Click Done to close the wizard. 
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Uninstalling B2B Data Exchange from UNIX Operating 
Systems

1. Stop all B2B Data Exchange services. 

2. Run the Uninstall.exe file from the B2B Data Exchange installation directory. 

The Uninstall B2B Data Exchange section appears.

3. Click Next. 

The Pre-Uninstall Summary section appears.

4. Click Uninstall. 

The uninstaller displays the progress of the uninstallation process. When the uninstallation process 
ends, the Uninstall Complete section appears.

5. Click Done to exit the uninstaller. 
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